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Introduction

Read this Instruction Manual thoroughly before using
the product.

Thank you for purchasing this product.

This manual describes the operation and options for this product. Read this manual
thoroughly before using the product and operate the product in accordance with the
instructions in this manual.

Keep this manual for future reference.

IMPORTANT

e |f the user or usage location changes, ensure that this Instruction Manual is always
kept together with the product.

e |f this manual is lost or damaged, immediately contact your Shimadzu
representative to request a replacement.

e To ensure safe operation, contact your Shimadzu representative if product
installation, adjustment, re-installation (after the product is moved), or repair is
required.

Notice

¢ Information in this manual is subject to change without notice and does not represent
a commitment on the part of the vendor.

e Any errors or omissions which may have occurred in this manual despite the utmost
care taken in its production will be corrected as soon as possible, although not
necessarily immediately after detection.

¢ All rights are reserved, including those to reproduce this manual or parts thereof in
any form without permission in writing from Shimadzu Corporation.

¢ Microsoft and Windows are registered trademarks of Microsoft Corporation in the
United States and/or other countries.
Other company names and product names mentioned in this manual are trademarks or
registered trademarks of their respective companies.
The TM and ® symbols are omitted in this manual.

e LabSolutions RF is a registered trademark of Shimadzu Corporation in the United States
and Europe (Office for Harmonization in the Internal Market).

©2015 Shimadzu Corporation. All rights reserved.
Original version is approved in English.
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Introduction

Indications Used in This Manual

The following symbols are used in this manual:

Indication Meaning
B NOTE Emphasizes additional information that is provided to ensure
v the proper use of this product.
2" Hint Indicates information provided to improve product performance.
PP Reference Indicates the location of related reference information.
Mouse and On-Screen Operations
Indication Meaning
Click Indicates placing the mouse pointer over a target and pressing
the left button on the mouse once.
Right-click Indicates placing the mouse pointer over a target and pressing

the right button on the mouse once.

Indicates placing the mouse pointer over a target and pressing

Double-click the left button on the mouse twice.

Indicates placing the mouse pointer over a target and holding
Drag down the left button on the mouse while moving the mouse
pointer.

Indicates dragging to the intended location and releasing the

Drag and drop left button on the mouse.

Names of buttons and windows displayed on screen are
Text enclosed in [ ] described enclosed in square brackets.
E.g.: Click [OK].

Input values, text, and the keys on the keyboard are described
Text enclosed in " " enclosed in double quotation marks.
E.g.: Press the "N" key while holding down the "Ctrl" key.
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Using This Manual

Using This Manual

The instruction manuals for the LabSolutions RF software (hereafter "LabSolutions RF")
comprise the following manuals including this manual.

Refer to the corresponding instruction manual for details on the operation of
LabSolutions RF.

Document Name Docll:lrgent Description
LabSolutions RF Setup 207-90012 This manual explains installation and environment
Procedure settings for the LabSolutions RF software.

LabSolutions RF
Instruction Manual [Basic
Operation Manual] (this
manual)

This manual explains specifically how to perform
206-97926 basic operations using the LabSolutions RF
software.

The basic operation manual is aimed at new users of LabSolutions RF and describes the
basic functions and operating procedures of the software. For details on each command
of LabSolutions RF and execution method, refer to the help file provided with
LabSolutions RF.

Explanations in this manual are structured as follows.

Structure Description

Chapter 1 Basic Software Provides an outline of LabSolutions RF.

Operation

Chapter 2 Starting and Describes the startup procedures from turning on the
Shutting Down the System system to software startup.

Chapter 3 Launcher Describes how to use the LabSolutions RF launcher.
Chapter 4 Spectrum Describes how to measure a spectrum.

Chapter 5 3D Spectrum Describes how to measure a 3D spectrum.

Describes how to perform quantitative measurement that

Chapter 6 Quantitation employs the multi-point calibration curve method.

Chapter 7 Photometric Describes how to perform photometric measurement.
Chapter 8 Time Course Describes how to perform time-course measurement.
Chapter 9 Data Processing Describes how to use the data processing functions.
Chapter 10 Printing Describes how to use the printing function.

Chapter 11 Quantum Yield Describes how to perform quantum yield measurement.

Describes how to perform quantum efficiency

Chapter 12 Quantum Efficiency measurement

Describes how to operate the management tools used for
Chapter 13 Management Tools | instrument management, registration, and performance
checks.
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Introduction

While this manual describes examples of operation that are considered to be the most
frequently performed, these examples may not always match your specific operational
requirements. In this case, an understanding of basic methodology and operating
procedures can be attained by performing operations based on the actual examples
provided in this manual.

Shimadzu recommends performing the examples in this manual in order to become
accustomed with software operations.

For explanations on items not covered in the above chapters, refer to the help file
provided with LabSolutions RF.
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Warranty

Shimadzu provides the following warranty for this product.

1.

*

Period:

Please contact your Shimadzu representative for information about the period of this warranty.

Description:

If a product/part failure occurs for reasons attributable to Shimadzu during the warranty period,

Shimadzu will repair or replace the product/part free of charge. However, in the case of products
which are usually available on the market only for a short time, such as personal computers and
their peripherals/parts, Shimadzu may not be able to provide identical replacement products.

Limitation of Liability:

(1) In no event will Shimadzu be liable for any lost revenue, profit or data, or for special, indirect,
consequential, incidental or punitive damages, however caused regardless of the theory of
liability, arising out of or related to the use of or inability to use the product, even if Shimadzu

has been advised of the possibility of such damage.

(2) In no event will Shimadzu's liability to you, whether in contract, tort (including negligence), or

otherwise, exceed the amount you paid for the product.

Exceptions:

Failures caused by the following are excluded from the warranty, even if they occur during the

warranty period.
(1) Improper product handling

(2) Repairs or modifications performed by parties other than Shimadzu or Shimadzu designated

companies
(3) Product use in combination with hardware or software other than that designated by Shimadzu

(4) Computer viruses leading to device failures and damage to data and software, including the
product's basic software

(5) Power failures, including power outages and sudden voltage drops, leading to device failures
and damage to data and software, including the product's basic software

(6) Turning off the product without following the proper shutdown procedure leading to device
failures and damage to data and software, including the product's basic software

(7) Reasons unrelated to the product itself

(8) Product use in harsh environments, such as those subject to high temperatures or humidity levels,

corrosive gases, or strong vibrations

(9) Fires, earthquakes, or any other act of nature, contamination by radioactive or hazardous

substances, or any other force majeure event, including wars, riots, and crimes
(10) Product movement or transportation after installation
(11) Consumable items

Recording media such as CD-ROMs are considered consumable items.

If there is a document such as a warranty provided with the product, or there is a separate contract
agreed upon that includes warranty conditions, the provisions of those documents shall apply.
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Introduction

Software License Agreement

PLEASE READ THIS AGREEMENT CAREFULLY BEFORE USING THE SOFTWARE.

SHIMADZU Corporation ("SMZ") is willing to license the SMZ software provided herein,
together with accompanying documentation (collectively "SOFTWARE") to you only upon
the condition that you accept all of the terms and condition contained in this License
Agreement. By using the SOFTWARE, you agree to be bound by the terms of this
Agreement. If you do not agree to all these terms of this Agreement, promptly return
the unused SOFTWARE to the party (either SMZ or its reseller) from whom you acquired
it to receive a refund of the amount you paid.

1. License

SMZ grants you a non-exclusive and nontransferable license to use the SOFTWARE subject to the
following terms and conditions.

2. Limitation of Use
Except as specifically authorized by SMZ, you may NOT:

(1) Use the SOFTWARE, or permit the SOFTWARE to be used, on more than one computer at any
one time.

(2) Copy the SOFTWARE except one (1) archival copy of the SOFTWARE.

(3) Modify, reverse engineer, decompile, disassemble, or create derivative works based upon the
SOFTWARE.

(4) Transfer, rent, lease or grant any rights in the SOFTWARE in any form to anyone else.

3. Title and Ownership

This license is not for sale and it may not be assigned or sublicensed to anyone else. Title and all
associated intellectual property rights to the SOFTWARE shall remain in SMZ and/or its licensor.

4. Upgrades

You are entitled to receive all official software upgrades for the SOFTWARE that SMZ will release
as deemed necessary by SMZ. An upgrade means certain supplemental program modules and/or
information for bug fixing and/or updates to the defects and/or failures of the SOFTWARE that are
acknowledged or confirmed by SMZ. An upgrade excludes hardware, network, consulting services,
third party products, operation and general computer system maintenance. All supplemental program
module for upgrades and enhancements furnished to you shall be deemed to be part of the
SOFTWARE and subject to the terms and conditions set forth in this Agreement.

5. Limited Warranty

SMZ warrants that for a period of one (1) year from the date of purchase, as evidenced by a copy
of the receipt, the media on which SOFTWARE is furnished will be free of defects in materials and

workmanship under normal use.

Except for the foregoing, SOFTWARE is provided AS IS. Your exclusive remedy and the entire liability
of SMZ and its suppliers under this limited warranty will be, at SMZ's option, repair, replacement,
or refund of the Software if reported (or, upon request, returned) to the party supplying the
SOFTWARE to you. In no event does SMZ warrant that the Software is error free or that you will
be able to operate the SOFTWARE without problems or interruptions.
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Software License Agreement

EXCEPT AS SPECIFIED IN THIS WARRANTY, ALL EXPRESS OR IMPLIED CONDITIONS, REPRESENTATIONS,
AND WARRANTIES INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTY OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, NONINFRINGEMENT, ARISING FROM A
COURSE OF DEALING, USAGE, OR TRADE PRACTICE, ARE HEREBY EXCLUDED TO THE EXTENT
ALLOWED BY APPLICABLE LAW.

. Limitation of Liability

IN NO EVENT WILL SMZ BE LIABLE FOR ANY LOST REVENUE, PROFIT OR DATA, OR FOR SPECIAL,
INDIRECT, CONSEQUENTIAL, INCIDENTAL OR PUNITIVE DAMAGES, HOWEVER CAUSED REGARDLESS
OF THE THEORY OF LIABILITY, ARISING OUT OF OR RELATED TO THE USE OF OR INABILITY TO USE
SOFTWARE, EVEN IF SMZ HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. IN NO EVENT
WILL SMZ'S LIABILITY TO YOU, WHETHER IN CONTRACT, TORT (INCLUDING NEGLIGENCE), OR
OTHERWISE, EXCEED THE AMOUNT YOU PAID FOR SOFTWARE.

. Termination

This License is effective until terminated. You may terminate this License at any time by destroying
all copies of SOFTWARE including any documentation. This License will terminate immediately
without notice from SMZ if you fail to comply with any provision of this License. Upon termination,
you must destroy all copies of SOFTWARE.

. General

(1) This Agreement is the entire agreement. If any provision of this agreement is held invalid, the
remainder of this agreement shall continue in full force and effect.

(2) This Agreement shall be construed and governed in accordance with the laws of Japan, excluding
its conflict of law rules.

(3) The exclusive jurisdiction for any disputes arising out of or in connection with this Agreement
shall be Kyoto District Court of Japan.

(4) The invalidity or unenforceability of any provision of this Agreement shall not affect the validity
or enforceability of any other provision.
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Introduction

Precautions for Use

B Latest Information
The latest information on LabSolutions RF is described in the "ReleaseNotes" file that is
displayed by clicking @ (Start) - [All Programs] - [Shimadzu] - [LabSolutions RF] -

[Release Notes]. Read this information thoroughly before operating the product.

B Compatible OS

LabSolutions RF is only compatible with the 32- and 64-bit versions of Windows 7
Professional.

B Screensaver

If the screensaver activates during time-course measurement, consecutive measurements,
or other types of measurements, the software may stop operating. Turn off the Windows
screensaver function.

B Resident Programs Including Anti-Virus Software

Resident programs, such as anti-virus software, running on the PC used for LabSolutions
RF may cause the LabSolutions RF software to start up and exit slowly.
Do not allow such software to run when using LabSolutions RF.

H Text Input

LabSolutions RF does not support environment-dependant characters (Unicode).
Do not enter text using environment-dependant characters (Unicode).

B Numerical Value Input

Always enter numerical values into LabSolutions RF using one-byte characters.

viii
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Basic Software Operation

This chapter provides an outline of the LabSolutions RF software (hereafter "LabSolutions
RF") and explains basic operation.

PP Reference For cases not covered in this chapter and detailed descriptions and information on
LabSolutions RF functions, refer to the help file provided with LabSolutions RF.

B Explanations Included in this Chapter

This chapter provides an overview of LabSolutions RF specifications and applications.

1.1 Overview

LabSolutions RF comprises various applications for performing instrument control and
data analysis using the Shimadzu Spectrofluorophotometer series as well as software and
tools used for instrument management.

e Applications for performing basic measurement and related data analysis (hereafter

"Basic Analysis")

Application Specifications
Scan the fluorescence (excitation) spectrophotometer using any
excitation (fluorescence) wavelength to capture a fluorescence
(excitation) Spectrum.
Synchronized scanning, which captures data by scanning
Spectrum excitation and the spectrofluorophotometer at the same time

while keeping the interval between the excitation wavelength
and fluorescence wavelength constant, is also supported.

PP Reference "4 Spectrum" P.34

3D Spectrum

Repeatedly measure fluorescence spectra at any excitation
wavelength interval and draw the results in 3D.

Repeated measurement of fluorescence spectra at any time
interval and capturing fluorescence spectra in 3D is also
supported.

PP Reference "5 3D Spectrum" P.49

Quantitation

Create a calibration curve from the fluorescence intensity
captured from the standard sample to determine the
concentration of unknown samples.

Quantitation using peak values and areas within a specified
wavelength range is also supported.

D) Reference "6 Quantitation” P.63
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1 Basic Software Operation

Application

Specifications

Photometric

Capture fluorescence intensity at any fixed wavelength (multiple
wavelengths can be set).

Calculation results and pass/fail judgments can be obtained in
conjunction with measurement by using captured data to
create/register arithmetic expressions with the four basic
arithmetic operations and judgment criteria.

PP Reference "7 Photometric" P.83

Time course

Capture changes in fluorescence intensity over time at any fixed
wavelength.

Calculation of enzyme reaction activity values based on the
gradient of the change in fluorescence intensity over time is
also supported.

D) Reference "8 Time Course" P.99

¢ Applications for performing specific analysis (hereafter "Special Analysis")

Application

Specifications

Quantum Yield

Determine the Quantum Yield of an unknown sample by using
the fluorescence Spectrum of a standard sample (with a known
Quantum Efficiency) and the fluorescence Spectrum of the
unknown sample.

PP Reference "11 Quantum Yield" P.157

Quantum Efficiency

Use an integrating sphere to determine the Quantum Eficiency
from the fluorescence Spectrum in the blank state and the
fluorescence Spectrum of the sample.

PP Reference “12 Quantum Efficiency" P.176

e Tools used in instrument

management (hereafter "management tools")

Tool

Specifications

RF Performance Validation
Software

Check instrument performance (such as wavelength accuracy
and S/N ratios).

PP Reference "13.5 Checking RF-6000 Performance" P.208

Register Device

Register instruments (spectrofluorophotometer and integrating
sphere) that connect to LabSolutions RF.

PP Reference "13.1 Registering an Instrument" P.193

Spectrum Correction
Function Measurement
Tool

Create correction functions used in Spectrum correction when
an integrating sphere is installed.

PP Reference "13.2 Registering an Integrating Sphere" P.196
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1.1 Overview

1.1.1 Specifications

Item Specification
Operating system Microsoft Windows 7 Professional 32/64-bit version
Required hard disk space 40 GB min.
Required memory 4 GB min.
e RF-5300PC/5301PC (RF-5300 series)

Controllable devices
e RF-6000

Basic Analysis

e Excitation Spectrum, fluorescence Spectrum,

Spectrum synchronous Spectrum

* Repeated measurement in a specified time interval
(3D excitation Spectrum, 3D fluorescence Spectrum,
3D synchronous Spectrum)

3D Spectrum e Fluorescence Spectrum measurement at a specified

excitation wavelength interval (3D Spectrum)

e Excitation/fluorescence Spectrum extraction

e Quantitation using the peak / maximum value / area
etc. of single wavelengths, multiple wavelengths
(including single, double, and triple wavelength
methods), and specified wavelength ranges

o K-factor method, single-point calibration curve
method, and multi-point calibration curve method
(1st, 2nd, and 3rd order function-fitting, zero
intercept can be specified)

Quantitation

® Photometric processing with user-defined functions
(functions that use addition, subtraction,
multiplication, and division can be embedded
together with factors)

e Capturing the fluorescence intensity of single
wavelengths and multiple wavelengths as well as
peak / maximum value / area in specified

_ wavelength ranges
Photometric . ] ) ) )
® Photometric processing with user-defined functions

(functions that use addition, subtraction,
multiplication, and division can be embedded
together with factors)

e Time course recording using up to 4 wavelengths

e Calculation of a difference between 2 wavelengths

) and a ratio
Time course . .
e Activity value calculation

e Event recording of reagent additions during
measurement

e Processing, data printing, point pick, peak pick, area
calculation, constant calculation, data set calculation,
1st to 4th order differentiation, smoothing, common
logarithm transformation, natural logarithm
transformation, reciprocal transformation,
exponentiation, square root, index transformation of
waveform data (Spectrum/Time course)

Data processing functions
(common)
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1 Basic Software Operation

Item

Specification

Printing functions

¢ Report template creation

e Printing using report templates

File functions

e Automatic conversion to CSV file and text file (.txt)
formats
(Only manual text conversion in the Quantitation
and Photometric applications)

Special Analysis (note: unavailable o

n the RF-5300 series)

Quantum Yield

e Quantum Yield calculation of unknown samples

e Display and printing of results list of multiple
samples

e Text conversion of Spectrum data

Quantum Efficiency™

e Calculation of sample absorption factors, internal
Quantum Efficiency, and external Quantum Efficiency

e Display and printing of results list of multiple
samples

e Text conversion of Spectrum data

Management tools

RF Performance Validation
Software

S/N ratio, Stability, Wavelength Accuracy™?
Wavelength Repeatability*?, resolution (emission
side)™?, and results of initialization

B NOTE The only test item that can be executed
on the RF-5300 series is S/N ratio.

Register Device

Registration of spectrofluorophotometer and
integrating spheres

Spectrum Correction Function
Measurement Tool

Creation of correction functions when an integrating

sphere is installed (unavailable on the RF-5300 series).

*1 An integrating sphere unit (option) is required.

*2 A mercury lamp unit (option) is required. Unavailable on the RF-5300PC/5301PC models.

4
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1.1 Overview

1.1.2 Analysis Application Window Layout

The layout of the Basic Analysis application window in LabSolutions RF is shown below.

P) Reference For details on the parts that comprise the window, refer to the help file provided with
LabSolutions RF.
For details on the window layout of the Special Analysis applications, see the chapter that
describes each application.

7] Spectrum(RF-6000)-(Measurement] == e

L File Edit View Graph Instrument Tools Window Help

T o

1y r r f
= | &t
D+ [ 1] [z ﬁ 7| Set file name automaticaly >> &t
| Close ‘ GvTuW'L‘ AutoZem (| Search |  AutoFle[ Date Time].fs2f | Disconnect
EX EM
@‘ 350.0 350.0
-1360.0
o Arclamp  OMN (352 hours)
tosd
Parameter Value o
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N ﬂ?!hﬂg .U nm
Shut!er Me.tor C.heck - 0K Data Interval L0 nin
Ernission Side Slit Motor Check - Scan Speed 6000 nmfmin | =
Emission Side Grating Motor Che
Total Judgment - OK [Enstrumant]
Instrument Function Acquisition EX Bandwidth 5.0nm
6_ Are Lamp - mounted EM Bandwidth 5.0mm
Are Lamp - Total Lighting Time: |2 Senalthvity Low
Mercury Lamp - unmounted [Attachment]
Integrating Sphere - Not Used e : e
Sipper - Not Used
Connection - Passed = [Auto Print] -
7 = % ‘ (] '
= 44
Window Layout
No. Name Function

Displays information including the application name,
(1) Title bar registered instrument name, and window mode
([Measurement] or [View]).

Displays the application menus. Selecting a menu

along the bar displays multiple command menus. The
2 Menu bar displayed command menus differ depending on the
application type and window mode.

Displays tool buttons for executing main functions,

© Main toolbar such as file operations, printing, and data processing.

Displays the open data file and data set contained in
this file in tree format. Operations including switching
the active data set and closing open files can be
performed.

(4) Tree view

Displays and records logs that indicate the instrument
(5] Log view status and operations performed on the system as well
as warnings.
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No. Name Function

Displays a graph, data processing table, and

6 Application area information on measurement parameters. The type of
view displayed in the area and layout differ

depending on the application.
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1.1 Overview

1.1.3 Window Mode Selection

Each Basic Analysis application window in LabSolutions RF has a "measurement mode",
"view mode", and "edit print form mode".

The window mode can be changed by clicking [Measurement], [View], and [Edit
Printform] on the main toolbar.

The functions of each window mode differ depending on the analysis application. For
details, see the chapter of the relevant analysis application in this manual or refer to the
help file provided with LabSolutions RF.

Name Function

This mode is used when controlling an instrument to capture data.
The "measurement toolbar" used for instrument control and
measurement, "istrument status" that indicates the status of
connected instruments, and "parameter view" that allows
configuration of measurement parameters and other settings are
displayed.

Measurement mode

This mode is used when performing data processing on captured
data.

View mode The data processing button on the main toolbar becomes active and
data processing items become selectable.
This mode is used when creating, editing, and saving report files for
printing.

Edit printform The report layout can be edited while graphs and different data

processing tables are displayed and the user does not need to
change the window to print after editing.

1.1.4 LabSolutions RF Data Formats

LabSolutions RF data files internally store both the original data from measurement as
well as any calculation results obtained from the various data processing functions.

A single Basic Analysis application data file generally stores multiple data.

In addition, each data set is appended with auxiliary information.

e Data sets contained in files (for Spectrum and 3D Spectrum data)

Item Description
Data prior to Spectrum correction.
Raw data On the RF-5300PC, this data is the sample data that is normally
(measurement data) used because the RF-5300 series does not have the Spectrum

correction function.

Data that has undergone Spectrum correction and is normally
Correction data used as the sample data.
On the RF-6000, this data set is used for sample analysis.

Data converted or generated in waveform processing.

Converted data (Only Spectrum.)

LabSolutions RF Basic Operation Guide 7



1 Basic Software Operation

e Data sets contained in files (for Quantitative and Photometric data)

Item

Description

Standard table

Table data that includes sample information and concentration.

Unknown sample table

Table data that includes sample information, concentration, and
calculation results.

e Data sets contained in files (for Time course data)

Item

Description

Raw data
(measurement data)

Sample data that is normally used.
This data set is used in sample analysis.

Converted data

Data converted or generated in waveform processing.

e Auxiliary data appended to each data set

Item

Description

History

History of data set generation and modification

Measurement parameters

Parameters used during measurement

Summary

General information on the data set (such as software version,
analysis time and date, and instrument information)

Peak pick table

Peak table generated using the "peak" pick function

Point pick table

Point pick table generated using the "point pick" function and
"batch point pick" function

Peak area table

peak area table generated using the "area calculation
function".

8
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1.1.5 File Formats of the LabSolutions RF Software

The following file formats can be used with LabSolutions RF.

e Data files

Name

Extension

Description

Spectrum file

fs2f

Data file created in the Spectrum application.

This file contains Spectrum (waveform) data, measurement
parameter information, file information (summary), data
history, peak pick data, point pick data, and area
calculation data.

3D Spectrum file

fs3f

Data file created in the 3D Spectrum application.

This file contains 3D Spectrum data, measurement
parameter information, file information (summary), and
data history.

Calibration curve
file

fqcf

Calibration curve data file created in the Quantitation
application.

This file contains standard table data, measurement
parameters™, calibration curve parameters, file information
(summary), and data history.

Quantitation file

fqqf

Quantitation result data created in the Quantitation
application.

This file contains standard sample / sample table data,
measurement parameters™!, calibration curve parameters,
file information (summary), and data history.

Photometric file

fquf

Measurement result data created in the Photometric
application.

This file contains sample table data, measurement
parameters, file information (summary), and data history.

Time course file

fttc

Data of changes in fluorescence intensity over time created
in the Time course application.

This file contains Time course (waveform) data,
measurement parameter information, file information
(summary), data history, peak pick data, point pick data,
and area calculation data.

Quantum Yield
file

faty

This measurement result data is created in Quantum Yield
measurement.

This file contains standard/unknown sample Spectrum
(waveform) data, analysis results, and file information (such
as summary information and measurement conditions).

Quantum
Efficiency file

fqte

This measurement result data is created in Quantum
Eficiency measurement.

This file contains blank/sample Spectrum (waveform) data,
analysis results, and file information (summary,
measurement conditions, etc.).

Test results file
(Validation)

fpvr

This test result data is created by the RF performance
validation software.

This file contains waveform data, test conditions, test
results, and file information (such as summary information)
for each test item.

LabSolutions RF Basic Operation Guide
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Name

Extension

Description

Text file
(Spectrum)

txt

Data file created (output to text file) in the Spectrum
application (can be loaded).

This text format file contains horizontal axis values
(wavelength) and the corresponding vertical axis values
(fluorescence intensity) delimited with commas or other
characters™.

Text file
(3D Spectrum)

txt

Data file created (output to text file) in the 3D Spectrum
application (cannot be loaded).

This text format file contains X-axis values (fluorescence
wavelength)*3, Y-axis values (excitation wavelength or
time)*3, and Z-axis values (such as fluorescence intensity)
delimited with commas or other characters™.

Text file
(Quantitation)

txt

Data file created (output to text file) in the Quantitation
application (cannot be loaded).

This text format file contains standard sample and sample
table items and data delimited with commas or other
characters™.

Text file
(Photometric)

txt

Data file created (output to text file) in the Photometric
application (cannot be loaded).

This text format file contains sample table items and data
delimited with commas or other characters™.

Text file
(Time course)

txt

Data file created (output to text file) in the Time course
application (cannot be loaded).

This text format file contains horizontal axis values (time)
and the corresponding vertical axis values (such as
fluorescence intensity) delimited with commas or other
characters™.

Text file
(Quantum Yield)

txt

Result file created (output to text file) in the Quantum
Yield application (cannot be loaded).

This text format file contains horizontal axis values (time)
and the corresponding vertical axis values (such as
fluorescence intensity) delimited with commas or other
characters™.

When saving, any of the following three types can be
selected: standard sample, any unknown sample, or all
unknown samples.

Text file
(Quantum
Efficiency)

txt

Result file created (output to text file) in the Quantum
Eficiency application (cannot be loaded).

This text format file comprises waveform data of blank
spectra and sample spectra and contains horizontal axis
values (wavelength) and the corresponding vertical axis
values (fluorescence intensity) delimited with commas.

Data Print Table

txt

Data processing result file created in the Spectrum and
Time course applications (cannot be loaded).

This text format file contains data print table items and
data delimited with commas or other characters™.

Point Pick Table

txt

Data processing result file created in the Spectrum and
Time course applications (cannot be loaded).

This text format file contains point pick table items and
data delimited with commas or other characters™.

10
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Name Extension Description

Data processing result file created in the Spectrum and
Time course applications (cannot be loaded).

This text format file contains peak pick table items and
data delimited with commas or other characters™.

Peak Pick Table | txt

Data processing result file created in the Spectrum and
Time course applications (cannot be loaded).

This text format file contains peak area table items and
data delimited with commas or other characters™.

Peak Area Table | txt

Data processing result file created in the Time course
application (cannot be loaded).

Main Table txt This text format file contains main table items and data
delimited with commas or other characters*2.
Data processing result file created in the Time course

Intensit application (cannot be loaded).

D'fferer):ce Table txt This text format file contains intensity difference table

! items and data delimited with commas or other

characters™.

RFPC Spectrum soc This is an RFPC software file format.

file P This file can be loaded into the Spectrum application.

RFPC Time tme This is an RFPC software file format.

course file This file can be loaded into the Time course application.

*1 Configured as the application's measurement parameters when the data file is loaded.

*2 Depends on the application setting when saving. Measurement parameters and summary information
can be included when saving.

*3 The X axis and Y axis can be selected when performing text conversion from the application.
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¢ Measurement parameter files

Application Extension Description
This file stores measurement, instrument, and attachment
Spectrum fm2f
parameters.
This file stores measurement, instrument, and attachment
3D Spectrum fm3f
parameters.
This file stores wavelength, calibration curve, measurement
o (standard sample), measurement (sample)
fmqf . ! . ! .
Quantitation ma instrument, attachment, calculation, and pass/fail
parameters.
This file stores wavelength, measurement (sample),
Photometric fmff instrument, attachment, calculation,
and pass/fail parameters.
. This file stores wavelength, measurement, instrument, and
Time course fmtc
attachment parameters.
e Template files
Name Extension Description
Spectrum Peak fsta Template file for peak area tables that contain the
Area template wavelength range and coefficients used in area calculation.
Spectrum Point fst Template file for point pick tables that contain the
Pick template P wavelengths used in point picking.
Time course Template file for peak area tables that contain the time
Peak Area ftta . .
range and factors used in area calculation.
template
T'”.‘e course Template file for point pick tables that contain the times
Point Pick fetp used in point pickin
template P P 9-
o Quantitation measurement file that contains standard
Quantitation . . .
fqtf sample / sample table information without any data,
template . .
measurement parameters, and calibration curve parameters.
. Photometric measurement file that contains sample table
Photometric . . .
futf information without any data, and measurement
template
parameters.
Report template | frpt Template file for printing that contains printable items.
e Other
Name Extension Description
This file contains the history of operations performed using
the software.
Log log

The contents of this file can be checked via [System Log] -
[View] on the [Tools] menu.

12
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1.2 Window Operation

This section explains window operation in LabSolutions RF.

1.2.1 Tree View Operations

The tree view structure is shown below.
Display or hide the tree view by clicking [Tree View] on the [View] menu.

= Jb RAMAN .f s2f —————— I[Datafile name]

V) E RawData ————— I[Original data:waveform databefore spectrum correction]

: 1LE CorrectionData
VI Dataset 185324

[Corrected data: waveform data after spectrum correction]

[Transformed data: waveform data transformed through data operations]

Example of Spectrum Data

!NOTE e When using the RF-6000, [RawData] in Spectrum measurement and 3D
Spectrum measurement is considered internal data and is therefore not shown
by default. This data can be set to be shown or hidden in the [User Settings],
which are accessible from the [Tools] menu.

e [CorrectionData] does not exist on the RF-5300 series because the Spectrum
correction function is not installed on this model.

Measure a sample or open data to display data in the tree view and graph view.

At first, data is displayed at the top of the hierarchical structure. When data is processed,
new data is added at a lower level.

If other data is added, it is displayed at the top of the hierarchical structure. Close data
to remove the data from the tree view and graph view.

P) Reference For details on the data format of displayed data, see "1.1.4 LabSolutions RF Data Formats"
P.7.

The following operations can be performed on data in the tree view of the Spectrum

application.
- lgr 53_02 fs2f
e .E R awD ata
----- .E Eu:urrec:tlnnData
N .E D atazet 18
-] 5300 fs2f
Operation Description
Display or hide the contents of the data set in the tree view.
Clicking [+] and [-] e Click [+] to display data sets lower in the hierarchy.
e Click [-] to hide data sets lower in the hierarchy.
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Operation

Description

Clicking checkboxes

Toggles between showing and hiding data (waveforms).
e Selected: Displays waveforms on the [Overlay] graph.
* Unselected: Hides waveforms on the [Overlay] graph.

Deselect the checkbox next to the filename to hide the
waveforms of all data sets contained in the file.

Double-clicking data set
names

Toggles the active data set. The double-clicked data set
becomes the active data set.

PP Reference See "1.2.2 Specifying Data Sets (Activation)".

Right-click (on mouse)

Right-click on a filename or data set name to display a menu
specific to the current task or area. The following menu items
are displayed in the case of a Spectrum.

e Filename - [Show Full Path]: Displays the filename with it's
full path.

¢ Filename - [Close]: Closes the file.

e Data set name - [Text File Output]: Outputs the selected data
set to a text file.

P) Reference The menu items differ depending on the analysis
application. For details, refer to the help file provided
with LabSolutions RF.

Dragging a data set

Places a 3D graph on the [Tile] tab in the 3D Spectrum
application.

1.2.2 Specifying Data Sets (Activation)

When multiple data files (data sets) are loaded into the Spectrum, 3D Spectrum, and
Time course applications, the data set to be targeted for data processing must be
specified. In LabSolutions RF, the data set targeted for data processing through
specification is referred to as the "active data set".

:' Hint A data set is automatically selected as the active data set immediately after measurement

or loading.

The active data set is specified in the tree view.

1 Click the [+] that precedes the data filename in the tree view.
This expands the data file and displays all of the loaded data set names.

2V 53 01421
o) 53 02k
=¥

14
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Click the [Overlay] tab in the graph view.
Search for the data set to specify (set active) among the loaded data set waveforms and

check the line type and color.

2V 5300 Fs2f Active | Dverlay

¢ ~{VIH CorectionD ata |

o) 5302 fs2f

) = | orrectionDiata 191180 T T T T

15000.0

10000.0

Intensity

5000.0

-1585.2 L
300.0 32000 340.0 3600 380.0 400.0
nm

In the tree view, check the line type icon that precedes the data set name and
then double-click the name of the target data set.
This highlights the specified data set name in blue and sets the data set to active.

=V 53 01620
E| CarrectionD ata
=V 53 02020
E| ComectionD ata
=5 53 03620

Carrectionl ata

Click the [Active] tab in the graph view.
Check that the waveform of the target data set is displayed.

EI 53 071.f=2f Active | D\-'El|a_'r'|
i [VIH CorectiorData

[V S 02k

= - 177273

15000.0

10000.0

Irtensity

5000.0

-1585.4 L
300.0 32000 34000 360.0 3&0.0 400.0
nm
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1.2.3 Right-Click Menu

Right-click on the tree view or graph view to display a menu specific to the current task
or area. This allows commands to be easily executed without having to perform selection

via a menu or toolbar.

The following procedure shows how to display and use menus using the Spectrum graph

view as an example.

Click the [Active] tab in the graph view.

=

2 Right-click on the active graph.

The active graph right-click menu is displayed.

provided with LabSolutions RF.

PP Reference For details on the active graph menu, refer to the help file
Active | Dve[la_lrl|
177273 T
15000.0 - Ho -
Auto Scale
= 10000.0 - Cursor T
"]
[
E Lock Cursor
5000.0 Customize... ]
Vertical axis
walll Print 1
15854 — L
300.0 Properties... 0 380.0 2000

16
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Click [Customizel.
The [Customize Graph] window is displayed.

PP Reference The [Customize Graph] window can also be displayed by selecting [Customaize] on the
[Graph] menu.

Customize Graph

Line Colors | Limits I Appearance | Settingsl

Data: Basic Colar:

=== C\RF-Data"\Data\53_03f=2

EEEEETE

Annotation:  Line Width: Created Colar:

o-| B-| Frrrrrrrr
Frrrrrrr
[ Create Color... ]

[ ok || Ccancel
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2 Starting and Shutting Down the System

This chapter explains how to start and shut down the Shimadzu Spectrofluorophotometer
system.

PP Reference For details on Windows operation, refer to the relevant Windows manual.

B Explanations Included in this Chapter

This chapter explains the procedure for starting the system, from turning on power to
software startup, assuming that the personal computer (hereafter "PC") and instrument
are connected using the communication cable and the LabSolutions RF software is
installed on the PC.

2.1 Turning the Power ON

2.1.1 For RF-6000

1 Turn ON the main switch on the RF-6000.
Initialization of instrument settings starts.

2 Turn ON power to the PC.
R— A system check is performed and then Windows starts up.

2.1.2 For RF-5300 Series

1 Turn ON the main switch on the RF-5300 series.

2 Turn ON power to the PC.
— A system check is performed and then Windows starts up.

2.2 Registering an Instrument

Before starting up any of the analysis applications, information on the connected
instrument must be registered in LabSolutions RF.
Instrument registration is performed using the "Register Device" tool in LabSolutions RF.

PP Reference For information on the registration method, see "13.1 Registering an Instrument" P.193.

18
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2.3 Connecting the Instrument

2.3.1 Starting an Analysis Application

This section explains application startup using the spectrum general analysis application
as an example.

1 ‘ Double-click E (LabSolutions RF) on the desktop.

:’ Hint The software can also be started by clicking the [Start] button, navigating to [All
Programs] - [Shimadzu] - [LabSolutions RF], and clicking [LabSolutions RF].

The LabSolutions RF launcher starts.

E sHIMADZU

LabSolutions RF

Manage

Bazic Analysis

P4 =

Quantitation Photometric Tim

LabSolutions RF Launcher
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2 Starting and Shutting Down the System

2 ’ Click [Spectrum] on the [Fluorescence] tab.

The spectrum general analysis application starts.

Spectrum [Measurement]
File Edit View Graph Instrument Tools Window Help
l'i" - I
=i v
Saw Print Me: =me
= i =5 +
\/b \\_j:, v Set file name automatically b4
Open J Go To WLJ Auto Zero J Search J AutoFile[ Date_Time]. fs2f Connect
Overlay ‘
3756.5 . .
30000 =
=
Parameter Value  *
[Measurement]
Message = 20000 B Spectrum Type Emission
PR § EX Wavelength 350.0nm
System Initialization £ EM Wavelength Start ~ 350.0 nm
- EM Wavelength End 450.0 | =
Data Interval 1.0nm
10000} - Scan Speed 6000 nm,|
[Instrument]
EX Bandwidth 5.0 nm
EM Bandwidth 5.0 nm
0ol B Sensitivity Low
1 1 1 1
~267.2 [Attachment]
300.0 320.0 340.0 380.0 3800 400.0 attarhment o -
<[ v nm P 1 3
For Help, press F1
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2.3.2 Connecting to the Instrument

This section explains instrument connection using the spectrum application window for
the RF-5300 series as an example.

1 Click [Connect] on the measurement toolbar.

} v [V] Set file name automatically >> e +

S
Open Go To WL | | Auto Zero Search AutoFile[_Date_Time].fs2f Connect

Spectrum Measurement Toolbar (Instrument Disconnected)

The application connects to the instrument and the initialization of settings starts.

PP Reference For details on the items set during initialization, refer to the instrument instruction manual
or the help file provided with LabSolutions RF.

B NOTE The RF-6000 automatically performs initialization of settings when the power is
turned ON. Because the initialization of settings completes in a short time, if it
completes normally before communication is established, the [Initialization]
window is not displayed.

ilili!ﬁ:d.ioﬂ
Instrument: RF-5300

Serial Number: A40193301186SA

Version: 3.2
@ ROM
@ RAM
@ EEPROM
& Excitation Slit
@ Emission Slit
| Excitation Grating
(" Emission Graling
(" Zero sefting
[ Initializing @ Passed € Failed

OK

[Initialization] Window
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2 ’ Click [OK] after the settings are initialized.
— The instrument control button on the measurement toolbar becomes active and

I

Go To WL | | Auto Zero

measurement can now be performed.
AutoFile[ Date_Time].fs2f Disconnect

Spectrum Measurement Toolbar

L) 7, +O-
o] Open

{E

! NOTE If an NG occurs for any of the items set during initialization, a connection cannot
be established with the instrument.
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2.3.3 Instrument Status

When a connection is established with the instrument, the currently set wavelength and
fluorescence intensity are displayed in real time on the upper section of the instrument
status located on the right of the main window in the analysis application.

The lower section displays the lighting state and cumulative operating time of the light
source lamp and the type of any installed attachments. The cumulative operating time
of the light source lamp is updated every hour.

The lower section can be shown or hidden from the right-click menu of the instrument
status.

EX EM

307.0 400.0
0.0

' ArcLamp ON (280 hours) ’
. Lower section

Instrument Status

Upper section

The following table describes the meaning of each icon.

Icon Description

(Xenon) Xenon arc lamp

Indicates that the cumulative operating time is within the
service life range.

The service life of the xenon arc lamp used by the RF-5300

v series is 500 hours and the service life of the xenon arc lamp
used by the RF-6000 is 2000 hours.

Attachments (sipper, integrating sphere)

Indicates that a sipper or integrating sphere (RF-6000-only
option) is installed in the sample compartment.

(Xenon) Xenon arc lamp
o Indicates that the cumulative operating time of the xenon arc

lamp has exceeded the service life range.
The lamp must be replaced.
(Xenon) Xenon arc lamp
O A problem is occurring with the xenon arc lamp or lighting

circuit.
Contact your Shimadzu representative.
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2.34 Log View

The general analysis applications display instrument log information in the log view
located at the lower left of the window when a connection is established with the
instrument.

File Edit View Graph [nstrument Tools Window Help

-D@{- lb @ | ﬁ [V]5et file name automaticaly >3 % I
Gose | GoToWL | |AtoZem || Scarch 1 AutoFie[_Date_Time].f2f Disconnect
Duersy | v
350.0 350.0
3756.5
' ' ' ' -1722.6
« AucLamp ON [362 hours)
™
Message = 30000 -
- o] (o)
EEPROM Check - OK Parameter value -
& o

Har.dw.afe C_on |g.ura1|on oK (Heasreinény
Excitation Side Slit Motor Check - OK Spactrum Type Errisss
Excitation Side Grating Motor Check: = 20000 - 1 EX Wavelength 350.0 nm
Shutter Motor Check - OK § EMWavelength Start 350.0m
Emission Side Slit Motor Check - OK = EM WavelengthEnd 4500 nm
Emission Side Grating Motor Check - Data Interval 1.0nm =
Total Judgment - OK A Sean Speed 6000 nm min
Instrument Function Acquisition - Pa| 100001 B
Arc Lamp - mounted g‘mi S0
Arc Lamp - Total Lighting Time: 362 EM Bandwidth 5.00m
Mercury Lamp - unmounted Sensitivity Low g
Integrating Sphere - Not Used
Sipper - Mot Used e 1 [Attachment]
Connection - Passed -2672 L k ' ' Attachment None

b 300.0 3200 3400 380.0 380.0 400.0 -

\ F il F—rv— v L] | « m ] v
For Help, press F1
Log view
Log View

B NOTE  Although exiting the application clears the log view, log information is saved.
To reference previous log information, click [System Log] - [View] on the [Tools]
menu and check the required log in the displayed [System Log] window. For
details, refer to the help file provided with LabSolutions RF.
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2.4 Shutting Down the System

2.4 Shutting Down the System

B NOTE Do not turn off the power or press the reset switch on the PC while Windows |

is running.

2.4.1 Disconnecting From the Instrument

The spectrum application screen is used as an example to explain this operation.

1 Click [Disconnect] on the measurement toolbar.

Communication with the instrument stops and "OFF" is displayed on the instrument
status.

2.4.2 Exiting the Analysis Application

1 Click [End] in the [File] menu.
The analysis application closes. If an unsaved data file exists, a confirmation message
asking whether to save the data file is displayed.

2 Click [X] at the upper right of the LabSolutions RF launcher.
The LabSolutions RF launcher closes

2.4.3 Turning the Power OFF

1 Turn OFF the main switch on the instrument.

2 Shut down Windows.

3 Turn OFF power to the monitor.
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Launcher

This chapter explains how to use the LabSolutions RF launcher (hereafter "launcher").

PP Reference For cases not covered in this chapter and detailed descriptions on LabSolutions RF functions,
refer to the help file provided with LabSolutions RF.

B Explanations Included in this Chapter

This chapter explains the procedure for starting analysis applications and tools from the
launcher as well as registering external applications to the launcher.

B Functions Used in this Chapter

e Starting analysis applications and tools from the launcher

e Registering external applications to the launcher

3.1 Starting the Launcher

Double-click E (LabSolutions RF) on the desktop to start the LabSolutions RF

launcher.

ElsHIMADZU

LabSolutions RF

Manage
Bazic Analysis

P4 =

Quantitation Photometric Tim

LabSolutions RF Launcher
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3.1 Starting the Launcher

Launcher functions are divided into the following three types.

Name Function

Start LabSolutions RF analysis applications for fluorescence
[Fluorescence] tab measurement and any registered external applications or files
from this tab.

Start the RF performance validation software, instrument
[Manage] tab registration, spectrum correction function measurement tool,
and any registered external applications or files.

Perform operations including configuring the startup method of
[Settings] analysis applications and registering external applications to the
launcher.

:’ Hint  The launcher can be exited independently even if any analysis applications that were started
using the launcher are still displayed. The launcher can also be restarted when applications
are running.
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3 Launcher

3.2 [Fluorescence] Tab

Analysis applications for fluorescence measurement that uses the xenon arc lamp can be
started from this tab.

In addition, frequently used external applications can be started directly from the
[Fluorescence] tab by registering them.

E sHIMADZU

LabSolutions RF

Manage

Baszic Analysis

[Fluorescence] Tab

3.2.1 Analysis Applications

General analysis and special analysis applications can be started from this tab.

While multiple applications can be started at the same time, only one application can
communicate with the instrument.

Note that when using (or performing instrument registration of) the RF-5300 series, the
special analysis applications ([Quantum yield] and [Quantum efficiency]) cannot connect
to these instruments.

( B NOTE  Multiple instances of the same application cannot be started. ]
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3.2 [Fluorescence] Tab

3.2.2 External Applications

Frequently used external applications can be started from this tab by registering them.
In addition, folders on the PC that contain related data and information can be opened
directly from the launcher by registering them.

PP Reference For details on the registration method, see "3.4.2 Registering External Applications" P.32.
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3 Launcher

3.3 [Manage] Tab

Tools for instrument management and creating and saving correction functions for
integrating spheres can be started from this tab.

In addition, frequently used external applications can be started directly from the
[Manage] tab by registering them.

E sHIMADZU

LabSolutions RF

Manaze

Management Tool

g LSy

alidation

Application

[Manage] Tab

3.3.1 Management Tools

Tools for instrument management and creating and saving correction functions for
integrating spheres can be started from the [Manage] tab.

While the [Validation] and [Correction] tools can be started when other applications are
running, multiple instances of the same tool cannot be started.

3.3.2 External Applications

Frequently used external applications can be started from this tab by registering them.
In addition, folders on the PC that contain related data and information can be opened
directly from the launcher by registering them.

PP Reference For details on the registration method, see "3.4.2 Registering External Applications" P.32.
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Configuration

3.4 Configuration

Click [Settings] in the launcher to display the [Configuration] window.

External applications for starting from the launcher can be registered in the
[Configuration] window. Applications to be started together with the launcher when

starting LabSolutions RF can also be selected.

Configuration

Launching procedure
() Launcher and Window Spectrum window

@ Launcher only

Configuration for Application

Fucrescence | Manage

No. Title Filename

1 Help MLabSolutionsRF .chm
2 Operation Guide MLabSolutionsRF pdf
3

4

5

6

7

Up

Down

Delete

0K | [ Cancel

[Configuration] Window

3.4.1 Startup Settings

Set the applications to be started together with the launcher.

Configuration

Launching procedure

@ Launcher and Window Spectrum window
3D Spectrum window
Quantitation window
Corfiguration for Application Phaotometric window

() Launcher only

Time course window
Flucrescence - Quantum yield

Quantum efficiency
No. Title Filename Up
1 Help MLabSolutionsRF .chm o
2 Operation Guide ALabSolutionsRF pdf oun
3 Edt.
4
5 Delete
6
7

[ ok ][ cancel
Item Description

[Launcher and Window] together with the launcher.

Start the LabSolutions RF analysis application selected in the list

[Launcher only] Start only the launcher.
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3 Launcher

3.4.2 Registering External Applications

Register frequently used applications and PC folders to the launcher.

B Registering external applications

Up to a combined total of 14 external applications and folders can be registered (seven
each for the [Fluorescence] tab and [Manage] tab).

1 Click [Settings] in the launcher.

2 Click the tab ([Fluorescence] tab or [Manage] tab) for registering an external
application.

A list of registered external applications and folders is displayed.

Configuration @

Launching procedure
() Launcher and Window Spectrum window

@ Launcher onty

Configuration for Application

Flucrescence | Manage

Mo. Tile Filename Up
1 Help MlabSelutionsRF .chm Dow
2 Operation Guide \LabSolutionsRF pdf own
3 Edt...
4

5 Delete
[

7

oK || Cancel

[Configuration] Window

3 Click an empty number in the list to highlight the row and then click [Edit].
An [Edit Application] window is displayed.

Edit Application

Title

Browse Folder...

File/Folder

i
II@

| ok || Cancel |

[Edit Application] Window
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3.4 Configuration

Click [Browse File], select the application to be registered in the [Select File]
window, and then click [Open].

Select File @
——
@uv| | « Win7Eng64 (C:) » Windows » System32 » ~ [ 49 || Search system32 o
Organize « MNew folder =« @
X Favorites MName . Date modified Type g
. B Desktop || NOISE.CHS 6/10/2009 2:29 PM CHS File
& Downloads || NOISE.CHT 6/10/2009 2:29 PM CHT File
“5| Recent Places || NOISE.DAT 6/10/2009 2:32 PM  DAT File
a L noisejpn 6/10/2009 2:32PM  JPN File
4 Libraries E || noise.kor 6/10/2009 2:29 PM KOR File
@ Documents || NOISETHA 6/10/2009 2:29 PM THA File
Gb Music %] normaliz.dll 7/13/20096:09 PM  Application exten
] Pictures | Zl notepad 7/13/20096:14 PM__ Application
B videos %] npmproxy.dll 7/13/2008 6:16 PM Application exten
(%] nshhttp.dll 7/13/2009 6:16 PM Application exten
1% Computer %] nshipsec.dll 11/20/2010 7:24 PM  Application exten
£, WinTEngs4 (C:) %] nshwfp.dll 11/20/2010 7:24 PM  Application exten _
sl < 1 | b

ca Win7Jpn32 (D:)

File name: notepad

v [l Files ()

’)

o |

Cancel ]

[Select File] Window

( !NOTE A folder can be registered by clicking [Browse Folder] instead of [Browse File].

:' Hint  The application icon is set automatically. Click [Select] to change the icon.

Enter a title in the [Title] field and click [OK].

The user is returned to the [Configuration] window.

B NOTE The order of registered applications can be changed using the [Up] and [Down]

buttons.
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Spectrum

This chapter explains how to operate the spectrum general analysis application.

PP Reference For cases and functions not covered in this chapter, refer to the help file provided with
LabSolutions RF.

B Explanations Included in this Chapter

This chapter explains the procedures for measuring fluorescence spectra using distilled
water, changing the scale on graphs, and printing using the quick print function.

B NOTE Measurement parameter configuration is explained assuming that a connection
is established between an RF-6000 and LabSolutions RF.

B Functions Used in this Chapter

The following functions are used in spectrum measurement mode.

¢ Configuring measurement parameters, saving measurement parameter files
e Auto file function (setting filenames automatically)

e Fluorescence spectrum measurement

¢ Changing graph scales

¢ Printing (quick print)
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4.1 Startup

Startup

Click [Spectrum] on the [Fluorescence] tab in the LabSolutions RF launcher to start the
spectrum general analysis application.

The [Spectrum] window features a "measurement mode", "view mode", and "edit print
form mode" and the mode can be changed by clicking the relevant button on the main
toolbar.

P) Reference For details and operation method of the "edit print form mode" window, see "10 Printing"
P.135.

4.1.1 [Spectrum - [Measurement]] Window Layout

Spectrum(RF-01)- [Measurement] =@
Eile Edit Miew Graph [Instrument Tools Window Help
i (=]
=T 53 0162 - —
] ConectiorData +$H«|| = Om || W | setfermeacmacly _>> || £1 —
5 §3 0262 J ToW J J
W CoectiorData Close | |Go To WL | | Auto Zero | | Search
=PI 83 034521 -
v e (([ove T —
P 350.0 350.0
: ¥ b ! Y -4801.7
e o duclamp  ON (362 hours]
15000.0 -
e
| Parameter value A |
| Measurement]
Message - z 10000.0 i Spectrum Type Emission
EX Wavelength 350.0 nm
Shu_!tel Mr..»tol C.he(k - Ot g ; EM Wavelength Start 350.0 nm __e)
Emission Side 5lit Motor | EM Wavelength End 450.0m
Emission Side Grating Mc | Data Interva L0rm =
Tetal Judgment - OK 50000 | Scan Speed 6000 ramfrin
Instrument Function Acq |
Arc Lamp - mounted | Onstrument]
Arc Lamp - Total Lighting | EXBandwidth 3.0nm
Mercury Lamp - unmoun _ EM Bandwidth 3.0mm il
Integrating Sphere - Not 1 i Rl o
Sipper - Mot Used [Attachment]
Connection - Passed ~1595.2 . ! L ! Abtachment o
= 000 3200 3400 380.0 380.0 400.0 | -
<[am b _ Lt = | A2 o ___J _'__|
\ J
For Help, press F1

[Spectrum - [Measurement]] Window

The measurement mode is used when controlling an instrument to perform measurement.

No. Name Function

The buttons used for starting and stopping
measurement and performing instrument control are

o Spectrum measurement located on this toolbar.
toolbar Buttons such as [Start] become active after clicking
[Connect] and establishing a connection with the
instrument.

The upper section displays the current wavelength and
fluorescence intensity and the lower section displays
(2) Instrument Status the status of the spectrofluorophotometer.

PP Reference For details on the instrument status, see "2.3.3
Instrument Status" P.23.
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4 Spectrum

No. Name Function
Displays the settings of the currently configured
measurement parameters (settings such as parameters
P3) Parameter view related to measurement and whether to perform

automatic printing).
This view is used to configure, save, and load
measurement parameters.

(4] Spectrum graph view

Displays a spectrum graph in real time during
measurement. Only [Overlay] is available as the graph
display method.

:' Hint  Displaying and hiding of the spectrum graph is
performed in the tree view.

PP Reference For details on the operating procedure, see "1.2.
1 Tree View Operations" P.13.
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4.1 Startup

4.1.2 Spectrum - [View] Window Layout

= -
1] Spectrum(RF-01)-[View] ==
(Eile | Edit View Graph [nstrument Tool: Window Help
T ™ 3 r=.-<.l_="l=
-
Save
2Pl 53 0042 Active | Oveslay| Pacameter |
W Commetiorbe | Dveslay| || Pacameter |istory | Summaey
=H¥ES 53026 e ||| Parameter Value
[V ConectionData T T T T Messurement]
EHTE 53 0362 ;
L = Spectrum Type Emission
¥ EX Wavelength 307.0 nm
15000.0 EM Wavelength Start 300.0 nm -—o
EM Wavelength End 400.0 nm
Data Interval 0.5nm
Scan Speed 600 nmjirin
> 100000
&) E [Instrument]
e E EX Bandwidth 3.0nm
EM Bandwidth 3.0nm
S000.0 Sensitivity Low
[Attachment]
Message = Attachment Mone
Shutter Motor Check - OF
Emission Side Slit Motor ¢ L [Auto Print]
Emission Side Grating Mc -1585.4 L ! i 4 Auto Print No
Total Judgment - OK 000 320.0 240.0 - 2600 380.0 4000 Repart File
Instrument Function Acq = _J
Afe Lapnp - motinted [Peak Pick e 10 Points: 5 [ Execue
Are Lamp - Total Lighting
Mercury Lamp - unmoun _ No. | PV | Wavelength nm. ity I D
Integrating Sphere - Not |
& il [ @] 00| 6179
< [ v 4 o L

[Spectrum - [View]] Window

The view mode is used to perform operations such as data processing with respect to
captured or saved data.

No. Name Function

Displays measurement parameter information, data
history, and summary information (such as sample
information and instrument information) of the active
data.

(1) Parameter view

Displays a spectrum graph of the loaded data. [Active]
and [Overlay] are available as graph display methods.

. :\' Hint  Displaying and hiding of the spectrum graph is
12 Spectrum graph view performed in the tree view.
PP Reference For details on the operating procedure, see "1.2.
1 Tree View Operations" P.13.

Displays the parameter setting window for the Peak

Pick table, Point Pick table, and Manipulate.

(3] Data processing view
PP Reference For details on data processing, see "9 Data

Processing" P.118.
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4 Spectrum

4.2.1

Configuring and Saving Measurement Parameters

Create (configure) measurement parameters for measuring the fluorescence spectrum of
distilled water and save them to a file.

Measurement parameters can be set by loading a saved measurement parameter file.

Spectrum measurement parameters comprise "measurement (parameters)", "instrument
(parameters)", and "attachments" and are configured in the parameter view.

Configuring Measurement Parameters

PP Reference For details on each measurement parameter item, refer to the help file provided with
LabSolutions RF.

Display the measurement mode window and click [Settings] in the parameter
view.

The [Spectrum Measurement Parameters] window is displayed.

Configure the measurement conditions (parameters) on the [Measurement] tab.

Spectrum Mesurement Parameters ||

Measurement | instrument | Attachment |

o Spectrum Type: [E'm '}
Excitation Emission
Start (nm): 370
Wavelength (hm): 350 End (m): 430 g

Data terval )

@) Scan Speed fm/min):

?

— ] Perform Auto Print

Report File :

(oK J[ Comes |

[Spectrum Measurement Parameters] Window ([Measurement] Tab)

No. Measurement Condition Setting
(Parameter)
(1) [Spectrum Type] Emission
(2] [Excitation] 350 nm
e [Start]: 370 nm
(3) [Emission] e [End]: 430 nm
e [Data Interval]l: 0.1 nm
(4) [Scan Speed] 200 (nm/min)
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4.2 Configuring and Saving Measurement Parameters

Measurement Condition

A, (Parameter)

Setting

(5) [Perform Auto Print] No (unselected)

3 Configure the instrument conditions (parameters) on the [Instrument] tab.

Spectrum Mesurement Parameters @

instumert | Attachment

f Spectral Bandwidth

o__ Excitation: Sensitivity: Low v

Emission:

)

Save As... OK Cancel
| |

[Spectrum Measurement Parameters] Window ([Instrument] Tab)

Instrument Condition

e, (Parameter)

Setting

) e [Excitation]: 5.0 nm
o [Spectral Bandwidth] o
e [Emission]: 5.0 nm

(2] [Sensitivity] High
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4 Spectrum

4.2.2 Saving Measurement Parameters

1 Click [Save As] in the [Spectrum Measurement Parameters] window.

Enter a filename and click [Save].
The file is saved and the configured measurement parameters are accepted for use.

Savein:
- -
oo

Recent Places

Desktop
w=all
Libraries
‘A
Computer
= N
@

Network

, Parameters

Name

<

File name:

Save as type:

r Save As - Measurement Parameters File

- @ @E
Date modified

No items match your search.

||
|Ll

Type

-l

[ Sample001

)

[ Spectrum Parameters (*fm2/)

[1

[Save As - Measurement Parameters File] Window
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4.3 Configuring the Auto File Function (Setting Filenames Automatically)

Configuring the Auto File Function (Setting Filenames Automatically)

Filenames with the measurement start date and time or serial number appended to an
arbitrary character string can be created automatically.

:' Hint  While file information such as the sample name, ID, and comments can be entered in the
[New Data Set] window displayed for each measurement, measurement can be performed
without displaying this window.

PP Reference For details on this function and setting items, refer to the help file provided with
LabSolutions RF.

Select the [Set file name automatically] checkbox on the spectrum measurement
toolbar.

The [Settings] window of the auto file function is displayed.

! NOTE  |f the checkbox is already selected, click == | next to the checkbox.

¢

Close Go To WL

+De
J

o

% [[::Setﬂenameauhomaﬁdy ] >> g:

Spectrum Measurement Toolbar
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4 Spectrum

2 Set the auto file function conditions (parameters).
Settings
o——
|V Show new data set creation dialog when measurement is performed
f Filename 1( Sample Name
Name: ["]use sequential number
soc 4
o) Name: First No.: Step:
< Use date @ Use sequential number Test sample + 1 1
FirstNo.: 1 r
Sample: Spc_001.fs2f Sanme D B
| Use sequential number
Analyst Name Name: First No.: Step: 9
Shimadzu| (i 1
Comment [ Option
" | Use sequential number
e Name: First No.: Step: 9
& 1
(o ] [ concel
[Settings] Window
No. Condition (Parameter) Setting
[Show new data set
reation dial when
(1) creation dia o9 € Yes (selected)
measurement is
performed]
e [Name]: Spc
) [Filename] e [Use date]/[Use sequential number]: [Use sequential
number]
e [First No.]: 1
(3) [Analyst Name] Enter a name.

¢ [Name]: Test sample (example)
(4] [Sample Name] _
e [Use sequential number]: No (unselected)

e [Name]: -
(5) [Sample ID] _
e [Use sequential number]: No (unselected)

[ ] N -
(6) [Option] [Name]

e [Use sequential number]: No (unselected)

3 | dlick [OKI.

The [Settings] window closes and the filename is displayed on the spectrum measurement
toolbar.

O 9,
Stop

=

Go To WL

{g‘g Vlsetfiename automaticaly  >> | [ 21

=2
Close MoZem} J

search | [ soc_ooneaf | | Disconnect

+@De
|

Spectrum Measurement Toolbar
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4.4 Spectrum Measurement

4.4 Spectrum Measurement

Check that the shutter is closed (*ﬁ*) and then click [Auto Zero] on the

spectrum measurement toolbar.

2

Place the sample in the instrument's sample compartment and close the lid.

3

Click [Start] on the spectrum measurement toolbar.
The [New Data Set] window is displayed.

4

Enter a comment and click [OK].

[ New Data Set

Filename:

Data Set Name:
Analyst:
Sample Name:
Sample |D:
Option(Q]):

Comment:

C:\RF-Data\Data\Spe_001.fs2f 97] @
RawData
Shimadzu
Test sample
Sample data -
]
[ 0K ] [ Cancel

[New Data Set] Window
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4 Spectrum

Measurement starts and the captured data is graphed in real time.

Spectrum(RF-01)-[Measurement]
File Edit View Graph Instrument Tools Window Help
- = - Marip I (i
e Print Vi Edit Printform Peak Pick o
O © v Set file name automatically »>
Close | [Go To WL | [Auto Zero || Search Spe_006.fs2f Disconnect
Dvetay | -
350.0 404
3000 s
v Aclamp DM (85 hours)
 Sipper
Settings... Load...
2000 B
Parameter Value E
—_— [Measurement]
Message 1z Spectrum Type Emission
Mercury Lamp - Total E EX Wavelength 350.0 nm
Integrating Sphere - N £ EM Wavelength Start 370.0nm
Spper - sed 1000 1 orm w1
Connection - Passed -
Sipper - Installed Scan Speed 00 rm/min
Data acquisition starte Hnstrument]
Data acquisition starte EX Bandwidth 5.0mm
Data acquisition starte EM Banduwidih 5.0nm
Data scquisition starte Sensitivity High
Data acquisition starte 00l L L I ]
Data acquisition starte — 370.0 380.0 400.0 420.0 430.0 [Attachment] -
<[ o nm < . 3
Ready

[Spectrum - [Measurement]] Window
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4.5 Changing the Graph Scale

4.5 Changing the Graph Scale

The following methods are available for changing the scale on spectrum graphs.
¢ Directly Edit the Upper and Lower Limits of the Scale

e Perform automatic scaling

e Configure the scale in the [Customize Graph] window

B Directly edit the upper and lower limit values of the scale

‘ Click the upper limit value (on the intensity axis in this example) of the graph

scale.
The value changes to the editable state (value becomes highlighted).

| Active | Overlay

Upper limit value (m]— .

6.0+

40k

Intensity

3700 380.0 400.0 4200 430.0

Changing the Upper Limit Value

2 ‘ Directly enter a new value and press the "Enter" key.
— The graph is redrawn using the entered value as the upper limit.

Active | Overlay

8.8 T T T

8.0+

Imtensity

0.4l 1 1
370.0 3800 400.0 4200 4300
nm
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4 Spectrum

B Perform Automatic Scaling

1 Double-click on the graph.
— Automatic scaling is performed according to the current state of the graph.

Active | Overlay Active | Overay
78 T T T T 88 T T T

8.0 -

6.0

Intensity

60 -
40+
20

15

3849 390.0 395.0 400.0 405.0 408.8 370.0 380.0 400.0 420.0 430.0
nm nm

Performing Automatic Scaling

B Configure the scale in the [Customize Graph] window

1 Open the right-click menu on the graph and click [Customize].
— The [Customize Graph] window is displayed.

:\' Hint  The right-click menus in the graph view differ depending on the window mode and graph

tab type.
Copy 3
Auto Scale
3
Copy Cursor 4
Auto Scale Lock Cursor
Cursor > [ Customize... ]
[ Customize... ] Vertical axis >
Vertical axis 4 Print
Properties... Properties...
Measurement Mode View Mode

Right-Click Menus (Overlay Graph)
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4.5 Changing the Graph Scale

2 Change the scale on the [Limits] tab and then click [OK].

:' Hint  Set the margin ratio for automatic scaling here.

pe ~
Customize Graph |3
[ Line Colors | Limts | Appearance | Settings |
X Pods
Min: 370]
Max: 430
Y Aods
Left
Min 0.39 0
Max: 8.84 Max 1
Auto Scale
X Ads: ¥ Y Aods: il
Percentage: 0 Percentage: 10
[ ok ]| cancel |

[Customize Graph] Window ([Limits] Tab)
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4 Spectrum

4.6 Printing (Quick Print)

Print using the report file (report template) linked to the overlay graph in the view mode
window.

PP Reference For details on the quick print function (such as creating report files and setting links), see
"10 Printing" P.135.

‘ Change to the view mode window, open the right-click menu on the overlay
—— graph, and click [Print].
Printing is performed using the overlay graph and the linked report file.

Copy 4
Auto Scale
Cursor »

Lock Cursor
Customize...
Vertical axis »

[ print ]

Properties...

View Mode

Right-Click Menu (Overlay Graph)

Overlay Graph Report PetDMN | CORODIS 02 T:3IPU

== 5pc_001 - CometionDay
nzf B == po_002 - Conectionliata

Example of Printout
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3D Spectrum

This chapter explains how to operate the 3D spectrum general analysis application.

PP Reference For cases and functions not covered in this chapter, refer to the help file provided with
LabSolutions RF.

B Explanations Included in this Chapter

This chapter explains the procedures for measuring a 3D spectrum using a fluorescence
sample and extracting a fluorescence spectrum from the captured 3D data.

! NOTE Measurement parameter configuration is explained assuming that a connection
is established between an RF-6000 and LabSolutions RF.

B Functions Used in this Chapter

The following functions are used in 3D spectrum measurement mode.

e Configuring measurement parameters, saving measurement parameter files
e 3D spectrum measurement

e Switching to view mode

The operation explanation uses a sample that emits fluorescent light at around 340 nm
for an applied excitation light of 307 nm as an example.

The following functions are used in 3D spectrum view mode.
e Graph enlargement
e Cursor position setting

¢ Fluorescence spectrum extraction (file saving)

5.1 Startup

Click [3D Spectrum] on the [Fluorescence] tab in the LabSolutions RF launcher to start
the 3D spectrum general analysis application for capturing 3D data
(excitation/fluorescence wavelength - time - fluorescence intensity or fluorescence
wavelength - excitation wavelength - fluorescence intensity).

The [3D Spectrum] window features a "measurement mode", "view mode", and "edit
print form mode" and the mode can be changed by clicking the relevant button on the
main toolbar. The "measurement mode" window is displayed when the 3D spectrum
application starts up.

Pp Reference o For details on the "view mode" window, see "5.5.1 3D Spectrum - [View] Window Layout"
P.57.

e For details and operation method of the "edit print form mode" window, see "10
Printing" P.135.
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5 3D Spectrum

5.1.1

[3D Spectrum - [Measurement]] Window Layout

‘ [ 30 Spectrum(RF-01)-[Measurement]
File Edit View 3D Graph [nstrument

Jools Window Help

=

Help
T = 30Spe-01 f53f = . f S 5 a1
i ] CoectionData) @ | +D+ =h | [7]sat fle name automaticaly _ >> | at |
Stop, | Gose J GoToWL| | Ao Zero || Sesch |  Autoriel pate Timel.fs3f Disconnect J
0 2 EM
i — : h(am) 400.0 200.0
EM Wavelength(nm)/EX Wavelength{(nm e
d : 20315.0
1200
' AicLamp OM [362 hows)
1000 .
© 800
800 Parameter Value
400 [Measurement]
200 Spectrum Type Emission
i = EX Wavelength 400.0 nm
. o EM Wavelength Start  200.0 nm
Shutter Motor Check - EM WavelengthEnd  900.0 nm
Emission Side Slit Mot 300 320 340 360 380 400 420 440 460 480 SO0 Data Interval 1on0m |z
Emission Side Grating Repetiton 10Times
Total Judgment - OK Time Interval s
Instrument Function & 5eiE Scan Speed 000 nm/mi
Are Lamp - mounted Wi 4 t ! T
E - - nstrument
Arc Lamp - Tetal Light = X Bancuidth S0mm
Mercury Lamp - unme = g o] ] EM Bandwidth 10.0rm
Integrating Sphere - N B : Sensitivity Hgh
Sipper - Not Used
Connection - Passed 11440 L L 1 3 [Attachment]
¥ 3000 350.0 400.0 4500 500.0 Attachment None ek
« [m v nm 1 i, L

For i—mp, press F1

[3D Spectrum - [Measurement]] Window

The [3D Spectrum - [Measurement]]

window is divided into the following four parts.

No. Name

Function

3D spectrum
measurement toolbar

The buttons used for starting and stopping
measurement and performing instrument control are
located on this toolbar.

Buttons such as [Start] become active after clicking
[Connect] and establishing a connection with the
instrument.

Instrument status

The upper section displays the current wavelength and
fluorescence intensity and the lower section displays
the status of the spectrofluorophotometer.

PP Reference For details on the instrument status, see "2.3.3
Instrument Status" P.23.

Parameter view

Displays the settings of the currently configured
measurement parameters (settings such as parameters
related to measurement and whether to perform
automatic printing).

This view is used to configure, save, and load
measurement parameters.

3D spectrum graph view

The lower section displays a spectrum graph and the
upper section displays a 3D spectrum graph in real
time during measurement.
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5.2 Configuring Measurement Parameters

5.2 Configuring Measurement Parameters

Create (configure) measurement parameters for measuring the fluorescence spectrum (3D
spectrum) at a certain excitation wavelength interval.
PP Reference For details on the procedure for saving measurement parameters to a file, see "4.2

Configuring and Saving Measurement Parameters" P.38.

3D spectrum measurement parameters comprise "measurement (parameters)",
"instrument (parameters)", and "attachments" and are configured in the parameter view.

1 Click [Settings] in the parameter view.
— The [3D Spectrum Mesurement Parameters] window is displayed.

2 Configure the measurement conditions (parameters) on the [Measurement] tab.

r3[) Spectrum Mesurement Parameters

o Spectrum Type: 30 b/
Excitation Emission
Start (nm): 280 Start (nm): 300.0
9 End (um): 330 End (wm): 500.0 9
l Data Interval {om): h 20 || Data Interval (om):
(4] Scan Speed fom/ine):
(5 [7] Perfom Auto Print
Report File :
——

[3D Spectrum Mesurement Parameters] Window ([Measurement] Tab)

No. Measurement Condition Setting
(Parameter)
(1] [Spectrum Type] 3D
e [Start]: 280 nm
(2) Excitation e [End]: 330 nm
e [Data Intervall: 2.0 nm
e [Start]: 300 nm
(3) Emission e [End]: 500 nm
e [Data Interval]l: 1.0 nm
(4] [Scan Speed] 6000 (nm/min)
(5) [Perform Auto Print] No (unselected)
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5 3D Spectrum

3 Configure the instrument conditions (parameters) on the [Instrument] tab.
[ 3D Spectrum Mesurement Parameters @1
Instrument | Attachment
Spectral Bandwidth
| Excitation: Sensitivity: Lowy - @
0l ..
ok ) oren ]

[3D Spectrum Method] Window ([Instrument] Tab)

Instrument Condition

s (Parameter)

Setting

) e [Excitation]: 3.0 nm
(1) [Spectral Bandwidth] o
e [Emission]: 3.0 nm

(2) [Sensitivity] Low

4 Click [OK] to close the window.
The measurement parameter settings are accepted for use.
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5.3 Disabling the Auto File Function

5.3 Disabling the Auto File Function

An arbitrary filename and sample information (sample name and comments) can be set
when starting measurement.

P) Reference For details on the procedure for enabling automatic filename creation (auto file function),
see "4.3 Configuring the Auto File Function (Setting Filenames Automatically)" P.41.

‘ Check that the [Set file name automatically] checkbox on the 3D spectrum
e measurement toolbar is not selected.

If this checkbox is selected, deselect it.

@€ +DHe

Close

\7

Go To WL

=t

LN [DSetﬁenmwhmb‘dy] > gt
Auto Zero

3D Spectrum Measurement Toolbar

5.4 3D Spectrum Measurement

Check that the shutter is closed (*S;OZ*) and then click [Auto Zero] on the 3D

spectrum measurement toolbar.

2 ‘ Place the sample in the instrument's sample compartment and close the lid.

3 ‘ Click [Start] on the 3D spectrum measurement toolbar.
— The [New Data Set] window is displayed.
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5 3D Spectrum

4 Click [...].

New Data Set

Filename: ARF-Data\Data\File 150210 130142.fs3f L]

Data Set Name: RawData

Analyst:

Sample Name:

Sample |D:
Option{Q}):
Comment: a
[ ok ) | Cancel |
[New Data Set] Window
5 Enter a filename and click [Open].
[I'] New File Name ()
Lookin: J, Data - @2 E
I Name Date modified Type
ool No items match your search.

Recent Places

Desktop

-g:lilJ
Libraries

A

|

Computer

@ <« i

Network :
File name: [ 3DSpec-01 > ] []
J

Flesoftype: | Spectum Fie (‘fs3) v | Cancel

[New Filename] Window

:' Hint The save destination of data files can be changed from [Destination Folder] on the [Tools]
menu.

PP Reference For details, refer to the help file provided with LabSolutions RF.
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5.4 3D Spectrum Measurement

Enter the name of the analyst and sample information (such as sample name

and comments).

Analyst

Sample
information

New Data Set

Filename: C:\RF-Data\Data\3DSpec-01.fs3f @ @ G—)
Data Set Name: RawData

{ Analyst RF User ]
Sample Name: DemoSample
Sample ID:
Option(Q}):
Comment: File Commen{ a

T

Cancel

[New Data Set] Window

Click [OK] to start measurement.

During measurement, the upper section of the 3D spectrum graph view draws a 3D graph
(intensity distribution diagram) and the lower section draws the fluorescence spectrum
being captured in real time.

1] 3D Spectrum(RF-01)-[Measurement] (=3 EoE ==
File Edit View 3DGraph Instrument Tools Window Help
=@ 305pecDl (3 e
275 CorectionD atal Set file name automatically
Cose ||GoTo Ao Zewo | | Search DSpec-01.f3f Discarinact
3D
EX EM
EM W, h )/EX W " ) 316.0 396.0
nm nm
15000 9323
v Aclamp  ON (302 hows)
10000
3D graph
so00 ||| | Settees
Message = Parameter Value =
o [Measurement]
Arclamp- mounded 300 320 340 360 380 400 420 440 460 480 500 Spectrum Type )
Arc Lamp - Total Lighting EX Wavelength Start 280.0 nm
Flash Lamp - d EXWar gth End 330.0nm =
Mercury Lamp - mounted Data Interval 2.0nm
Mercury Lamp - Total Ligh 145239 r . . EM Wavelength Start 300.0nm
Integrating Sphere - Not U 100000 EM Wavelength End 500.0 nm
Cooling Unit - Not used £ Data Interval Lhow
Spectrum JTspe Nottea | R i Scan Spesd 6000 rin
Connection - P?ss?d s ] [Instrument]
Auto Zero - Excitation Wav| 12760 I I L EX Bandwidth 3.0nm
Data acquisition started ~ ~ 300.0 350.0 400.0 450.0 500.0 M Ban it Ao '
<[m » am « i ’
For Help, press F1

During Measurement
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5 3D Spectrum

8 ‘ After measurement is complete, click [View] on the main toolbar.

3D Spectrum(RF-01)-[Measurement]

File Edit View 3D Graph Instrument Tools Window Help

=

=

Edt Printform

Main Toolbar

The window changes to view mode.
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5.5 View Mode

5.5 View Mode

5.5.1 3D Spectrum - [View] Window Layout

1] 3D Spectrum(RF-01)-[View]
File Edit View 3D Graph Instrument Tools Window Help
: @
Help
B0 30SpecO1.fs3 Active [Tie | | Parameter | istory | Summary |
CorrectionData - J Y L]
EM Wavelength(nm)/EX Wavelength ki Yabe
avelength{nm)/ avelength(nm) v q
Spectrum Type 30
EX Wavelength Start 280.0 nm
EX Wavelength End 330.0 nm
Data Interval 2.0nm
EM Wavelength Start 300.0 nm
EM Wavelength End 500.0 nm
Data Interval 1.0nm
320 330 340 350 360 370 Schi;Speer) 6000 im ki
EM:340.0/EX:306/14106.4 = 1
EX Bandwidth 3.0nm
EX(nm): 306 Execute EM Bandwidth 3.0nm
— B Bl5 -
Arc Lamp - mounted
155151 = =
Arc Lamp - Total Lighting = T i ¥ [Attachment]
Flash Lamp - unmounted § Attachment Nene
- E B T
:ercuvy tamp .’r“c:u;l:edh -1380.0 - - 1 [AutoPrint]
ercufy Lamp - 10 1y 3000 3500 400.0 4500 500.0 AutoPrint No
Integrating Sphere - Not U __ EM (nm)(EX:306.0nm) Report Fie
Cooling Unit - Not used
Sipper - Not Used 3 EM(nm}: 340 E E
Connection - Passed ToRTTT T - - .
Auto Zero - Excitation Wav| E‘ - // i
Data acquisition started ~ ~ e - =
< [om 3 » E i « i, : »
aare a - 1 | ) 1
Ready
[3D Spectrum - [View]] Window (View Mode)
No. Name Function

Displays the measurement parameter information,
(1) Parameter view data history, and summary information of data shown
on the [Active] tab.

Displays graphs of the loaded 3D data. Moving the
mouse cursor into the 3D graph area changes the
cursor to a crosshair, and moving the mouse moves
the crosshair.

e The [Active] tab displays graphs of the currently
active data set.
An "intensity distribution diagram" or "3D spectrum

(2] 3D spectrum graph view graph" can be shown in the graph display.

e The [Tile] tab can display up to six 3D graphs of any
data set in tiled form. Dragging a filename from the
tree view into the tiled graph area displays a 3D
graph corresponding to the file.

PP Reference For details on the operating procedure of the
[Tile] tab, refer to the help file provided with
LabSolutions RF.
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5 3D Spectrum

5.5.2 Enlarging 3D Graphs

B NOTE  When the "3D spectrum graph" display is enabled, click [Contour Plot] on the
[3D Graph] menu.

Enlarge 3D graphs on the [Active] tab.

3D graphs can be enlarged either by specifying a range using the mouse or by directly
entering a range in [3D Graph Range] from the right-click menu.
The method of using the mouse is explained in this example.

:' Hint  The intensity distribution of an enlarged area can be viewed more clearly by configuring
automatic scaling to be performed on fluorescence intensity according to the drawing range.

Configure the settings in the window displayed by clicking [Customize] on the [3D Graph]
menu.

Customize 3D Graph
Contour Plot
[] Show Color Bar
_) Monochrome @) Color
Gradation: 32 -
Lmit (Intensity)
( @ o Scae Bravingance) |
Auto Scale (Full Range)
Fixed
Max: | 15518.241 Min: | -1424.409
3D Spectrum Graph
Number of Spectrum: 100 -
ok ] [ cocel |

[Customize 3D Graph] Window
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5.5 View Mode

1 ‘ Drag the mouse on the 3D graph to create a quadrilateral and then click on the
— position to enlarge.

:, Hint  After creating a quadrilateral, the created quadrilateral can be moved within the 3D graph
using the mouse.

The enclosed area is displayed enlarged.

Active | Tile \

EM Wavelength({nm)/EX Wavelength{nm)

330 15000

320
310 10000
300
200 5000
280
300 320 340 360 380 400 420 440 460 480 500 0
3D Graph (Before Enlarging)
Active | Tile
EM Wavelength{nm)}/EX Wavelength{nm}
320
14000
310 12000
10000
300 8000
6000
290 4000
320 320 340 350 3Jel 370 2000
EM:374.0/EX:288/1680.3

3D Graph (After Enlarging)
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5 3D Spectrum

5.6 Extracting Spectrum Data

Extract a fluorescence spectrum from captured 3D spectrum data and save it to a
spectrum data file.

1 ‘ Move the mouse cursor onto the 3D graph (upper section of the graph view).

A transverse section graph (middle section) and longitudinal section graph (lower section)

of the cursor line position are displayed.

3D graph

Transverse
section graph

Longitudinal
section graph

{I] 3D Spectrum(RF-01)-[View]
File Edif

=4 3DSpec-01.fs3f
[ ConectiorData

iew 3D Graph [nstrument Tools

Window Help

Parame

tory | Summary

350 360
EM:340.0/EX:306/14106.4

370

14000
12000
10000
8000
6000
4000
2000

Message
Arc Lamp - mounted
Arc Lamp - Total Lighting”

EX(nm): 308

Flash Lamp - unmounted
Mercury Lamp - mounted
Mercury Lamp - Total Ligh
Integrating Sphere - Not U _
Cooling Unit - Not used
Sipper - Not Used L

Connection - Passed

Intensity

15515.1 - - -

-1390.
300.0 350.0

400.0
EM Spectrum (nm)EX:306.0nm)

450.0

EM(nm}): 340

E=TED

Auto Zero - Excitation Wav| |
Data acquisition started ~ ~
« [ )

Intensty

o

Parameter

[Measurement]
Spectrum Type

EX Wavelength Start

EX Wavelength
Data Interval

EM Wavelength Start

End

EM Wavelength End

Data Interval
Scan Speed

[Instrument]
EX Bandwidth
EM Bandwidth
Sensitivity

[Attachment]
Attachment

[AutoPring]
AutoPrint
Report File

Value

30

280.0 nm
330.0 nm
2.0nm
300.0 nm
500.0 nm
1.0nm
6000 nm/min

3.0nm
3.0nm
Low

Ne

Ready

[3D Spectrum

[View]] Window (Example of 3D Spectrum Data Display)

Move the cursor to the position for extraction on the fluorescence spectrum on

the 3D graph and click to lock the cursor position.

The fluorescence spectrum graph can also be updated by clicking @B located above

the transverse section graph in the middle section to move the extraction position (the
excitation wavelength in this example) by the amount set for the data interval.

KY

" Hint

wavelength into the [EX] field and click [Execute].

To display the fluorescence spectrum for any excitation wavelength, directly enter the

EX{nm}: 306 Execute ]E] (=]

155151 = T T T =
= " 4
[72]
c
@ - -
E

-1390.0 1 L L

300.0 350.0 400.0 450.0 500.0
EM Spectrum (nm)(EX:306.0nm)

Transverse Section Graph (Fluorescence

Spectrum)
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5.6 Extracting Spectrum Data

Open the right-click menu on the middle section graph area and click [Extract

Spectrum].
Copy »
Auto Scale
Cursor »
Lock Cursor
[ Extract Spectrum... ]
Customize...
Vertical axis 3
Text File Output...
Print
Properties...
Right-Click Menu
4 Enter a filename for the created spectrum data and click [Save].
[I7] Extract Spectrum e
Savein: || Data - @7 @3
B= Name Date mod'iﬁed Type
el No items match your search.

Recent Places

Desktop

:nﬁ;ﬂ
Libraries

A

e

Computer

h 4 m »
Network
File name: [ 3DSpec-01-Ex306nm fs2F p ] []

Save as type: JSpectnmt‘!sZ} 'I { Cancel J|

Saving a Spectrum Data File

5 Start [Spectrum] from the LabSolutions RF launcher.
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5 3D Spectrum

6

Open the spectrum data file saved in step 4.
The extracted spectrum data can be loaded into the spectrum general analysis application.

PP Reference To proceed to data processing, see "9 Data Processing" P.118.

Spectrum [View] [E=H EoR (=5
File Edit View Graph Instrument Tools Window Help
1 = | 1 | Operations | =
4 =
] - iy E Paak Pick ha 7
Print Preview Measurement Wiew Edit Prirtform Data Prirt ~ Help
=V} 3DSpecDT-Ex30E | Active | Overlay| Parameter | History | Summary |
[ =
Parameter Value
16316.2 T
[Measurement]
150000 - —
Spectrum Type Emission
EX Wavelength 306.0 nm
EM Wavelength Start 300.0 nm
EM Wavelength End 500.0 nm
10000.0 Data Interval 1.0nm
= Scan Speed 000 nm/min
5
E [Instrument]
5000.0 EX Bandwidth 3.0nm
EM Bandwidth 3.0nm
4 1 3 Sensitivity Low
Message 0o [Attachment]
System Initialization _1390.0 L L I Attachment None
300.0 350.0 400.0 4500 500.0
nm [AutoPrint]
AutoPrint No
Operation Pane Report File
] | Pl N . =
e E= Sl A=y o= )
<« [l D ] m 3

[Spectrum - [View]] Window
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Quantitation

This chapter explains how to operate the quantitation general analysis application.

PP Reference For cases and functions not covered in this chapter, refer to the help file provided with
LabSolutions RF.

B Explanations Included in this Chapter

This chapter explains the procedures for performing quantitation measurement with the
multi-point calibration curve method using three types of standard samples of varying
concentrations and creating and saving calibration curve files and (quantitation) template
files.

The following table shows the files that can be created by the quantitation application
and the settings and data contained in these files (indicated with a check mark).

B NOTE Measurement parameter configuration is explained assuming that a connection
is established between an RF-6000 and LabSolutions RF.
Configuring
Mp?:-zl:y:i:;??t Data and Information | Data and Information
Fill et (Including Calibration i v iz
Curve Standard Table Sample Table
Parameters)
Measurement v ) )
parameter file
Calibration curve file 4 -
Quantitation file v 4
. v (excludin v (excludin
Template file v ( 9 . ( 9 .
measurement data’') | measurement data™')

*1 This refers to information and values that can be directly entered into tables, such as sample
information (sample name and ID) and standard sample concentration.

B Functions Used in this Chapter

The following functions are used in quantitation.

e Configuring measurement parameters

e Creating standard tables

e Creating and saving calibration curve files (multi-point calibration curve method)

e Quantitation measurement

e Creating, saving, and loading template files

The operation explanation uses a sample that emits fluorescent light at around 340 nm
for an applied excitation light of 307 nm as an example.
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6 Quantitation

Startup

Click [Quantitation] on the [Fluorescence] tab in the LabSolutions RF launcher to start
the quantitation general analysis application that allows quantitation using the
calibration curve method.

6.1.1

[Quantitation - [Measurement]] Window Layout

Quantitation(RF_01)-[Measurement]
File Edit View Graph [nstrument Tools Window Help

[E=% BB ===

5@ Qnt0l.fogf = -
) Standard Table P 7, +O- | [ = Template:  Open... | Save As...| a1 __o
(5} Sample Table Open Auto Zero Search File Name:  Qnt-01.faqf >> Disconnect
>
(addLine..] [ Edi. [ Open... | [ Savess.. | 3 EM
307.0 340.0 o
Sample Name | SampleID | Ex Conc EX307.0_EM340.0 Comments -0.0 <
1 Std-1 D01 10.000 5855.497 v Aclamp  ON (306 houss)
2 Std-2 ID-02 20.000 8604.319 = 2
4
c 3 Std-3 ID-03 40.000 13766.649 Caribration Curve |Sample Graph | Parameters |
Standard Curve
14575.434 - -
Message 2l
Emission Side Grating AddLine... et
Total Judgment - OK >
Digital Signal Process Sample Name | Sample ID | Conc | EX307.0_EM340.0 Comments £ 10000000 3]
Instrument Function 1 Unk-1 1D-U91 21.681 8974.372 E
Arc Lamp - mounted i | | RV ink ID-U92 21503 8927 622 5000.000
Flash Lamp - unmoui 3
Wiscing Lirip~mion Unk-3 1D-U93 2159 8952.041
e e G Unk-4 ID-U%4 21.785 9001.659 £000.000
) L
Cooling Unit - Notus | |5 [Unkcs ID-U% 21753 8993.399 o oss 000 4
Sipper - Not Used 6* |Unk6 ID-U96 | Conc. (mg/mi)
Connection - Passed ~ y =262.907 x + 3274.33
« [ » r2 = 0.99975
C:\RF-Dato\Date\Qnt-01.fqq| loaded )

[Quantitation - [Measurement]] Window

L B NOTE The quantitation application has only the measurement mode.

No.

Name

Function

Quantitation
measurement toolbar

The buttons used for starting and stopping
measurement and performing instrument control are
located on this toolbar.

Buttons such as [Start] become active after clicking
[Connect] and establishing a connection with the
instrument.

Instrument status

The upper section displays the current wavelength and
fluorescence intensity and the lower section displays
the status of the spectrofluorophotometer.

D) Reference For details on the instrument status, see "2.3.3
Instrument Status" P.23.

Graph/Parameter view

Displays information including the settings of the
currently configured measurement parameters and
information and graph of the calibration curve.
Clicking [Settings] on the [Parameters] tab displays the
window for creating (configuring) the quantitation
measurement parameters. When loading an existing
measurement parameter file, click [Load].
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6.1 Startup

No. Name Function

Displays information on the standard sample (such as
(4) Standard table sample information, concentration, and fluorescence

intensity) used to create calibration curves.

Displays information on unknown samples (such as
(5] Sample table sample information and fluorescence intensity) and

quantitation results (concentration).
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6 Quantitation

6.2.1

Creating and Saving Calibration Curve Files

Configuring Measurement Parameters

Set parameters related to measurement, such as measurement wavelength and instrument
conditions, and the calibration curve information used in quantitation.

B NOTE  When connecting to the instrument in the quantitation general analysis
application, measurement parameters must be configured in advance.

Click [Settings] on the [Parameters] tab in the graph/parameter view.
The [Quantitation Measurement Parameters Wizard] window is displayed.

:' Hint  If measurement parameter configuration is already complete, the [Quantitation
Measurement Parameters Wizard] window is displayed.

Set the [Instrument], [Wavelength], [Calibration], [Measurement (Standard)], and
[Measurement(Sample)] according to the wizard and click [Finish] when finished.

e [Instrument]

Quantﬂation Measurement Parameters Wizard - [Instrument]

—0
-8

Spectral Bandwidth
Sctton S r—
Emission: Accumulation Time: | 10ms bl

[ tet> | [ Concs |

[Quantitation Measurement Parameters Wizard - [Instrument]] Window

Instrument Condition

No. (Parameter)

Setting

) e [Excitation]: 3.0 nm
(1) [Spectral Bandwidth] o
e [Emission]: 3.0 nm

(2] [Sensitivity] Low
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6.2 Creating and Saving Calibration Curve Files

No Instrument Condition Settin
: (Parameter) 9
(3) [Accumulation Time] 10 ms

e [Wavelengths]
Click [Add] after setting the following parameters to register the wavelength and
automatically create a (modifiable) column name.

Quantitation Measurement Parameters Wizard - [Wavelengths] (=23

— T ol Name:  EX3070_EM3400

PTT

___ EX Wavelength (m): 307
—— EM Wavelength (nm): 340
Entries:

Columns Type [—Hdd
EX307.0_EM340.0 Point o

<Back |[ Net> ] [ Cancel

[Quantitation Measurement Parameters Wizard - [Wavelengths]] Window

No. Wavel(ePnagr';Pr\ng&r:;jition Setting
Q@ | I[Typel Point

(2] [EX Wavelength (nm)] 307

(3) [EM Wavelength (nm)] 340
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6 Quantitation

e [Calibration]

Quantitation Measurement Parameters Wizard - [Calibration] [

— Type:

2

— Formula: | Fixed Wavelength ~ mg/ml

PoT

—— WL1| EX307.0_EM340.0 ~

Parameters

@ Int=f[Conc) () Conc = f(Int)
Int = K1*(Conc] + KO
Order of Curve: 1st -

|| Zermo Interception

<Back [ Ned> | [ Cancel

[Quantitation Measurement Parameters Wizard - [Calibration]] Window

No Calibration Curve Settin
’ Condition (Parameter) 9
(1) [Typel Multi Point
(2] [Formula] Fixed Wavelength
3] [WL1] (Select the column name of the wavelength registered
on the previous screen (wavelengths).)
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6.2 Creating and Saving Calibration Curve Files

e [Measurement (Standard)]

Quantitation Measurement Parameters Wizard - [Measurement (Standard)] (3]
STD
EEEE
o——DaaAoguiredBy: *) User Entry
@—— Sample Repetitions: 1 ["] Prompt before repeat
Settings of the decimal place to display
Use Rounded Value OFF @l  Follow [Tool] - [User Setting] to
for Calculation: QY cany o..nofu-as setting. The
. ; - number of decimal places’ digts
Settings of the decimal :
it e
{for standard sample table and calibration curve)
[ <Back [ MNet> | [ Cancel |

[Quantitation Measurement Parameters Wizard - [Measurement (Standard)]] Window

No Measurement Condition Settin
: (Parameter) 9

(1) [Data Acquired By] [Instrument]

(2] [Sample Repetitions] 1
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6 Quantitation

¢ [Measurement (Sample)]

Quantitation Measurement Parameters Wizard - [Measurement (Sample)] [25m)

2

Q@ ——oataAcquiedBy O UserErty
9——§m'pleﬁepeﬁtions: 1 [7] Prompt before repeat

Settings of the decimal place to display

Use Rounded Value OFF @ Folow [Tool] - [User Setting]to
for Calculation: ;' camy out this setting. The
"~ number of decimal places’ digits

Settings of the decimal .
pacetodeplay: ey
(For sample table and sample graph)

[ <Back |[ Fnsh | [ Cancel |

[Quantitation Measurement Parameters Wizard - [Measurement (Sample)]] Window

No Measurement Condition Settin
: (Parameter) 9

(1) [Data Acquired By] [Instrument]

(2] [Sample Repetitions] 1
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6.2 Creating and Saving Calibration Curve Files

3 ‘ Click [Closel].

— The [Quantitation Measurement Parameters] window closes.

f Quantitation Measurement Parameters

| Measurement (Sample) | Equations | Pass/Fal | Instument | Attachment

Wavelengths [ Calibration ] Measurement (Standard)
Type: Column Name:  EX350.0_EM400.0
EX Wavelength (nm): 350

EM Wavelength (nm): 400
Entries:

Cones T ==

EX307.0_EM340.0 Point

[Quantitation Measurement Parameters] Window

P) Reference For details on the setting procedure of other parameters (such as for the calculation
function and attachments), refer to the help file provided with LabSolutions RF.
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6 Quantitation

6.2.2 Specifying Filenames

1 Click => | on the quantitation measurement toolbar.
\/> \\.,__,'; - Template: Open... | Save As... :
Start Stop Open Auto Ze earch File Name >> Connect }

Quantitation Measurement Toolbar

2 Enter the details for [Filename], [Analyst], and [Comment] and click [OK].

Quantitation File Setting
Filename: [C:\HF-Dala\Data\Unt-m.qui ]j (e
Analyst: [ Shimadzu ]
Comment: | File comment »

[Quantitation File Setting] Window

The name of the quantitation file is displayed on the quantitation measurement toolbar.

A = 5 - o] Save As... v
O 7, Template:  Open... | Save s =Y
Start Stop Open || Auto Zero | | Search [FieName: Qnt-01.faqf ] >> Tt

Quantitation Measurement Toolbar
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6.2 Creating and Saving Calibration Curve Files

6.2.3 Connecting to the Instrument

In the quantitation general analysis application, a connection with the instrument cannot
be established unless the measurement parameters have been configured in advance.

!NOTE Closing a quantitation file by clicking [Close] on the [File] menu will clear the
configured measurement parameters thereby automatically disconnecting from
the instrument.

1 Click [Connect] on the measurement toolbar.

Template: Open... | Save As...

&) v @ ¥
Stop Open Auto Zero Search File Name: Qnt-01.fqgf >> Connect

Quantitation Measurement Toolbar

<

6.2.4 Creating a Standard Table

1 Click [Add Line] above the standard table.

T[Add Line.. |[ Edt..| [ Open.. | | Savess

I Sample Name l Sample ID | Option I Type

[Add Line] Above the Standard Table

2 Enter the number of lines to add and click [OK].

-
Add Line

Number of Line: | 3

ok 3| [ cance

[Add Line] Window
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6 Quantitation

3 Click the select all cells button and then click [Edit].

:' Hint Separate rows can be selected by clicking the corresponding number button on the left
edge of the table (multiple rows can be selected in the same manner by holding down
the "Shift" key).

| [addLine...| [Edt. | | [ Open.. -

Select all cells button—{___) IS Iy B TS M= G B

et

Editing the Standard Table

4 Set the sample information in the [Edit Table] window and click [OK].

3' Hint Sample information (such as sample name and sample ID) can be directly entered into the
table or copied and pasted from other application software.

[Edit Table 1

Sample Name
|V | Use sequential number

Name: First No.: Step:
Std- + 1 1
Sample ID
|¥| Use sequential number
Name: First No.: Step:
D 1 1
Option
v Use sequential number
MName: First No.: Step:
Option + 1 1

oK  Cancel

[Edit Table] Window
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6.2 Creating and Saving Calibration Curve Files

5 Open the right-click menu on the standard table and click [Properties].

| Open... |

Copy
Paste
Select All

[AddLine...| [Ed.. ]

Show Repeats
Hide Excluded Lines
Delete Line

Print

Properties...

Right-Click Menu of the Standard Table

6 Hide the columns that are unnecessary in this example ([Option], [Typel, [Wgt.

Factor]).
Standard Table Properties B
' Columns \
| Columns Status =
Sample Name Show L Hide
| Samole 1D Show 3
, Sho
Option Hide
Type Hide Show &ll
|| EX 2Now
Date Hide L
I : m . »
[Standard Table Properties] Window
7 Enter the concentration of each standard sample into the standard table.
(AddLine..] [Edt.] [ Open. || Saves:
Sample Name | Sample ID | Ex Conc EX307.0_EM340.0 Wagt.Factor Comments
1* Std-1 ID-01 10.000 1.000
2 Std-2 ID-02 20.000 1.000
3 |sw3 ID-03 aq 1.000

Entering Concentrations into the Standard Table
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6 Quantitation

6.2.5 Measuring Standard Samples (Creating Calibration Curves) and Saving Calibration Curve Files

1 Click on the standard table to activate it (the standard table becomes enclosed
in a red frame).

2 Check that the shutter is closed (*;;O;*) and then click [Auto Zero] on the

quantitation measurement toolbar.

3 Place a standard sample in the instrument's sample compartment and close the
lid.
4 Click [Start] on the quantitation measurement toolbar.

The measurement value is displayed in the wavelength column. Clicking the [Calibration]
tab in the graph/parameter view displays the data point plotted on a calibration curve
graph.

:' Hint  To display the calibration curve function or the squared correlation coefficient on the
[Calibration Curve] tab, select [Calibration Curve Statistics] on the [Graph] menu.

Repeat the same operations with respect to the other prepared standard samples.

Wavelength column

(] Quantitation(RF 01)-[Measurement] [E=S{EoE
File Edit View Graph Instrument Tools Window Help

)
Help

=@ Ont-01.fqf =
(5 Standard Table | 0 7, +«0- || L 7§ Tempiate: Open... | Save As... g:
Siat Siop JM Ao Zero || Search File Name: ~ Qnt-01.faaf _>> | | Dsconnect
X EM
- 307.0_340.0
Sample Name | Sample ID | Ex Conc EX307.0_EM340.0 Comments N - .
: || carbration Curve || e [Calibration
Std-1 1D-01 10.000 5855.497 et Carre
2 |sw2 1D-02 20,000 8604 319 14575434 T T Curve] tab
14000.000 -
3 |std3 1D-03 40.000 13766.649
12000.000 -
Message
Excitation Side Slit M .
Excitation Side Gratin n - E 10000.000 -
Shutter Motor Check £
Emission Side Sit Mq | Sample Name | Sample ID Option Type | Ex | Conc EX
Emission Side Grating 2000.000 |-
Total Judgment - OK
Instrument Function LY
Arc Lamp - mounted = 20000 1= Data points
Mercury Lamp - unrr (
Integrating Sphere - |~ 5062.775 ! L
Sinper - Not Used [ 10000 20000 30000  40.000
Tl ) P il V Conc. (mg/mi)

(C:\RF-Data\Parameters\Qnt-01.fmqf loaded

Quantitation Measurement of Standard Samples
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6.2 Creating and Saving Calibration Curve Files

Once measurement of all standard samples is complete, click [Save] on the main
toolbar.

Save the quantitation file before creating a calibration curve file.

Edit Printform

Main Toolbar

Click [Save As] above the standard table.

[sadLine..] [Edit. | [ Open.. ||| Saveas.. |
Sample Name | Sample ID | Ex Conc EX307.0_EM340.0 Comments
Std-1 ID-01 10.000 5855.497

2 Std-2 ID-02 20.000 8604.319
Std-3 ID-03 40.000 13766.649

Saving a Calibration Curve File

Enter a name for the calibration curve file and click [Save].

7] save As - Data File e
Savein: |, Data -~ 02 &

T Name Date modified Type

5"} No items match your search.
Recent Places

Desktop

Libraries

k..!

Computer

% < | m J 5

Network
Foname: [ S0 - | (e ]

Saveastype: | Caiiration Curve ("facf) v| | Concel |

Saves the standard table.

[Save - Data File] Window
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6 Quantitation

6.3 Quantitation

‘ Click on the sample table to activate it (the sample table becomes enclosed in a
—_— red frame).

2 ‘ Use [Add Line] above the sample table to create a number of lines equal to the
S number of samples for measurement and enter the sample information.

PP Reference For details on the procedure for adding rows and editing the table, see "6.2.4 Creating a
Standard Table".

Sample Name | Sample ID | Conc EX307.0_EM340.0 Comments
1 [[unk4 ID-U91
2 [[unk2 ID-U92
3 [Junk3 ID-U93
4 [[unka ID-U94
5 [[unks ID-U95

[Add Line] Above the Standard Table

‘ Check that the shutter is closed and then click [Auto Zero] on the quantitation
— measurement toolbar.

4 ‘ Place the sample in the instrument's sample compartment and close the lid.

78
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6.3 Quantitation

Click [Start] on the quantitation measurement toolbar.

A measurement value is displayed in the wavelength column and the concentration
calculated using the calibration curve is displayed in the concentration column.
Clicking the [Sample Graph] tab in the graph/parameter view displays the data point
plotted on a sample graph.

Repeat the same operations with respect to the other prepared samples.

% o [0 | e comol e 81
Stop Open Auto Zero Search File Name: = Qnt-01.fqqf >> Disconnect
Add Line.. EX  EM
307.0 340.0
Sample Name | Sample ID | Ex Conc EX307.0_EM340.0 Comments 0.0
1 Std-1 ID-01 10.000 5855 497 v Aclamp  ON (306 hous)
2 Std-2 ID-02 20.000 8604.319
3 |std3 1D-03 40.000 13766.649 Caribration Curve | Sample Graph |parameters|
Sample Graph
22.000 : - -
21.800 1 5 o
E 2ie00f n -
Sample Name | Sample IC Conc EX307.0_EM340.0 Comments g
1 |Unk-1 1D-U91 21.681 8974.372 M =
2 Unk-2 ID-U92 21.503 8927 622 8 2n4001 7
3 Unk-3 ID-U93 21.596 8952.041
4 Unk-4 ID-U%4 21.785 9001.659 21200 E
5 Unk-5 ID-U9%s 21.753 8993.399
? 21.000 L L L
1 2 3 4 s
Sequence No.

Quantitation Measurement Results

Once measurement of all samples is complete, click [Save As] on the main menu
bar.

A quantitation file is saved using the filename displayed on the quantitation
measurement toolbar.

«O~| = % Template: Open... | Save As... |
Open J MoZaoj Sea'chJ File Name: Qnt-01.fqqf >> |

Quantitation Measurement Toolbar

Close the quantitation file by clicking [Close] on the [File] menu.

A message window indicating that communication with the instrument will end. Click
[OK].

LabSolutions RF |5

As measurement parameters are cleared, communication with
/ !\ instrument is aborted.
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6 Quantitation

Saving and Loading Template Files

Quantitation template files are convenient when performing repeated quantitation
measurements using the same standard samples because they include measurement
parameter information, standard table information, and sample table information
(excluding measurement data).

Template files can be created from existing data files. This section explains the procedure
for saving and loading template files.

1 Click [Open] on the main toolbar.

Select the source quantitation data file in the [Open Data File] window and click [Open]
to open the file.

] Open - Data File (23]
Lookin: |, Data - 02 2 BEr
= Name Date modified Type
el {12 Qnt-01 2/10/20154:35 PM___ FQQF File

Recent Places
Desktop

=
Libraries
A
A
Computer
< m 3

@ File name: Qnt-01 v | |

Network
Files of type: [ Quantiation (*fadf) - | Cancel |

[Open - Data File] Window (Quantitation)

2 Click [Save As] - [Template] on the [File] menu.

— Enter the template filename and click [OK] to save the quantitation data file as a
template file.

:' Hint The folder specified for [Template Folder] in [Destination Folder] on the [Tools] menu is
displayed as the default save location.

3 Click [Close] in the [File] menu.
m— This clears the loaded data, table information, and measurement parameter settings
(returns to the startup state).
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6.4 Saving and Loading Template Files

4 Click [Open] next to [Template] on the quantitation measurement toolbar.

= i Ti :| Open... | |5ave As... +
&) emplate | I ave As ef
5}09 1 Open Auto Zero Search File Name: >> Connect

Quantitation Measurement Toolbar

g &

5 In the [Open - Template File] window, select the template file saved in step 2
and click [OK].

The [Quantitation File Setting] window is displayed.

6 Enter the details for [Filename], [Analyst], and [Comment] and click [OK].

I Quantitation File Setting

Filename:  CARF-Data\Data\Gnt-02.fqqf = @

Analyst: Shimadzu

Comment;  Template a

[Quantitation File Setting] Window

LabSolutions RF Basic Operation Guide 81



6 Quantitation

7 This sets the measurement parameters and loads the standard sample and sample
—  table information.

Click [Connect] on the quantitation measurement toolbar to establish communication with
the instrument and then perform quantitation measurement.

e = === o - |

File

-0 Q002 logl = — = =
() Standard Tatle " 57, «Q-|| Oz || " Tewplote:  Open... | Saveds.. | 2t
3 Savple Table 3 Open ”uam Search Fie Neme:  Qrit002.foaf »> | || Disconnect J
[Addine.| [Edt [(Opens] [ Saveds M
307.0 340.0
Sample Name | Sample ID Ex Conc EX307.0_EM340.0 Comments ‘ 0.0
1 s o0 10.000 ]  Aclatp  ON (33 hows)
2 Std-2 10-02 20,000
3 |std3 10-03 40.000 [ Cartuaton Curve | Sermpke Groph | Parameters
[ tood.
[ Vnamm Valve = |
Message Qstrument] |
Excitation Side Grating EX Bandwidth 30m
Shutter Motor Check - . ) EM Bandwidth 30mm &
Emission SideSitvor | | A8mes] (3] p— o ‘
Emission Side G Tme 10ms
e s Sample Name | Sample D | Conc | EX307.0 EM340.0 Comments
otal ludgment - OK = T |
Tnstrument Function 4 Unk-1 idl 5
ArcLamg - mounted 2 |unk2 DUz i s
Arc Lamp - Total Light 3 3 Unk-3 ID-U93 EM Wovelength 340.0 ren
Mercury Lamp - unmc ] Unk-4 IDU4
Integrating Sphere - N [Caibration Curve]
Sipper - Not Used x L] i Column for Cal. Curve EX307.0_EM340.0
Connection - Passed Cal. Curve Type Multi Point 2
- AL Durve i il
[ ' 1 o —l ] J

CARF-Data\Template\Qnt-002.f2¢f Ioaded

Main Window After Loading a Template File
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Photometric

This chapter explains how to operate the photometric general analysis application.

PP Reference For cases and functions not covered in this chapter, refer to the help file provided with
LabSolutions RF.

B Explanations Included in this Chapter

This chapter explains the procedures for measuring using a user-defined calculation
function and the pass/fail judgment function as well as saving the results of these
functions.

The following table shows the files that can be created by the photometric application
and the settings and data contained in these files (indicated with a check mark).

B NOTE Measurement parameter configuration is explained assuming that a connection
is established between an RF-6000 and LabSolutions RF.

Measurement Parameter
File Tvoe Settings Data and Information in the
yp (Including Calculation Formula Sample Table
Parameters)
Measurement parameter v i
file
Photometric file v v
. v" (excluding measurement
Template file v ( 9 "
data™)

*1 This refers to information and values that can be directly entered into tables, such as sample
information (sample name and ID) and factors.

B Functions Used in this Chapter

The following functions are used in photometric measurement.

e Creating measurement parameters (including creation of calculation formulas and
judgment equations)

e Creating a sample table
e Creating and saving a sample file

The operation explanation uses a sample that emits fluorescent light at around 340 nm
for an applied excitation light of 307 nm as an example.
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7 Photometric

7.1 Startup

Click [Photometric] on the [Fluorescence] tab in the LabSolutions RF launcher to start the
photometric general analysis application that allows obtaining of fluorescence intensity
at any wavelength, or a calculation result using that fluorescence intensity.

7.1.1 [Photometric - [Measurement]] Window Layout

= Photometric(RF_01)-[Measurement] [ole ==
file Edit View Graph Instrument Tools Window Help
[~ Bl | o=
X [PFJ»;M lq:nw = < "‘@" = [ Tempiate:  Open... | Save is... | Y
ample e y N7 o ‘.
Stop Open | | Auto Zero ’ Search File Name:  Pho-01.fquf >> nuz:-u
X EM
307.0 340.0
Sample Name | EX307.0_EM340.0 EQU_1 PF_1 K1 Comments 0.0 _9
e 1 Sample3-1 125.182 | 1251.817 Pass 10.000 « Aclamp  ON (394 hours)
2 Sample3-2 114354 | 11435637 Pass 10.000 A
3 Sample3-3 110647 553233 Fail 5.000 ((Sample Graph | arameters | D
Sample Graph
126.635 T T T
Message & 125.000 b 4
Data acquisition starte
Data acquisition starte
Data acquisition starte 3 1200001 b
Auto Zero - Excitation s
Data acquisition starte E 115000 | —9
Data acquisition starte n
Data acquisition starte, _
Data acquisition starte, 109,193 L L
Data acquisition starte 1 - 5
<[ » Sequence No
CARF-Data\Parameters\Pho-0L it loaded = 4
[Photometric - [Measurement]] Window Layout
( B NOTE The photometric application only has the measurement mode. ]
No. Name Function
The buttons used for starting and stopping
measurement and performing instrument control are
o Photometric measurement | located on this toolbar.
toolbar Buttons such as [Start] become active after clicking
[Connect] and establishing a connection with the
instrument.
The upper section displays the current wavelength and
fluorescence intensity and the lower section displays
(2) Instrument status the status of the spectrofluorophotometer.

PP Reference For details on the instrument status, see "2.3.3
Instrument Status" P.23.

Displays information including the settings of the
currently configured measurement parameters as well
as information and a graph of the calibration curve.
(3) Graph/Parameter view Clicking [Settings] on the [Parameters] tab displays the
window for creating (configuring) the photometric
measurement parameters. When loading an existing
measurement parameter file, click [Load].

(4] Sample table Displays sample information and measurement results.

84 LabSolutions RF Basic Operation Guide



7.2 Configuring Measurement Parameters

7.2 Configuring Measurement Parameters

Configure measurement parameters as well as calculation and judgment equations that
use captured data.

Photometric measurement parameters comprise measurement related parameters of
"wavelength", "measurement (sample)", "instrument", and "attachments" as well as
user-definable parameters of "calculation formulas" and "pass/fail" judgment. These
settings are configured in the graph/parameter view.

7.2.1 Configuring Measurement Parameters (Related to Measurement)

Set the parameters related to measurement, such as measurement wavelength and
instrument conditions.

B NOTE  When connecting to the instrument in the photometric general analysis
application, measurement parameters must be configured in advance.

1 Click [Settings] on the [Parameters] tab in the graph/parameter view.

| Sample Graph Parameters |

mmer—

Parameter Value

Parameter View

The [Photometric Measurement Parameters Wizard] window is displayed.

:' Hint  If measurement parameter configuration is already complete, the [Photometric Measurement
Parameters Wizard] window is displayed.
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7 Photometric

Set the [Instrument], [Wavelength], and [Measurement(Sample)] according to the
wizard and click [Finish] when finished.

e [Instrument]

Photometric Measurement Parameters Wizard - [Instrument] @

Spectral Bandwidth
Excitation: 3.0nm - Sensitivity: Low h ——e

Emission: 3.0nm - Accumulation Time: | 10ms > [—

cBsck | Net> | [ Cancel |

[Photometric Measurement Parameters Wizard - [Instrument]] Window

Instrument Condition .
e (Parameter) SO0
) e [Excitation]: 3.0 nm
(1] [Spectral Bandwidth] o
e [Emission]: 3.0 nm
(2) [Sensitivity] Low
(3) [Accumulation Time] 10 ms
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7.2 Configuring Measurement Parameters

¢ [Wavelengths]
Click [Add] after setting the following parameters to register the wavelength and
automatically create a (modifiable) column name.

Photometric Measurement Parameters Wizard - [Wavelengths] [

e Column Name:  EX3070_EM3400

—— EX Wavelength (nm): 307

— EM Wavelength (nm): 340

Pee

Entries:

‘ Columns Type ‘ Add

EX307.0_EM340.0 Point

[ <Back [ Nee> ] [ Cancel

[Photometric Measurement Parameters Wizard - [Wavelengths]] Window

No. Wavel(ePnagr';Pr\ng&r:;jition Setting
Q@ | [Typel Point

(2] [EX Wavelength (nm)] 307

(3) [EM Wavelength (nm)] 340
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7 Photometric

¢ [Measurement (Sample)]

-
]

[ Photometric Measurement Parameters Wizard - [Measurement (Sample)]

B

@ ———DatoAcquied By ) UserEntry @ Instrument
9——§anleRapeﬂions: 1 (] Prompt before repeat
Settings of the decimal place to display

Use Rounded Value
ForseCalo.Iabn: OFF
Settings of the decimal 3
place to display:

(For sample table and sample graph)

[ <Back ] [ Concel |

[Photometric Measurement Parameters Wizard - [Measurement (Sample)]] Window

Measurement Condition

M (Parameter) Sz
(1] [Data Acquired By] Instrument
(2) [Sample Repetitions] 1

The [Photometric Measurement Parameters] window is displayed.

Wavelengths | Measurement (Sampl) | Equatons | Pass/Fai | Instument | Atachment

Type: |Point - Column Name:  EX350.0_EM400.0

EX Wavelength (nm): 350

EM Wavelength {nm): 400

Entries:
Columns Type ;IM
EX307.0_EM340.0 Point Fenote

=

[Photometric Measurement Parameters] Window

PP Reference For details on the setting procedure of other parameters (such as for attachments), refer
to the help file provided with LabSolutions RF.
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7.2 Configuring Measurement Parameters

7.2.2 Measurement Parameter Settings (Calculation Forumulas / Judgment Equations)

Register a calculation formula / judgment equation in order to display calculation results
and judgment results, which use captured measurement values, in the sample table.
This section explains the procedure for displaying measurement results in the sample table
together with a pass or fail, which is determined by multiplying a measurement value
by the factor K1, where a result of 1000 or more is considered a pass and less than 1000
is a fail.

B Registering a Calculation Formula

1

Click [Factors] on the [Equations] tab in the [Photometric Measurement
Parameters] window.

-
Photometric Measurement Parameters

| Wavelengths | Measurement (Sample) | Equations | Pass/Fail | Instument | Attachment

Type: Custom -
ﬁ*’a‘;"; EQU_1 Unt:  mg/ml

Factors...
-

Build (double click to add an item to equation)

Columns: EX307.0_EM340.0 Operators:

+
»

-
1

Entries:

[Photometric Measurement Parameters] Window
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7 Photometric

2 Enter "K1" for [Column Name] and "10" for [Value] and click [Add].

Factor
Colurnn Name: | 1 el 10
Reqistered Factor:
| Columns Add
Delete
Close

[Factor] Window

3 Check that "K1" is added to the [Registered Factor] list and then click [Close].
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7.2 Configuring Measurement Parameters

4 Set the calculation formula.

Do not change the value of [Column Name] ("EQU_1") from its default setting. This item
is explained later in this section.

F =
Photometric Measurement Parameters

| Wavelengths | Measurement (Sample || Equations ||3ass/Fail | Instuument | Attachment |

Type: Custom v
Column o
Name: EQU_1 Unt:  mg/ml Factors...

Equation:  EX307.0_EM340.0°K1

Build (double click to add an item to equation)

Columns: [‘ EX307.0 EM340.0 ] Operators: [+ -

‘_ i

Entries:

Setting the Calculation Formula

1 Double-click [EX307.0_EM340.0] in the [Columns] list of the [Build] area.
2 Double-click [*] in the [Operators] list of the [Build] area.

3 Double-click [K1] in the [Columns] list of the [Build] area.
The set calculation formula is displayed in the [Equation] field.
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7 Photometric

i ’ Click [Add].

The created calculation formula is registered with the column name of "EQU_1".

Photometric Measurement Parameters

| Wavelengths | Measurement (Sample) | Equations | Pass/Fail | Instrument | Attachment |

Type: Custom v
Column :
Name- EQU_2 Unt:  mg/ml Factors...

Build (double click to add an item to equation)

Columns: EX307.0_EM340.0 Operators: |+ a

K1 . =

EQU_T I
/ -
\

Entries:
Columns
EQU_1

Registering a Calculation Formula
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7.2 Configuring Measurement Parameters

W Registering a Judgment Equation

1 Click the [Pass/Fail] tab in the [Photometric Measurement Parameters] window.

2 Set the judgment equation.

Do not change values of [Column Name] ("PF_1"), [Passed Text], or [Failed Text] from
their default settings. These items are explained later in this section.

:’ Hint  [Passed Text] and [Failed Text] are used as the judgment result in the judgment result
column of the sample table.

'Photornetric Measurement Parameters

| Wavelengths | Measurement (Sample) | Equation ! Pass/Fail | | strument |T°iiaT:‘111ed|

Column Name: PF_1

Passed Text: Pass Failed Text: Fai
Equation: EQU_1>=1000

Build (double click to add an item to equation)

Columns:  [[EX307.0_EM340.0 Operators:  [< A
K1 m '
eQu1 | E—

-

i. | Fy

Entries:

Columns l _édd__]

Setting a Judgment Equation

1 Double-click [EQU_1] in the [Columns] list of the [Build] area.
2 Double-click [>=] in the [Operators] list of the [Build] area.

3 Enter "1000" to the end of the string in the [Equation] field.
The set judgment equation is displayed in the [Equation] field.
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7 Photometric

3 ‘ Click [Add].

The created judgment equation is registered with the column name of "PF_1".

=

!Photornetric Measurement Parameters

| Wavelengths | Measurement (Sample) | Equations | Pass/Fail | instrument | Attachment |

Column Name: PF_2

Passed Tet: Pass Failed Text: Fail Factors...

St

Build (double click to add an item to equation)

Columns:  [EX307.0_EM340.0 Operators: [ < =
K1 I=
EQU_1 |
PF_1 <=
T
Entries:

PF_1 E

Registering a Judgment Equation

4 ‘ Click [Closel].
This closes the [Photometric Measurement Parameters] window.

The "EQU_1" column and "K1" column registered on the [Equations] tab and the "PF_1"
column registered on the [Pass/Fail] tab are added to the sample table.
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7.3 Photometric Measurement

7.3 Photometric Measurement

7.3.1 Specifying Filenames

1 ‘ Click => | on the photometric measurement toolbar.
<> E_//‘ v Template: M Save As... *
Start Open Auto Zero Search File Name: >> Connect

Photometric Measurement Toolbar

2 ‘ Enter the details for [Filename], [Analyst], and [Comment] and click [OK].
— The filename is displayed for [Photometric File] on the photometric measurement toolbar.

=

ToRotometrc File Setting

Filename:  C:ARF-Data\Data\Pho-01.fquf (e E @

Analyst: Shimadzu

Comment:  Photometric file comment a

[Photometric File Setting] Window

7.3.2 Connecting to the Instrument

In the photometric general analysis application, a connection with the instrument cannot
be established unless the measurement parameters have been configured in advance.

p

B NOTE Closing a photometric file by clicking [Close] on the [File] menu will clear the
configured measurement parameters thereby automatically disconnecting from
the instrument.

s v Template: Open... | Save As...
N

e +
+
Open Auto Zero Search File Name:  Pho-01.fquf >> Connect

Photometric Measurement Toolbar

O
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7 Photometric

7.3.3 Creating a Sample Table

1 Open the right-click menu on the sample table and click [Properties].

Copy
Paste

Select All

Show Repeats
Hide Excluded Lines

Delete Line

Print

Properties...

Right-Click Menu of the Sample Table

2 Hide the columns that are unnecessary in this example (those other than [Sample
Name], [Comment], [EQU_1], [K1], and [PF_1]).

Sample Table Properties E3)
Columns l
Columns Status *
Time Hide
Comments Show Show
EX307.0_EM340.0 Show
EQU_1 Show )|
PF_1 Show -
<[, m »

[Sample Table Properties] Window

3 Click [Add Line] above the sample table.

»

| sample Name | EX307.0_ EM340.0 | EQU_1 PF1 | K1 |  Comments

[Add Line] Above the Sample Table
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7.3 Photometric Measurement

4 Enter the number of lines to add and click [OK].

Add Line

Mumber of Line: | 3

7ok ]| | cencel

[Add Line] Window

5 Enter the name of the sample to measure.

:, Hint  All sample information can also be edited at once using the edit function or copied and
pasted from other application software.

P) Reference For details on the procedure for adding rows or editing tables, see "6.2.4 Creating a
Standard Table" or refer to the help file provided with LabSolutions RF.

Sample Name || EX307.0_EM340.0 | EQU_1 PF 1 K1 Comments
1+ || sample3-1 10.000
2 || sample3-2 10.000
3 || sample3-3 10.000

Entering Sample Names

6 Change the factor under [K1] of "Sample3-3" to "5".

Edt..
Sample Name | EX307.0_EM340.0 EQU_1 PR K1 Comments
1* | Sample3-1 10.000
2 Sample3-2 10 000
Sample3-3 5

Changing Factors
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7 Photometric

7.3.4 Measuring Samples and Saving Photometric Files

1 Check that the shutter is closed (";?:) and then click [Auto Zero] on the

photometric measurement toolbar.

2 Place the sample in the instrument's sample compartment and close the lid.

3 Click [Start] on the photometric measurement toolbar.

Measurement values in the wavelength column, calculation results in the [EQU_1] column,
and judgment results in the [PF_1] column are displayed. Clicking the [Sample Graph] tab
in the graph/parameter view displays the data point plotted on a sample graph.
Repeat the same operations with respect to the other prepared samples.

Wavelength Calculation Judgment
column result result

- = -
7S = || m= e ) ... | SaveAs... &4
) &, +O- | [z 7 T Open... | SaveAs... | 21
Stop Open J k!oZmJ Sead'nJ File Name:  Pho-01.fquf >> Disconnect
307.0 340.0
Sample Name | EX307.0_EM340.0 EQU_1 PF_1 | K1 Comments -0.0
1 |sample31 125182 ]| 1251817 Pass | 10.000 v Atclamp  ON (334 hows)
2 | sample3-2 114354 || 1123537  Pass | 10.000
3 | sample33 110.647]| 553.233 Fail 5.000 Sample Graph w]‘a'mm
Sample Graph
126,635 : . .
125.000 & B
.. 120000} -
%
§
E
115.000 - - -
L L
109.193 ! t 1
1 2 3
Sequence No.
Sample Measurement Results
4 Once measurement of all samples is complete, click [Save As] on the main menu
bar.

A photometric file is saved using the filename displayed on the photometric measurement
toolbar.

S )
Stop

r

Close

3 ... | Save As... (=% 3
O[] o ool smes) 51
Auto ZemJ Search j File Name:  Pho-01.fquf >> Disconnect

Photometric Measurement Toolbar

+D+
J
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Time Course

This chapter explains how to operate the time course general analysis application.

PP Reference For cases and functions not covered in this chapter, refer to the help file provided with
LabSolutions RF.

B Explanations Included in this Chapter

This chapter explains the procedures for measuring time-course intensities, automatically
printing results upon completion, and calculating activity values when using samples with
intensities that change over time.

! NOTE Measurement parameter configuration is explained assuming that a connection
is established between an RF-6000 and LabSolutions RF.

B Functions Used in this Chapter

The following functions are used in time course measurement mode and view mode.
e Configuring measurement parameters (including auto print function settings)

e Auto file function (setting filenames automatically)

e Time course measurement

e Calculating activity values using the main table

The operation explanation uses a sample that emits fluorescent light at around 340 nm
for an applied excitation light of 200 nm as an example.
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8 Time Course

Startup

Click [Time course] on the [Fluorescence] tab in the LabSolutions RF launcher to start the
time course general analysis application that allows measurement of changes in intensity
over time.

The [Time course] window features a "measurement mode", "view mode", and "edit
print form mode" and the mode can be changed by clicking the relevant button on the
main toolbar.

PP Reference For details and operation method of the "edit print form mode" window, see "10 Printing"
P.135.

8.1.1 [Time course - [Measurement]] Window Layout

| @ Time course(RF-01)-[Measurement] W!] =&
Eile Edit Yiew Graph [nstrument Jools Window Help

Open

B TreData 0.fic

[ ] &4
vE] GEE +@+ | .:i] [ ﬁ 7l5et fle name automaticaly > | a1
Ciose J;Gﬂem] mmJ Seoch | AutoFlel Dae Timel.fic Disconnect o
Time Course Graph
1934,039 ! T e
+ Arclamp DM (384 hours]
200001y 1 [
\
\ = — .
e \ | Parameter Valse 2
L | 4 [Measurement]
g Wil EX350.0_EM400.0
Messone Gilll | oosseor N . | x waveiangth 350.0 nm
Shutter Motor Check - ¢ 'E LY EM Wanslength 400.0 nm
Emission Side Slit Moto E b~ Timing Mode Auto =

Emission Side Grating b | :-:Tt s;a;q e
Tetal Judgment - OK el S
o mf-‘ﬂ.F o 5000001 1 | Evae Time 0.10s
strument Function Ac | Humber of Readings 1001
Arc Lamp - mounted | Record Events OFF

Arc Lamp - Total Lighti| TR |

Mercury Lamp - unmaot ‘-M'_""‘—"—-_._ | Drstrument]

Integrating Sphere - No L g BEn | Ex Bandwidth 5.0nm

Sipper - Mot Used _163.891 1 Il EM Bandwidth 5.0nm

Connection - Passed .. 0.0 100.0 200.0 3000 | Sensitivity High -
T { Second) | ‘ m v

< [m "

Fer Help, press F1

[Time course - [Measurement]] Window

The measurement mode is used when controlling an instrument to perform measurement.

No. Name Function

The buttons used for starting and stopping
measurement and performing instrument control are
o Time course measurement | located on this toolbar.

toolbar Buttons such as [Start] become active after clicking
[Connect] and establishing a connection with the
instrument.

The upper section displays the current wavelength and
fluorescence intensity and the lower section displays
(2) Instrument status the status of the spectrofluorophotometer.

D) Reference For details on the instrument status, see "2.3.3
Instrument Status" P.23.
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8.1 Startup

No.

Name

Function

Parameter view

Displays the settings of the currently configured
measurement parameters (settings such as parameters
related to measurement and whether to perform
automatic printing).

This view is used to configure, save, and load
measurement parameters.

Time course graph view

Displays a time course graph in real time during
measurement. Only [Overlay] is available as the graph
display method.

:' Hint  Displaying and hiding of the time course graph
is performed in the tree view.

PP Reference For details on the operating procedure, see "1.2.
1 Tree View Operations" P.13.
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8 Time Course

8.1.2 Time course - [View] Window Layout

(O Time course(RF-01)-{View] [E=8 Eoh| =
Eile Edit View Graph [nstrument Tools Window Help
-
= i)
=- W=7 TmcData_0 fitc
7l
B Time Course Graph
2007533
EX200.0_EM340.0
EX Wavelength 200.0 rn
1500.000 | . EM Wanelength 340.0 ren
Timing Mode Marnal
Time Unit Second
o N Total Tme 300.05
L £ ¥ 1000000 - Cycde Tme 0.20s
z Number of Readings 1501
- Record Events oFF
500.000 |- 4 s 1
[— EX Bandwidth 5.00m _o
Message = H"‘““—-.______ EM Bandwidth 5.0nm
I : -
Shutter Motor Check - O 0.000 ] Sy rich
Emission Side Slit Motor 183891 Accumulation Time 1s
Emission Side Grating M: 0.0 L W00 [Attachment]
Total Judgment - OK | Attachment Hone
I Function Acc "= e = =
Are Lamp - mounted ain Table  gan 1000 End 2000 [Cateutaiion] [t Pring
Arc Lamp - Total Lightin — = Auto Print o
Mercury Lamp - unmour| File I i l Activity ! Inita) Real =0 l Umin Factor l Correction Report File C:\RF-Data'Report|T
e i deial RawData _ | || | 1614976 395011| 08793 1614978 _ 10000| 10000
7 L)
Sipper - Not Used
Connection - Passed -
4 | an » s n + 3 - F
For Help, press F1

[Time Course - [View]] Window

The view mode is used to perform operations including data processing with respect to
captured or saved data.

No. Name Function

Displays measurement parameter information, data
history, summary information (such as sample
information and instrument information), and event
records of the active data.

(1) Parameter view

Displays a time course graph of the loaded data.
[Active] and [Overlay] are available as graph display
methods.

(2] Time course graph view :' Hint  Displaying and hiding of the time course graph
is performed in the tree view.

P) Reference For details on the operating procedure, see "1.2.
1 Tree View Operations" P.13.

Displays the parameter setting window for the main

table, data printing, and data calculation.

(3] Data processing view
PP Reference For details on data processing, see "9 Data

Processing” P.118.
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8.2 Configuring and Saving Measurement Parameters

Configuring and Saving Measurement Parameters

Create (configure) measurement parameters for measuring changes in fluorescence
intensity over time and save them to a file.

Measurement parameters can be set by loading a saved measurement parameter file.
Time course measurement parameters comprise "wavelength (parameters)",
"measurement (parameters)", "instrument (parameters)", and "attachments" and are
configured in the parameter view.

8.2.1 Configuring Measurement Parameters

PP Reference For details on each measurement parameter item, refer to the help file provided with
LabSolutions RF.

1 Click [Settings] in the parameter view.

EX EM
350.0 400.0

-0.0
W Auc Lamp ON (394 hours)

Parameter Value =
[Measurement]

WL1 EX350.0_EM400.0

EX Wavelength 350.0 nm

m

[ T Y DR P ARA A

parameter view - [Settings]

The [Time Course Measurement Method] window is displayed.
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8 Time Course

2 Set the wavelength conditions (parameters) on the [Wavelength] tab and click
[Add].
The measurement wavelength is registered and a (modifiable) name is automatically
generated.

B NOTE Delete the wavelengths used in the previous measurement before adding new
wavelengths for measurement.

Time Course Mesurement Parameters o
Wavelength IMeasuemed | Instrument IMadrned|
Wavelength
Exctation: 2000 | | WL Name EX EM |
Emission: 3404 ’ .
WL Name EX EM

1 EX200.0_EM340.0 2000 3400

[Time Course Measurement Method] Window ([Wavelength] Tab)

Wavelength Condition

(Parameter) Setting

e [Excitation]: 200.0 (nm)

Wavelength o
e [Emission]: 340.0 (nm)
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8.2 Configuring and Saving Measurement Parameters

3 Configure the measurement conditions (parameters) on the [Measurement] tab.

Time Course Mesurement Parameters

[ Wavelength | Measurement [ nstrument | Atachment

[ Timing Mode ( Graph «
Auto 9@ Manual Y axds Upper: 2000 @
e ek [rostr 0
[ Utiities
(1) Total Tona: i ] Record Events ©

Cycle Time: 02

Number of Readings: 1501

—— [¥] Perform Auto Print

@@———Repot Fie: CA\RF-Data\Report\TimeCourseActiveH frpt -

ot [ ooa ]

[Time Course Measurement Method] Window ([Measurement] Tab)

Measurement Condition

e, (Parameter)

Setting

e [Timing Mode]: Manual

e [Time Unit]: Second

(1) [Timing Mode] e [Total Time]: 300™"

e [Cycle Interval]: 0.2

e [Number of Reading]: 1501
e [Y axis Upper]: 2000

® | [Graph] :
e [Y axis Lower]: 0
(3) [Utilities] e [Record Events]: Unselected
(4) [Perform Auto Print] Selected
(5) [Report File] C:\RF-Data\Report\TimeCourseActiveH.frpt

*1 When using the manual setting, the measurement time is automatically calculated using the entered
data interval and number of data points.
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8 Time Course

:\’ Hint  While the full path of the report filename can be directly entered into the [Report File]
field, the report file can also be selected in the [Select File] window displayed by clicking

[...] (browse).

(O Select File (23]
Look in: Report Q2 Er
I Name - Date modified Type “
b 7 SpectrumPointPick 1/9/2015 3:59 PM FRPTF
Recent Places (I eCourseActiveH 3/3/20151:40 PM_ FRPTF
- ,E TimeCourseActiveV 1/9/2015 4:16 PM FRPTF
2 TimeCourseBatchPointPick 1/9/2015 4:16 PM FRPTF
Desktop 7 TimeCourseDataPrint 1/9/2015 4:15 PM FRPT F
= 7 TimeCourseDifference 12/12/2014 3:15PM  FRPTF
= .:a? TimeCourseEvent 1/9/2015 4:15 PM FRPTF
Libraries ,E TimeCourseMainH 12/16/2014 1:45PM  FRPTF
,:Z TimeCourseOverlayH 1/9/2015 4:14 PM FRPTF
:k 7 TimeCourseParameters 1/9/2015 4:13 PM FRPTF =
Computer ,:*_: TimeCoursePeakArea 1/9/2015 4:12 PM FRPT F
- ,E TimeCoursePeakPick 1/9/2015 4:10 PM FRPTF
Qﬁ ‘.7 TimeCoursePointPick - 1/9/2015 4:10 PM FRP'I; FE=
Network ‘
Flopame: [ TmeCouseActveh - | (Cosen ]
Flescftype:  |Report Fie ("fipt) v| | Concel | |

[Select File] Window

4

Configure the instrument conditions (parameters) on the [Instrument] tab.

Time Course Mesurement Parameters @
| Wavelength I Measurement | Instrumert |P«ﬂad’1meﬂt|
Spectral Bandwidth
o Excitation: 5.0nm - Sensitivity: High - 9
Emission: 5.0nm - Accumulation Time: | 1s - e
[Instrument] Tab
Instrument Condition .
No. (EArameter) Setting
) e [Excitation]: 5.0 nm
(1) [Spectral Bandwidth] o
e [Emission]: 5.0 nm
(2) [Sensitivity] High
(3) [Accumulation Time] 1s
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8.2 Configuring and Saving Measurement Parameters

8.2.2 Saving Measurement Parameters

1 Click [Save As] in the [Time Course Measurement Method] window.
The [Save As - Measurement Parameters File] window is displayed.

2 Enter a name for the measurement parameter file and click [Save].
The file is saved and the configured measurement parameters are accepted for use.

@ Save As - Measurement Parameters File
Savein: Parameters - O E-
= Name < Date modified Type
e No items match your search.

Recent Places

Desktop

w=l
Libraries

A

e

Computer
A
L~ « I 3
Network
File name: [Tmn:-U‘l_Param . ] [ Save ]

Save as type: ITmauPaaTﬁes(’fﬂtc) '] l Cancel Jl

[Save As - Measurement Parameters File] Window
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8 Time Course

Configuring the Auto File Function (Setting Filenames Automatically)

Filenames with the measurement start date and time or serial number appended to an
arbitrary character string can be created automatically.

This sections explains the settings for starting measurement without displaying the [New
Data Set] window after clicking [Start].

:, Hint  File information, such as the sample name, ID, and comments, can be entered for each
measurement by displaying the [New Data Set] window.

PP Reference For details on this function and setting items, refer to the help file provided with
LabSolutions RF.

1

Select the [Set file name automatically] checkbox on the time course
measurement toolbar.

The [Settings] window of the auto file function is displayed.

! NOTE  |f the checkbox is already selected, click == |

[::

xh

Go To WL

B

Auto Zero

Time Course Measurement Toolbar

108

LabSolutions RF Basic Operation Guide



8.3 Configuring the Auto File Function (Setting Filenames Automatically)

2 Set the auto file function conditions (parameters).
FSdﬁngs
o——__j Show new data set creation dialog when measurement is performed
[ Filename 1( Sample Name h
Name: [} Use sequential number
Foy India Name: First No.: Step: 9
A <4 Q) Use date Use sequential number Demo Sample + |1 1
FirstNo.: | 1 : :
Sample: TmcData_150212_133528. fitc Saen
Use sequential number
[ Analyst Name 1] {[i8riames FirstNo.:  Step: 9
Shimadzu =
+ 1 1
Comment [ Option i
9 Timecourse file comment [] use sequential number
Name: First No.: Step: @
+ |1 1
ok | [ conce
[Settings] Window
No. Condition (Parameter) Setting
[Show new data set
creation dialog when
(1) 9 No (unselected)
measurement Is
performed]

] e [Name]: TmcData
(2) [Filename] _
e [Use date]/[Use sequential number]: [Use date]

(3) [Analyst Name] Enter a name.

e [Name]: Demo Sample
(4] [Sample Name] _
e [Use sequential number]: No (unselected)

e [Name]: -
(5) [Sample ID] _
e [Use sequential number]: No (unselected)

o [N L -
(6) [Option] [Name]

e [Use sequential number]: No (unselected)

3 Click [OK].
The [Settings] window closes and the filename is displayed on the time course
measurement toolbar.

[ =2 .
> 7, +«O~ .:l] % (7] Set file name automatically >>. g:
i Stop Open J Go To WLJ Auto ZemJ Search [ TmcData[_Date_Time]. fttc ] Disconnect j

Time Course Measurement Toolbar
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8 Time Course

8.4 Time Course Measurement

l Check that the shutter is closed (*ﬁ*) and then click [Auto Zero] on the time

course measurement toolbar.

Place the sample in the instrument's sample compartment and close the lid.

\ N

3 Click [Start] on the time course measurement toolbar.
— Time course measurement starts and the captured data is graphed in real time.

PP Reference For details on the procedure for changing the graph scale, see "4.5 Changing the Graph

Scale" P.45.
—
=, i =
\/]> ) v Set file name automatically
Start | Close |G0 To WL | | Auto Zero | Search Tmc_002. fttc Disconnect
Overlay |
Time Course Graph
2000.000 ; ;
W Aic Lamp OM [86 hours]
Settings... Load...
1500.000 =
Parameter Value |+
[Measurement]
WL1 EX350.0_EM400.
= E¥ Wavelength 350.0 nm
£ 1000000} i EM Wanelength 400.0 nm
E Timing Mode Auto E
Time Unit Second
Total Time 100.0s
Cydle Time 0.10s
00000 - | Mumber of Readings 1001 i
Record Events OFF
[Instrument]
EX Bandwidth 5.0 nm
EM Bandwidth 5.0 nm
0.000 : : Sensitivity High
0.0 20.0 40.0 80.0 80.0 100.0 B P B -
Time ( Second ) 4Tlm“= o Tome. - | X

[Time Course] Window
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8.4 Time Course Measurement

When measurement is complete, printing is executed automatically (automatic printing).
The report file set in the measurement parameters is used for printing.

Print Date : 021272015 01:46:48 PM

Active Graph Report

File Mame:

TmcData__Z015021Z_134118 - RawData

Date/Time: 02/12/2015 01:46:20 PM
Analyst Shimadzu
1937.21 T T Sample Mame: Demo Sample
Sample 10: -
Option: -
Comment: Timecourse file comment
1500.00 | -
[Measurement]
WL EX200.0_EM240.0
EX Wavelength: 200.0 nm
EM Wanelength: 340.0 nm
Timing Mode: Manual
Time Unit: Second
Total Time: 200.0s
1000.00 W B Cycle Tima: 0.20s
= Number of Readings: 1501
z Record Events: OFF
£
\ [Instrument]
by EX Bandwidth: 5.0 nm
EM Bandwidih: 50nm
", Sensitivity: High
S Accumulstion Time: 13
500001 -, A
\‘-,\ [Attachment]
Attachment: Mone
e
e [AutoPrint]
hae AutoPrint: ON
M Report File: C:'\RF-Dats'Report
TT— TimeCourseActiveH.frpt
00D T
~1B3.50 I I
0.00 100.00 200.00 300.00
Time { Second )

Page1/1

Example of Printout
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8 Time Course

8.5 Calculating Activity Values

1

Click [View] on the main toolbar.

[

I 30 Spectrum(RE-01)-[Measurement]
File Edit View 3D Graph Instrument Tools Window Help

———

Main Toolbar

The window changes to view mode.

—

E'{

Edit Printform

Q© Time cou

Eile Edit View Graph [nstrument Tools Window Help

| eE= S| [ 2 (L | Parameter |tistocy | summary [ Event |
] | Fiawil ata]
- Time Course Graph Parameter Value
1864221 . . .
WLl EX200.0_EM340.0
1500000 EX Wavelength 200.0 nm
EM Wanelength 340.0 nm
Timing Mode Manual
Z 1000000 TTLHI Second
g Total Time 300.0s
i Cyde Time 0.20s
S00.000 MNumber of Readings 1501
Record Events OFF
0.000 [Instrument]
163891 . : EX Bandwidth s5.0nm
0o 100.0 200.0 300.0
Message = Time { Second } Edsmm th sjom
Shutter Motor Check - High
Emission Side Slit Mot Assistion Tine L
Emission Side Grating i g
Total Judgment - OK Attachment Hone
Instrument Function £
Arc Lamp - mounted [Auto Print]
Arc Lamp - Total Light o Auto Print ON
Mercury Lamp - unme | frier ’ ! Report File C:\RF-DatalReport)
Integrating Sphere - N
Sipper - Not Used
Connection - Passed
« [ v 1 LU d 2
For Help, press F1
View Mode
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8.5 Calculating Activity Values

8.5.1 Displaying the Main Table

1 Click [Operations] - [Main Table] on the main toolbar.

f Oneration

E —

Measurement Edit Printform -

Main Toolbar

:' Hint  [Operations] displays the two most recent data processing functions that were used.
If the data processing function for use is not displayed under [Operations], click [¥] and
select the function from the displayed list.

Operations

Point Pick

Manipulate

Data Print

Point Pick

Peak Pick

Peak Area

Batch Point Pick
Main Table
Intensity Difference

Selecting a Data Processing Function
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8 Time Course

2

calculation region are displayed in the graph area.

File Edit View

Graph Instrument Tools Window Help

Calculation region

The main table is displayed in the data processing view.
The display changes to the active graph and cursors for setting the activity value

TrmcData_01 fitc Active || 1
g [ Overay| : .
I Time Course Graph 1 Parameter
1982.040 epenl
WLl
EX Wavelength
1500.000 B EM Wanelength
Timing Mode:
Time Unit
= Total Time
% b 7 Cyde Time
E Number of Readings
Record Events
S00.000 - -
\ [Instrument]
EX Bandwidth
Message % ol | EM Bandwidth
Shutter Motor Check - -163i891 Sens‘ﬁ\-itvﬁm —
Emission Side Slit Mot 0.0 100.0 200.0 300.0 EESS
Emission Side Grating Time { Second ) o -
Total lJudgment - OK i .
Instrument Function # || | Main Table gy 1000 End 2000
s lamp d = [Auto Print]
Arc Lamp - Total Light File R Activity | Initial Rea 5D I/min Factor | Correction| || » +: print
Mercury Lamp - unm :5 RawData ... [&] 1614978 | 395.011 0.8793| -161.4978 1.0000 1.0000 | || Report Fie
Integrating Sphere - N
Sipper - Not Used |
Connection - Passed
< [ + < m ol | (7]

EX200.0_EM340.0
200,0 nm

340.0 nm

Manual

Second

30005

0.20s

1501

OFF

S.0nm
5.0nm

1s

For Help, press F1

Main Table Display
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8.5 Calculating Activity Values

8.5.2 Changing the Activity Value Calculation Region

There are two methods for changing the activity value calculation region: moving the
cursors on the graph and directly entering values on the main table.

B Setting the region using the cursors

Use the cursors on the graph to set the activity region. The region between the two
cursors is the activity value calculation region.

:' Hint  The main table displays all time course data that resides in memory.
When multiple data files are loaded, select (highlight) the target data row before setting

the calculation region.

1 Drag the cursors on the graph.
The [Start] and [End] times in the settings area of the main table are also updated.

:' Hint  Values can also be directly entered into the [Start] and [End] fields. In this case, the cursors
on the graph do not move to reflect the entered values.

Cursors
Active {Uverlay:
T/ne Course Graph
2015.49 :
1500.00 (- .
g 1000.00 g
£
500.00 B
0.00| n 1 e —
-163.89 (0) ( )|
0.00 /mbd}'j Wﬂ 300.00
Time ( Se: )
- a >
Main Table [ Stat 1160 End  197.2 Calculation
File R Activity Initial Reading SD I/min ] Factor |1/
RawData ] 667.04243 1388.201 7.15800 | -667.042 ] 1.000

Setting the Region
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8 Time Course

2 Click [Calculation].

The activity value is recalculated and the value in the main table is updated.

'Main Table gy

116.0 End. 197.2 Calculation
File R Activity Initial Reading SD I/min Factor |1
RawData 0 667.04243 1388.201 7.15800 | -667.042 1.000
Settings Area of the Main Table
B Directly Specifying the Start Time and End Time
Enter the calculation region directly into columns in the main table.
1 Open the right-click menu on the main table and click [Properties].

Copy
SelectALL
Paste
Print
Properties...

Right-Click Menu of the Main Table

116

LabSolutions RF Basic Operation Guide



8.5 Calculating Activity Values

Double-click both [Start] and [End] in the column list to change the display status

to "Show".
Main Table Properties X
Columns
Column Status 2
Activity Show
wi Hide E
Show y

Start
20wy

nua neauny

1

[Main Table Properties] Window

The [Start] and [End] columns are displayed in the main table.

Start End Initial Reading SD I/min
116.000 197.200 336.313 0.80193| -151.528

File R Activity
RawData O] 151.52801

)

Main Table

Enter the end time of the activity value calculation range into [End] in the main

table.
Press the "Enter" key to accept the value and automatically recalculate the activity value.

File R Activity Start End Initial Reading SD I/min
RawData O 151.52806 116.00( 200.000 336.313 080193 | -151.528
S ——

Entering the End Time

Enter the start time of the activity value calculation range into [Start].

Press the "Enter" key to accept the value and automatically recalculate the activity value
f — %
File R Activity Start End Initial Reading SD I/min
RawData E 151.5280: 100.000 200.000 336.313 0.80193 -151.528

Entering the Starting Time and Recalculating the Activity Value
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Data Processing

This chapter explains how to perform data processing in the spectrum and time course
general analysis applications.

PP Reference For cases and functions not covered in this chapter, refer to the help file provided with
LabSolutions RF.

B Explanations Included in this Chapter

This chapter explains how to perform data processing using operations in the spectrum
general analysis application as an example.

B Functions Used in this Chapter

While data processing consists of the following functions, this chapter uses the examples
of Peak Pick, Point Pick, batch Point Pick, and smoothing processing, which can be
performed in both the spectrum and time course general analysis applications, to explain
these functions and operating procedures.

Data processing in the spectrum application

e Data Print
e Peak Pick
e Point Pick
e Batch Point Pick
e Peak Area

e Manipulate (data set calculation, transformation, arithmetic)

Data processing in the time course application

e Data Print

e Peak Pick

e Point Pick

e Batch Point Pick

e Peak Area

e Main Table (activity value calculation)
¢ Intensity Difference

e Manipulate (data set calculation, transformation, arithmetic)
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9.1 Startup

9.1 Startup

To use a data processing function, click the desired data processing function under
[Operations] in view mode.

Clicking ¥ to the left of [Operations] displays a list of data processing commands. The
desired data processing can be performed by selecting the required command from the
data processing list. (This explanation uses the spectrum application window as an
example.)

[Operations] displays the name of the most recently used data processing function.

[12] Spectrum [View] ‘

File Edit View Graph Instrument Tools Window Help

e Manipulate

&) 530102 Active | Overlay | (B —
RREi =] CorectionDat l ! Point Pick ym
Vi

287826 . . .

T Peak Pick
s Peak Area Emission

3000.00 o
Batch Point Pick 307.0nm
& 200000 EM Wavelenath End 400.0rm

Data processing function list

Displaying the Data Processing List
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9 Data Processing

9.2 Peak Pick

Peaks and valleys are detected according to the set threshold value and number of points.

:\’ Hint ¢ When the number of points is set to n, peak detection occurs after the value
consecutively increases for more than n points and then consecutively decreases for more
than n points. The top of the peak (peak point) is taken as the point at which the value
starts decreasing. Valley detection occurs when the opposite condition (value consecutively
decreases for more than n points and then consecutively increases for more than n points)
is satisfied.

e The threshold value indicates the distance (fluorescence intensity) between the peak point
and a line connecting the valley points on each side (or provisional valley points) of the
peak. Peaks with a distance shorter than the set threshold value are excluded. The
detection of unwanted peaks and noise can be avoided by adjusting the threshold value
and number of points.

When multiple data is loaded, set the data for peak detection to active.

:' Hint  Double-click the target data set in the tree view to make it the active data (highlight in
blue).

=-¥)5 53 _01.fs2f
- [VIH ConectionData
=V $3_02.fs2f
- [VH ConectionData
221 G2 N3 ke

B =] Corectiondaia])

Active Data Display

1 ’ Click [Peak Pick] under [Operations].
——  The Peak Pick window is displayed.

Manipulate

| Active | Overlay

=) 53_01 k2!

¥8 CorectionData
-9 53 0262t

“-¥IH CorectionData
-9 53 0342

3 =] CorectionData

| Data Print
Point Pick

22052.13 T T T T [ Peak Pick ]
Peak Area
15000.00 /\
ES

Batch Point Pick
[Operations] - [Peak Pick]

T I EMTWAVEIENg I StErt

120 LabSolutions RF Basic Operation Guide



9.2 Peak Pick

2 Enter values for [Threshold] and [Points] and click [Execute].

:' Hint  The initial values of the Peak Pick parameters [Threshold] and [Points] are "1" and "4"

respectively.

Active Oveirlay !

22048.84 r . .

15000.00

10000.00

Intensity

5000.00

-1585.42

300 320 340 360 380 400

nm

Peak Pick [Threshold: 10 ][Poinls: 5 ]

I Intensity | Description

[ No. | PV | Wavelength nm.

Peak Pick Window

The wavelength and fluorescence intensity of each detected peak are displayed
in the Peak Pick table.

:' Hint  The mark in the [P/V] column indicates whether the detected wavelength is a peak or valley.

@ indicates a peak and @ indicates a valley.

Peak Pick  Theshold 10 Points: 5

No. PN Wavelength nm. Intensity Description
1| @ 340 16117.92

Wavelength  Fluorescence intensity

Wavelength and Fluorescence Intensity of Peaks
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9 Data Processing

4 Open the right-click menu on the Peak Pick table and click [Print].
The report file linked to the Peak Pick table is printed.

Copy
Paste

Select All

Graph » v Show Peak Mark
v Show Peaks Show Valley Mark

Show Vallevs

[ Print

Properties...

Right-Click Menu (Peak Pick Table)

:' Hint  The report file to be linked can be set on the [Quick Print] tab of the [User Settings]
window, which is displayed by clicking [User Settings] on the [Tools] menu.
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9.3 Point Pick

9.3 Point Pick

Detect fluorescence intensity at any wavelength (time).
When multiple data is loaded, set the target data to active.

Pp Reference For details on the procedure for setting the target data to active, see "9.2 Peak Pick"
P.120.

1 ’ Click [Point Pick] under [Operations].
The Point Pick window is displayed.

File Edit View Graph Instrument Tools Window Help
(S - rTl_‘ o
" L}

v

Print Preview Measurement

Manipulate
Data Print
Point Pick
= 7 53_02.fs2t | -
VIH CorectionD ata 25213 T T T Peak Pick
=-¥) $3 0312 Peak Area —
=] e /X Batch Point Pick 307.0 nm
= k T e g 300.0 nm

[Operations] - [Point Pick]

2 ’ Enter a value for [Wavelength] and click [Add].
Repeat this operation when detecting multiple wavelengths.

Active Overlay
22048.84 T T T T
15000.00 - =
=
e
§ 10000.00 -
E
5000.00 - -
-1585.42 ' ' ' ' ]
300 320 340 360 380 400
nm
Point Pick [ wavlengthinm}: 355.0 Template: m Save As
| No. | Wavelength nm. I Intensity | Description

Adding a Wavelength
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9 Data Processing

3

The fluorescence intensity of each set wavelength is displayed in the Point Pick
table.

:' Hint  Wavelengths can also be specified using the cursor on the graph.
Dragging the cursor on the graph displays the value of the wavelength at the cursor
position in the [Wavelength] field.

Point Pick  \avlengthinm}: 380 Template: | Open.. | [Savess.. |

No. Wavelength nm. Intensity Description
1 327.( 114004
2 360.( 10719.5

Point Pick Table

Open the right-click menu on the Point Pick table and click [Print].
The report file linked to the Point Pick table is printed.

Copy
Paste

Select All

Delete Point

Shaw PDaint Marlk

Print

Properties...

Right-Click Menu (Point Pick Table)

:\’ Hint  The report file to be linked can be set on the [Quick Print] tab of the [User Settings]
window, which is displayed by clicking [User Settings] on the [Tools] menu.
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9.3.1 Creating and Saving Template Files

9.3 Point Pick

The wavelengths (times) used in the Point Pick table can be saved as a template file.

Point Pick Wavlength(nm): 360 Add Template: [ Open... ] [Save As.‘.]
No. Wavelength nm. Intensity Description
1 327.0 11400.4
2 360.0 10719.5

Click [Save As] on the Point Pick table.

:' Hint  Saving can also be performed by clicking [Save As] - [Template] on the [File] menu.

POil'lt Pil:k Wa\"leﬁg‘h[nm]: 360 Temp;a(e: [ Dpen“ ] [ Save As... ]
No. Wavelength nm. Intensity Description
1 327.0 11400.4
2 360.0 10719.5
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9 Data Processing

2 Enter a name for the template file and click [Save].
[14] Save As - Template File |3
Savein: |, Template ~ Q@2 E-
I Name - Date modified Type
o~ No items match your search.

Recent Places

Desktop

=

Libraries
A
Computer
A 1
i&, P m ’
Network
File name: 327-360_Point| l
Save as type: [Po'rt Pick Template("fstp) '] l Cancel J

[Save As - Template File] Window

:' Hint e The folder shown as the save location when the [Save As - Template File] window is
displayed is the folder specified for [Destination Folder] on the [Tools] menu. This can
also be changed when opening a template file.

e Opening a Point Pick template with the target spectrum made active will execute Point
Pick on the spectrum.

PP Reference For details on the operating procedure for Point Pick using templates, see "9.4 Batch Point
Pick" P.127.
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9.4 Batch Point Pick

9.4 Batch Point Pick

Detect fluorescence intensity at any wavelength (time) with respect to all loaded data.

While any wavelength (time) can be detected by directly entering values or moving the
cursor in the same manner as for Point Pick, this section explains the Point Pick procedure
when using a Point Pick template file.

:’ Hint  Point Pick template files can be used for both Point Pick and batch Point Pick.

PP Reference For details on the procedure for directly entering values and moving the cursor, see "9.3
Point Pick" P.123.

9.4.1 Using Template Files

1 ’ Click [Batch Point Pick] under [Operations].
— The batch Point Pick window is displayed.

File Edit View Graph Instrument Tools Window Help
(R [———
" - [

v

Open Save Print Preview

Manipulate

-V 530162 Active| Overlay Data Print

V|H CorrectionD ata L—J I Point Pick = |
2V $3_ 0212t : value

- {W|H CorectionData 2205213 T T T T Peak Pick

&)y 53,0302 EcicHics Emission

= 15000.00 /\ Batch Point Pick 307.0 nm
= 1101 ST vEavEIsig U e 300.0 nm

[Operations] - [Batch Point Pick]
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9 Data Processing

2 ’ Click [Open] on the batch Point Pick table.

:' Hint  Template files can also be loaded by clicking [Open] - [Template] on

the [File] menu.

Active| Ovellay |

177282 . . . ;
15000.0

10000.0 -

Intensity

//

5000.0

-1595.2
300.0 320.0 340.0 360.0 380.0
nm

Save the result in each data: | Execute

Batch Point Pick  wavlengthinm):  355.0 Tgmpla[e; SE RS

No. | Wavelength nm. s301 | s302 | s3o03 |

Batch Point Pick Table
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9.4 Batch Point Pick

Select the template file to use and click [Open].

:' Hint  The folder shown as the save location when the [Open - Template File] window is displayed
is the folder specified for [Destination Folder] on the [Tools] menu. This can also be changed

when opening a template file.

Open - Template File

=)

Look in: . Template v @ T £ G
D= Name = Date modified Type
S f o 327-360_Point 2/12/2015 3:15PM  FSTP File

Recent Places

Desktop

=l
Libraries

A

-

Computer

@
¥ -
Network

File name:

Files of type:

I

¢
327-360_Point - [

|

Point Pick Template("fstp) ~|

[Open - Template File] Window

4

Batch Point Pick is performed according to the opened template file.

Batch Point Pick Table

Batch Point Pick Wwiavlengthlnm]. 3550 &dd Template: [ Open... l [Sa\fe Az ]
Save the result in each data:
No. Wavelength nm. 53 M1 53 02 53 03
1 327.0 18277 4075.5 114004
2 360.0 2127.0 4393.3 10719.5
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9 Data Processing

5 Open the right-click menu on the batch Point Pick table and click [Print].
The report file linked to the batch Point Pick table is printed.

Copy
Select All

Delete Point

Print

Right-Click Menu (Batch Point Pick Table)

:' Hint  The report file to be linked can be set on the [Quick Print] tab of the [User Settings]
window, which is displayed by clicking [User Settings] on the [Tools] menu.

130 LabSolutions RF Basic Operation Guide



9.4 Batch Point Pick

9.4.2 Saving Batch Point Pick Results as a Point Pick Table

The batch Point Pick results can be saved as a Point Pick table for each corresponding
data.

1 Click [Execute] on the batch Point Pick table.

Batch Point Pick ‘w'avlength[nm}: 355.0 Temp]a[e" [ UD’Eﬂ... ] [ SaveAs... ]
Save the result in each dat:
No. Wavelength nm. S3 .01 S3 02 S$3 .03
1 327.0 1827.7 4075.5 114004
2 360.0 2127.0 43933 107195

2 Click [Yes] in the displayed confirmation dialog box.

— Point Pick tables are created for all spectrum data and updated with the batch Point
Pick results.

"Tabsolutions RF

. Updates each spectrum point pick table with batch point pick results.
' ! Point pick table is overwritten.
—  OK?

["] Do not display this prompt in the future

L Yes J|__MNo_ |

Confirmation Dialog Box

B NOTE If a template file that has already been executed (with a saved Point Pick table)
is loaded, the existing Point Pick table is overwritten.
If a loaded data file that contains an existing Point Pick table that should be
preserved, click [No] (do not overwrite) in the confirmation dialog box and then
close that particular data file.
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9 Data Processing

9.5 Manipulate - Smoothing Processing

Smoothing processing can be performed on spectrum data and time-course data.

:’ Hint The data created by smoothing processing does not overwrite the original data (data
captured in measurement) and resides in the same file as the original data as a new data
set.

This section explains the smoothing procedure using the spectrum application as an
example.

1 ’ Click [Manipulate] under [Operations].
— The Manipulate is displayed.
File Edit View Graph Instrument Tools Window Help

r - f - ] I Operations
[ = | CHE L3 -‘ E

Batch Point Pick
Open Save Print Preview Measurement View Edt Printform Manipidate
=) $3._016s21 [Active Overlay | Data Print ]
L i v
J VH c Data Point Pick e —
-V 53_021s2t B
{5 ConectionD ata o T T T T Peak Pick
=¥ 53 031s2f Peak Area Emission
= 15000.00 K Batch Point Pick 307.0 nm
=, & TT e quTs 300.0 nm

[Operations] - [Manipulate]

2 ’ Click [Transformations] in the [Type] list.

Active Overlay

17727.3 T T T T
15000.0
= 10000.0
wn
5
E
5000.0
-1585.4 1 L L 1
300.0 320.0 340.0 360.0 380.0 400.0
nm
Manipulate
Type: [[Transfotmations ']] Execute... ]
Data Set: 53_03 - ConrectionD ata
Transformation [ Deivative hd ]
Method:
Order: [Smoot}ing 'J
DeltaLambda: | 5000 3

Scaling Factor: 1

Data prosseing view

132 LabSolutions RF Basic Operation Guide



9.5 Manipulate - Smoothing Processing

Check that [Transformation Method] is set to [Derivative] and [Order] is set to
[Smoothing].

:' Hint  The target of data manipulation is the data displayed for [Data Set].

Since the active data is displayed, the target data can be changed by reselecting the active
data in the tree view.

Manipulate

Type: [Translo:mations '] l Execute... J
Data Set: 53 03 - CormectionData

Transformation [Delivative v]
Method:

Order: [SmoolHng ']
Detalambda (5,000 ]
Scaling Factor: 1

Checking the Parameters for Data Transformation

Select the value of the derivative wavelength (time) difference in the [Delta
Lambda] list ("5.000" in this example) and click [Execute].

The [New Data Set] window is displayed.

:’ Hint ¢ For smoothing processing, set [Scaling Factor] to "1".

e [Delta Lambda] indicates the derivative wavelength (time) difference. While the value of
[Delta Lambda] varies according to the data interval of the data to transform (data
interval x 10), there are four levels that can be selected.

Setting a large derivative wavelength (time) difference will reduce noise but adversely
affect resolution.

PP Reference For details on data transformations, refer to the help file provided with LabSolutions RF.

Manipulate

Type: ’Transformalions '} ’ Execute... I
Data Set: S3_03 - ComectionD ata

Transformation [Deli'v‘ative v ]
Method:

Order: [Smoothing v l

Delta Lambda: 5.000

20.000
40.000

Scaling Factor: 10.000 ‘

Setting the Delta Lambda (Derivative Wavelength (Time) Difference)
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9 Data Processing

‘ Enter the data set name of the transformation data to create in [Data Set Name]
(shown as "Smoothing" here) and click [OK].

‘New Data Set
Filename: C:ARF-Data\Data\S3_03.fs2f Q_}
Data Set Name: Smoothing
Analyst: Shimadzu
Sample Name:
Sample |D:
Option(Q}):
Comment: A
1 b
Lok J| [ Concel ]

[New Data Set] Window

A transformed data set is created and a spectrum graph is displayed on the [Active] tab
in the graph view.

:' Hint  The created transformation data resides in the same file as the original data.

=-[Vpr 53 03fs2A ‘ Active | Overlay|
[ CrrmntinnDaba
=] Sroothi ]
[ =8 17685 1 . . . .
15000.0 .
= 10000.0 -
-
]
E
5000.0- .
L -
-1348.1 1 L 1 1
300.0 3200 340.0 360.0 380.0 400.0
nm

Spectrum Display

134 LabSolutions RF Basic Operation Guide



—
1 Printing

This chapter explains the procedure for operating the print function and the function
for creating report templates (report files).

PP Reference For cases and functions not covered in this chapter, refer to the help file provided with
LabSolutions RF.

B Explanations Included in this Chapter
This chapter explains the procedures for creating report files and printing using report
files (Quick Print).

The sample data used in explanations is located in the folder for LabSolutions RF-related
files that is created during installation.

For example, if LabSolutions RF is installed on the C drive, the data is copied to the
"C:\RF-Data\Sample" folder. This location is abbreviated to "\Sample" in this manual.

B Functions Used in this Chapter

e Creating and editing report files

e Data Print (Quick Print)
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10 Printing

Quick Print

The general analysis applications feature a Quick Print function that allows printing of
graphs and data processing tables using specified report files. This section explains the
procedure for printing using the Quick Print function.

10.1.1 Report Files

A report file is a template file for printing that contains the following printable objects
arranged on a mock-up page.

e Graphs

¢ Measurement parameter information
e Data processing results

e Quantitation results

¢ File information etc.

Straight line
Place lines of any thickness and color.

Text Linked text
Entertext in any font and size. The date and time of printing is specified as a link.
[ Active Graph Report ] ((rint pate - 021122015 0511303 PM )
i File Name: S53_03 - ComectionData h -
Date/Time: 02/05/2015 11:35:04 AM
Analyst Shimadzu
208185 T T T T Sample Name:
n q SamplelD
Option
Comment:
i
-
15000.04 4 ~ _‘
Measurament]
Spectrum Type Emission
EX Wavelength 307.0 nm
EM Wavelength Start 300.0 nm
EM Wavelength End: 400.0 nm
Dats Interval: 0.5nm
10000.0 Scan Speed: 800 nmimin
oooaol- ‘
E [Instrument]
£ £X Banawidtn: 20mm
EM SBandwidth: 3.0nm
Sensitivity: Low
[Attachment]
5000.04 4 Attachment: None
[AutoPrint]
AutoPrint: No
Report Fila:
0.0 .
\ )
-2515.2! - 1 L 1
2000 3200 3400 3800 3800 4000
L o
Page1/1
Measurement parameters
Specify the active data set as a link.

Graph Data information
Specify the active graph tab as a link. Specify the active dataset as a link.
ltems for printing can be set as needed.

Example of a Report File (spectrum_active graph_landscape.frpt)
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10.1 Quick Print

LabSolutions RF provides report files with a combination of various printable objects and
these files are configured with initial settings that allow them to be used with the Quick

Print function in each application.

Report files are located in the folder for LabSolutions RF-related files that is created

during installation.

:’ Hint If LabSolutions RF is installed on the C drive, the report files are copied to the

"C:\RF-Data\Report" folder.

The following table lists the report files prepared for the printing of spectra.
Report files can be edited in the "edit print form mode" of each general analysis

application.

PP Reference For details on the procedure for editing report files, see "10.3 Creating Report Files"

P.148.

Report Filename

Description

SpectrumActiveV.frpt

Includes a layout of objects such as the active graph
tab, linked graph objects, and measurement
parameter information objects. The page orientation
is portrait.

SpectrumOverlayH.frpt

Includes a layout of objects such as the overlay graph
tab, linked graph objects, and legend information. The
page orientation is landscape.

SpectrumParameters.frpt

Includes a layout of measurement parameter
information objects corresponding to the active data.
The page orientation is portrait.

SpectrumDataPrint.frpt

Includes a layout of the displayed data print table.
The page orientation is portrait.

SpectrumPeakPick.frpt

Includes a layout of the peak pick table of the active
data and objects related to information regarding the
file. The page orientation is portrait.

SpectrumPointPick.frpt

Includes a layout of the point pick table of the active
data and objects related to file information. The page
orientation is portrait.

SpectrumBatchPointPick.frpt

Includes a layout of the displayed batch point pick
table and graph objects (linked to the overlay graph).
The page orientation is portrait.

SpectrumPeakArea.frpt

Includes a layout of the point pick table of the active
data and objects related to file information. The page
orientation is portrait.
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10 Printing

10.1.2 Quick Print Settings

The report file for use with Quick Print can be set on the [Quick Print] tab of the [User
Settings] window, which is displayed by clicking [User Settings] on the [Tools] menu.

User Settings =)
[ General | Quick Pt | Links | Text File Formats | Text Output|

Print kem: | [T -
Peak Area [
Paint Pick | ‘
Data Prirt 1=
Batch Point Pick
Active Spectrum Graph
Oveday Spectrum Graph -

Report File:

C:\RF-Data\Report\Spectrum PeakPick fipt

oK || cance |

[User Settings] Window (Spectrum Application)

The initial settings are configured as listed in the following table.

View Area Printable

Application Using Quick Print Report Filename
Active graph SpectrumActiveV.frpt
Overlay graph SpectrumOverlayH.frpt
Measurement parameters SpectrumParameters.frpt
Data Print table SpectrumDataPrint.frpt
Spectrum

Peak Pick table

SpectrumPeakPick.frpt

Point Pick table

SpectrumPointPick.frpt

Batch Point Pick table

SpectrumBatchPointPick.frpt

Peak Area table

SpectrumPeakArea.frpt

3D Spectrum

Active graph (Contour Plot)

3Spectrum3DActiveContour.frpt

Active graph (3D Spectrum
Graph)

Spectrum3DActiveShift2D.frpt

Measurement parameters

Spectrum3DParameters.frpt

Tiles 1x2 Spectrum3DTile1x2.frpt
Tiles 2x1 Spectrum3DTile2x1.frpt
Tiles 2x2 Spectrum3DTile2x2.frpt
Tiles 2x3 Spectrum3DTile2x3.frpt
Tiles 3x2 Spectrum3DTile3x2.frpt
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10.1 Quick Print

Application

View Area Printable
Using Quick Print

Report Filename

Quantitation

Standard table

QuantitationStandardTable.frpt

Sample table

QuantitationSampleTable.frpt

Measurement parameters

QuantitationParameters.frpt

Calibration curve

QuantitationCalibrationCurve.frpt

Sample graph

QuantitationSampleGraph.frpt

Photometric

Measurement parameters

PhotometricParameters.frpt

Sample table

PhotometricSampleTable.frpt

Sample graph

PhotometricSampleGraph.frpt

Time course

Active graph

TimeCourseActiveV.frpt

Overlay graph

TimeCourseOverlayH.frpt

Measurement parameters

TimeCourseParameters.frpt

Data Print table

TimeCourseDataPrint.frpt

Peak Pick table

TimeCoursePeakPick.frpt

Point Pick table

TimeCoursePointPick.frpt

Batch Point Pick table

TimeCourseBatchPointPick.frpt

Peak Area table

TimeCoursePeakArea.frpt

Main Table

TimeCourseMainH.frpt

Intensity Difference table

TimeCourseDifference.frpt

Event table

TimeCourseEvent.frpt
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10 Printing

10.1.3 Printing Using Quick Print

This section explains the procedure for printing with the Quick Print function using a
report file linked to the peak pick table in the spectrum general analysis application.

1 ’ Set the spectrum data targeted for printing to active and display the peak pick

— table.

This example uses the sample data in the "S3_03.fs2f" file located in the "\Sample" folder.

:' Hint  Double-click on the target spectrum data in the tree view to set it to active.

PP Reference For details on peak pick, see "9.2 Peak Pick".

Tree view
) . Operations
E Peak Fick v
Ede Printform Batch Point Pick ~
=91 §3 0162 Active "
T CemiorDal Overlay Parameter |kistory | Summary |
&) 83 0212 S popmater Yolue
V& CorectiorData ~F y J T R [Measurement]
¥ 530362 Spectrum Type Emission
€ B corectionDats EX Wavelength 307.0nm
15000.0 EM Wavelength Start 300.0 nm
EM Wavelength End 400.0 nm
Data Interval 0.5nm
i 10000.0 Scan Speed 600 nm/min
5
E [Instrument]
50000 EX Bandwidth 3.0nm
EM Bandwidth 3.0nm
Sensitivity Low
Message 00 [Attachment]
System Initialization D A | L L Attachment None
300.0 3200 3400 360.0 380.0 400.0
am [AutoPrint]
AutoPrint No
Peak Pick  rhieshold: 10 Points: 5 ReportFle
No. I PV | Wavelength nm. | i I D p |
1 @ | 340.0 16117.9 |
<[ ) <[ HT ] ’
Peak pick table

Displaying the Peak Pick Table
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10.1 Quick Print

Open the right-click menu on the peak pick table and click [Print].
Printing is performed on the printer set as the default printer on the PC in use.

Copy
Paste

Select All

Graph »
v Show Peaks

Show Vallewe

Print

Properties...

Printing
Printing is performed using the report file linked to the peak pick table.

:' Hint To print after checking the mock-up page, click the view area of the target for printing
(the peak pick table in the above example) to select it and then click [Print Preview] on
the main toolbar or the [File] menu.
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10 Printing

Peak Pick Report Print Date:  02/12/2015 05:18:02 PM
File Name:  53_03 - ComectionData
205185 r T T T L -
L
150000 g -
.’. B
g- 10000.0 E
5
E
5000.0- 1
00— -
25152 4 L L 4
3000 3200 3400 3800 3800 4000
nm
[Peak Pick Teble] Date/Time: 02/05/2015 11:38:08 AM
- Analyst: Shimadzu
Tl'ml'nlgf ;’Elmré) 5 Sample Name:
Number 2 o:
[ No. [ PIV_ | Wavelength nm. ity | Description | option:
| 1 [ [] | 3400 161179 | | Comment:
[Measurement]
Spectrum Type: Emission
EX Wavelength: 307.0 nm
EM Wavelength Start- 300.0 nm
EM Wavelength End: 400.0 nm
Data Interval: 0.5 nm
Scan Speed: 800 nm/imin
[Instrument]
EX Bandwidth: 3.0nm
EM Bandwidth 3.0 nm
Sensitivity Low
[Attachmaent]
Attachment: None
[AutePrint]
AutoPrint: No
Report File:
Page1/1

Example of Printout
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10.2 Printing in Edit Print Form Mode

10.2 Printing in Edit Print Form Mode

To print by selecting an existing report file or by selecting the target data for printing,
print using the edit print form mode.

This section uses a report file ("spectrum_print operation example.frpt") that contains a

layout of spectrum printing objects to explain the procedure for printing any spectrum
information and data out of multiple spectrum data that is loaded.

Open the spectrum sample data files in the order of "S3_01.fs2f", "S3_02.fs2f",
and "S3_03.fs2f".

Click [Open] on the main toolbar to display the [Open-Data File] window, specify the
"\Sample" folder, and open the files.

Spectrum [View] =8 Mol =S
File Edit View Graph Instrument Tools Window Help
- Il 1 | Operations
- | m E e 2
Open Save Frint Preview Measuremert EdtPrntforn [ Bach Pomi Pk v Help
W) 53 0142t | overlay| 5
{7 ConectionData Aot |Deley porameter isctcy,| macy]
53 02162t Parameter Value
[ CormectionD st 2085185 T T B [Measurement]
Spectrum Type Emission
EX Wavelength 307.0nm
15000.0 EM Wavelength Start 300.0 nm
EM Wavelength End 400.0 nm
Data Interval 0.5nm
£ 100000 Scan Speed 600 nm/min
z
5
E [nstrument]
000.0 EX Banduwidth 3.0nm
EM Bandwidth 3.0nm
Sensitivity Low
Message 00 [Attachment]
System Initialization 5152 \ . . \ Attachment None
300.0 320.0 340.0 360.0 380.0 4000
nm [AutoPrint]
AutoPrint No
Peak Pick  Thieshold 10 Foints: 5 Report File
No. | PN | Wavelength nm. | Intensity | Description |
1 @ | 340.0 16117.9]
< [ 3 1 il >

Click [Edit Printform] on the main toolbar.
The window changes to edit print form mode.

File Edit View Graph Instument Tools Window Help

] Operations )
Peak Pick s ;
Edt Printform Batch Point Pick = Help

Main Toolbar

Click [Open] on the main toolbar.

Eile Edit View Tools Window Help

Main Toolbar
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10 Printing

4 Select a file and click [Open].
In this example, select "\Report\PrintOperationExample.frpt".

5 Open-eport i =
Lookin: J, Repott - @2 @
T Name < Date modified Type *
e [ PhotometricParameters 12/5/2014 4:44PM  FRPTF
Recent Places ) pp, ot ometricSampleGraph 1/9/2015409PM  FRPTFE
. .‘a PhotometricSampleTable 12/5/2014 4:45PM  FRPTF|
EE‘I PrintOperationExample 2/12/20157:35PM  FRPTF
Desktop ] QuantitationCalibrationCurve 1/9/2015 4:05 PM FRPTF
. ,\EJ QuantitationParameters Type: FRPT File FRPTF
an‘_] +2] QuantitationSampleGraph Size: 24.0 KB FRPTF
Libraries ,F_J QuantitationSampleTable Date modified: 1/9/2015 4:05 PM FRPT F
,\B QuantitationStandardTable 12/5/2014 4:42 PM FRPTF
&_I ,F,:tj Spectrum3DActiveContour 1/9/2015 4:00 PM FRPTF
Computer w3 Spectrum3DActiveShift2D 1/9/20154:01PM  FRPTF
w4 Spectrum3DIntensityDistribution 1/9/20154:01PM  FRPTF
@ ) Spectrum3DParameters 1/9/2015 4:01 PM FRPTF ™
! < m ] 3
File name: [ PrintOperationExample - ] [ ]
Flesoitpe: | Repor Fle (fp) g o)

[Open] Window

:' Hint  The folder shown for [Look in] when the [Open] window is displayed is the folder specified
for [Destination Folder] on the [Tools] menu.

5 Open the [View] menu and put checkmarks on [Properties View] and [Objects
List].

[44] Spectrum IViewl

File Edif II'ooIs
|v Tree View
s ’7 Log View

[7 Status Bar

Ok AR LUOERL &QQ

6 Change the zoom size on the layout toolbar to [75%].

[14] Spectrum [View]
File Edit View Tools Window Help

2[5 53 01.1s2f "
- [¥|3 CorectionData Ok BB BERE Q9] | ik |
=@ 53 0262 — 7
L[V CorectionData a . . z :
Layout toolbar Zoom size
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10.2 Printing in Edit Print Form Mode

7 \ Click the graph object in the report editing area.

e Edit View Tools Window Help
=
B4 1.1s2t
o e DELRED
& $3 0252 P - S D =SS S ;
1 H CorectionData — 2 3 4 5 6 7 S
=) 53 0362
B = Corecionaa :
: Spectrum Print Operation Example
&
2} System ~ &
] Report Template | || ©
@[5 Accessory
& Spectium :
| é,) Data Informal =
-zt= Legend
5 Summary :
5] Parameters o
R Y Data History 5
Message ) Pesk Area T: :
System Initialization - B DataPintTal_| | - . ) )
<[] v « W -
For Help, press F1 Pagel/1  Pos: 392, 263in NUM

Report Object Properties

The properties of the graph object are displayed in the window.

8 \ Click [View Links] on the [Data] tab.

e Edit View Tools Window Help
[ — [ — R —

iz L

Measurement = o

V)5 53 0162 Data HR AR LUOLEY &

- [VH CorectionData
Bg_gﬂmm“ View Links R L s S Ry S S T SN PO PR ¥
=@ $3 0382 ] Active (Spectrum)

ES] [C]0verlsy -
[]Latest Dataset 1 4
i ol : Spectrum Print Operation Example |
[ Latest Dataset 4 T | [Print Dete: p2/12120[8p7 37:38 AM
[JLatest Dataset 5 7
[JLatest Dataset 6 z e Name: P30 - on |
[7]Latest Dataset 7
[]Latest Dataset 8 & w3 9 -
["Latest Dataset 9
[7]Latest Dataset 10

11 sbant Dspanns 11

£ system =

Repott Template [ 7

@5 Accessoy

=-{uks) Spectium -
-9 DataInformal -

Intensity

(B Parameters
B DataHistory |
) PeakAreaT:
System Initialization  ~ ) DataPintTa _| * e == == . = w0

< E » « [ - Eﬂ""--'»"‘“'—:' ":'. v -

For Help, press FL Pagel/1  Pos:-032, 080in NUM

Message b

Selecting [View Links]

The [View Links] window is displayed.
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10 Printing

9

[Latest Dataset 3]: S3_01- CorrectionData

Active (Spectrum) 53_03 - ComectionData
Overay 53_01 - ComectionData
53_02 - ComectionData
53_03 - ComectionData
Latest Dataset 1 $3_03 - ComectionData
| mbmed Mimbmnnmit I C N Camamdine Neda
H Latest Dataset 3 $3_01 - CorrectionData | ]
< m

[View Links] Window

Check that the spectrum targeted for printing is displayed as follows and click
[OK].

(1] Spectrum [View]

File Edit View Tools Window Help

Select the [Latest Dataset 3] checkbox in the data list on the [Data] tab.
This displays the spectrum of "S3_01.fs2f" on the upper graph object in the report.

=)= 5301621
" [V& ConectionData
=5 $3 0212
[VJH ConectionData
=) $3_036s21

= Coecioa

D% [opis]

[ Active (Spectrum]
[ Overlay
["]Latest Dataset 1
=11 atast Natacat 2

[T

gt

B Y IER R RN

4 B

Spectrum Print Operation Example |

e

] =)
[ Latest Dataset 5
[|Latest Dataset 6
[ ]Latest Dataset 7 -
[]Latest Dataset 8 ~
["|Latest Dataset 9
[ILatest Dataset 10
=

bt Py bmnt 11

Message B

System Initialization -

« [ 3

3}
=)

£ System -
Report Template ||
Accessory
{s] Spectrum -
O Datalnformal || <+
[~ Graph =
i Legend
5 Summary :
-- Parameters &
[F DataHistory |||
), Peak Area Te
@ DataPiint Ta _

! [print Date: p2/12/20f1507:38:19 PM]

Inensity

50000

nu————/\\-

00 0 310 *20
il

300 wo

Pagel/1

Pos: -0.18, 042in

NUM

m

Changing

used as the graph scale.

the Upper Graph object

:' Hint  When a latest spectrum data is selected, the scale of the overlay graph in view

mode is
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10.2 Printing in Edit Print Form Mode

11 Click the linked text object that displays the filename and then double-click
— [Latest Dataset 3] in the [Field Name] data list.

The filename of "S3_01 - CorrectionData" is displayed on the linked text object.

:' Hint  The display format of the displayed filename is the display format of the dataset set via
[User Settings] on the [Tools] menu in view mode window.

[14] Spectrum [View]

File Edit View Tools Window Help

Coriers e [f5] 3 MM UOEEB QQ
=@ $3 0262 Lategories: e
{V[H CorectionData 3 4 b (o ’ &
=) S3_03fs2A
1€ =] ConectionD at=]

RS LR RRr IR

: ISpectrum Print Operation Example |
- | [rint Dste. p2rr22ofeprfeze o

; ———
Field Name: : ﬁhm a

Active[Spectium) &~
Latest Dataset 1 -

5 s

]

m

] System -
[E) Report Template
[# Accessory

Spectium

&
@

&8 (|5

intensity

2 Datalnfomal
Graph .
2 Legend

5 Summary

(E) Pavameters

&) DataHistory

Message i B), PeskbreaTe | | - 1

s P :
System Initialization - § Efl? '_:"‘\}Tvé - : ) 00 ) %0 20 00
A =

5

<@ v [eE

Pagel/1 Pos: -0.36, 241 in NUM

Changing the Lower Graph object

12’ Click [Print] on the main toolbar.
— The [Print] window is displayed.

Printer
Mame: | Microsoft XPS Document Wrker ~| [ Propetties... |

Status:  Ready
Type: Microsoft XPS Document Wiiter
Where:  XPSPort:

Prirt range Copies
@ Al Number of copies: 1

Pages from: |1 b |1

Selection _LH _Z;ﬂ ﬂil

[Print] Window

:' Hint  When [Print Preview] is displayed on the main toolbar, click ¥ to select [Print].

13’ Click [OK] to print.
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10 Printing

10.3 Creating Report Files

Create and edit report files in the edit print form mode of each analysis application.

This section explains the procedure for creating a report file that contains a layout of
objects including the filename of the active data, a graph, data information, and a peak
pick table.

Prepare spectrum data that has undergone peak pick and load the data in advance.

10.3.1 Configuring Page Settings and Editing Area User Settings

Configure the page settings of page size and margin and user settings of grid size of
the editing area.

1 Click [New] on the [File] menu in the edit print form mode of the spectrum
application.

The application changes to the state for creating a new report file.

2 Click [User Setting] on the [Tool] menu.
The [User Settings] window is displayed.

3 Select [Inches] for [Scale Unit], enter "0.5" for [Space] under [Grid], and select
—— the [Align to Grid] checkbox.

- ~
User Settings (53]

General |
Sl
T

Show Fields Name:
Grid
Color:

EC—

[User Settings] Window

4 Click [OK].

5 Click [Page Setup] on the [File] menu.
The [Page Setup] window is displayed.
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10.3 Creating Report Files

6 Set the [Paper], [Orientation], and [Margins] settings and click [OK].

e -
Page Setup [E5m]

o
Paper — = [ )
Source [Automaticaly Select -]
Orientation Margins {inches)
P i - 05 ight: 05
Printing — o i s — Margins
orientation pecsse || leeai 0 = U
==
[Page Setup] Window
10.3.2 Placing an Object for Printing the Filename
Use [Link Text] to print the filename of the active spectrum.
@77 System
® - Report Template
- [ Accessory
e A Text
-/ Shraight Line
-] Box
(O Round Rectangle
QO Circle
i 9 Pichira
& Link Text
[Link Text]
1 Drag and drop [Accessory] - [Link Text] in the objects list to the desired location

in the editing area.

:' Hint  This item can also be placed in the editing area by double-clicking on the object item in
the objects list.
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10 Printing

2 Display the filename of the active spectrum on the linked text item.

1

Click the [Contents] tab (on the properties display of the inserted linked text
object) in the property view.

2 click [Spectrum] in the [Categories] list.

3

Double-click [Active(Spectrum)] in the [Field Name] list.

Coreris |G [FetA2] p MM GEOGE &QQ
Categories:
Report & ! 2
Instrument Information

Spectium
General

_G WAPPIPIEPIP PRI PIIPGII PP
2
bl

Linked text

73|
#CorrectionData

N

Field Name: . ‘r
=
Latest Dataset 1 =
Latest Dataset 2
Latest Dataset 3
Latest Dataset 4

Displaying the Filename

:' Hint  The display format of the displayed filename is the display format selected via
[User Settings] on the [Tools] menu in view mode.

‘ Click on the [Font] tab in the properties view and set the type and size of the
! text font.
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10.3 Creating Report Files

4 Adjust the position of the linked text and size of the layout frame using the
mouse.

:' Hint ¢ Aligning the mouse over any of the handles (H) around the layout frame for edit mode
or selection mode changes the mouse cursor to an arrow. The size of the linked text can
be changed in the direction of the arrow by dragging in this state.

e Aligning the mouse over the layout frame in edit mode or on an object in selection
mode will display crossed arrows under the mouse cursor or change the mouse cursor
itself into crossed arrows. The position of linked text can be moved by dragging in this
state.

R I Y |

-~

Edit mode | Selection mode

B IR

el

B Ll PRIy |

Layout Frames

10.3.3 Placing a Data Information Object

Use data information objects to print data information (such as analysis date and time
and sample name) of the active spectrum.

+

-7 System
) Report Template
¥ [% Accessory

){ull Snectum _
9 Data Information
°v] @rapn

=w= Legend

-

5 Summary
_ Parameters

ry

[Data Information]

1 Drag and drop [Spectrum] - [Data Information] in the objects list to the desired
location in the editing area.

:’ Hint  This item can also be placed in the editing area by double-clicking on the object item in
the objects list.
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10 Printing

2 \ Select the [Active (Spectrum)] checkboxes on the [Data] tab in the properties
view.

Data |Opions | Contents [Font | jp MA@ OEBYH &Q

]

[ (] Active (Spectium] - J
T e

[ Latest Dataset 2

[ |Latest Dataset 3

[7]Latest Dataset 4

[ Latest Datoset 5 il - S3_03 - CorrectionData

[7]Latest Dataset 6

[[]Latest Dataset 7 . Date/Time: 02/05/2015 11:38:04 AM
[7] Latest Dataset 8 Analyst: Shimadzu
[]Latest Dataset 9 N Sample Name:
[7]Latest Dataset 10 . :
- o 5 SamplelD:
atest Nataset 2 KOption: ’

e Comment:

-7 System
D---@ Report Template
3] E‘j Accessory N
=] Spectium - =

9 Data Information
1 Reanl

Specifying the Active Spectrum

3 [ Select the [Date/Time], [Analyst], [Sample Name], and [Comment] checkboxes on
the [Contents] tab in the properties view.

The selected items are displayed in the data information object.

[Dsa [pionl Cens [fomt | vy AR mEOEBEL Q4

[V] Date/Time 2.3.4.5

FUKEE EEXIK

Analyst

Sample Name

[7] Sample ID :<,
1 Opion : S3_03 - CorrectionData

[ Comment ] - DateTime:  02/05/2015 11:38:04 AM
) Analyst: Shimadzu

= Sample Name:

Comment:

£ System
@-[2] Report Template
w3 Accessory _
-{u] Spectrum

E &? Data Information

— ~

Displaying Data Information

4 \ Adjust the position of the data information object and size of the layout frame
using the mouse.
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10.3 Creating Report Files

1034 Placing a Graph Object

Use a graph object to print a graph of the active spectrum.

@7 System
93'— Report Template
® Ej Accessory
() Spectium
i 4-_0 Nata Infarmating
[ i Graph
i-=e Legend
B Summary
{Z] Parameters

[Graph]

1 ‘ Drag and drop [Spectrum] - [Graph] in the objects list to the desired location in
——  the editing area.

:’ Hint  This item can also be placed in the editing area by double-clicking on the object item in
the objects list.

2 ‘ Check that the [Active (Spectrum)] checkbox on the [Data] tab in the properties
— view is selected.

bes fopios) A p AR LOUEW QK

= ST TearTTe
[ [[ZActive (Spectium) - J . Comment:

T ovenay 7
[ ]Latest Dataset 1 -
|| Latest Dataset 2 |
[ ]Latest Dataset 3 d - -
[ Latest Dataset 4 - e esd
[ Latest Dataset 5 ™
|| Latest Dataset B
["]Latest Dataset 7
[ Latest Dataset 8
[]Latest Dataset 8
711 atest NDataset 10

Intensity

-] System

(3] Report Template

[OF Ej Accessory

£-{ik] Spectum -
QQ Data Information -
Graph o
== Legend =
&5 Summary :
(=] Parameters . -1835.
IS) Data History . T
) Peak Area Tabele s

Specifying the Active Spectrum

3 ‘ Adjust the position of the graph object and size of the layout frame using the
' mouse.
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10 Printing

103.5 Placing a Peak Pick Table Object

Use a peak pick table object to print the peak pick results of the active spectrum.

@7 System
&]m Report Template
&]fj Accessory
=)-{uk] Spectrum
9 Data Information
{~] Graph
I Legend
g5 Summary
~{E] Parameters
~{&} Data History
) Peak Area Tabele
.[iH Data Print Table
(- Peak Pick Table
207 Pont Fick 1 able

[Peak Pick Table]

1 ‘ Drag and drop [Spectrum] - [Peak Pick Table] in the objects list to the desired

“Q Hint
the objects list.

location in the editing area.

This item can also be placed in the editing area by double-clicking on the object item in

2 ‘ Check that the [Active (Spectrum)] checkbox on the [Data] tab in the properties

view is selected.

Data | Options | Contents | Font
View Links

[_ |/ Active [Spectium) I -

[ Latest Uataset | ‘ ‘

[ Latest Dataset 2
[ Latest Dataset 3
(| Latest Dataset 4
|| Latest Dataset 5
[ Latest Dataset 6
[ Latest Dataset 7
|| Latest Dataset 8
(7| Latest Dataset 9
[7] Latest Dataset 10
(11 atest Nataset 11

#-£77 System

] Report Template

@ Ej Accessory

=] Spectrum
-9 Data Information
Graph

.25 Leaend

Ok AR

-~

A0 s 5w

[Number of Points: 5
Ho. | PV |Wavelength nm.| Intensity Description |
1@ | 340.0] 161179 |

nouB &8
00
-1585_1[—/ . . . 1
3000 3200 3400 #00 300 000
nm
hreshold: 10.000

Specifying the Active Spectrum
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10.3 Creating Report Files

3 ’ Adjust the position of the peak pick table object and size of the layout frame
' using the mouse.

153 03 - CorrectionData

D T IEEAE LS4 AN
Am W Ee o B
LaTo s ETE

=

R

| ritensity

-4
Sold BREE SRR 1T}

famoara’fomca 3

o d e X
o Y _I I

Example of Printing Object Layout

:\' Hint  The displayed column (row) width of the peak pick table is linked to the column width of
the peak pick table in the view mode window.
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10 Printing

103.6 Saving a Report

File

1 Click [Save As] on the [File] menu.

The [Save As] window

is displayed.

2 Enter a filename and click [Savel].
A report file is saved to the specified folder.

[ 4] Save As

Savein:
L -
=l
Recent Places

Desktop

=
Libraries

B L

L

Computer

A

Metwork

=
| Report [« W

Name : Date modified Type =
R?_J PhotometricParameters 12/5/2014 4:44 PM FRPTF
R‘Ej PhotometricsampleGraph 1/9/2015 4:09 PM FRPT F|E
R?_J PhotometricsampleTable 12/5/2014 4:45 PM FRPTF
R‘Ej PrintOperationExarmple 2/12/2015 7:35 PM FRPTF
R‘Ej QuantitationCalibrationCurve 1/9/2015 4:05 PM FRPT F
R?_J QuantitationParameters 12/5/2014 4:41 PM FRPTF
R‘Ej QuantitationSampleGraph 1/9/2015 4:07 PM FRPT F
R?_J Quantitation5ampleTable 12/5/2014 4:43 PM FRPTF
R?_J QuantitationStandardTable 12/5/2014 4:42 PM FRPTF
R‘Ej Spectrum3DActiveContour 1/9/2015 4:00 PM FRPT F
R?:*_J Spectrum3DActiveShift2D 1/9/2015 4:01 PM FRPTF
R‘Ej Spectrum3DiIntensityDistribution 1/9/2015 4:01 PM FRPT F
le-'i'; Spectrum3DParameters 1/9/2015 4:01 PM FRPTF ™
Il T 3

File name: Practice - i}

Save as type: [F{e-port File ("frpt) v] [ Cancel l

:\' Hint  The folder shown for [Save in] when the [Save As] window is displayed is the folder

[Save As] Window

specified for [Destination Folder] on the [Tools] menu.
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—
Quantum Yield

This chapter explains how to operate the dedicated analysis application for quantum
yield.

PP Reference For cases and functions not covered in this chapter, refer to the help file provided with
LabSolutions RF.

B Explanations Included in this Chapter

This chapter explains the procedures for measuring sample fluorescence spectra and

calculating quantum yield, changing the settings of display items in the results table, and
printing reports.

B Functions Used in this Chapter

The following functions are used in the quantum yield measurement program.
e Configuring measurement and instrument parameters
¢ Entering sample information and performing sample measurement

e Changing display items in the standard sample and unknown sample tables and setting
the number of digits for displaying values

e Printing reports
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11 Quantum Yield

11.1 Startup

The quantum yield measurement program comprises a measurement mode and file check
mode.

In measurement mode, a "preparation window" for performing tasks including
configuring parameters for measurement and a "measurement window" for checking
measurement results are used.

In file check mode, the content of opened data files can be viewed in the "measurement
window".

1 Click [Quantum yield] on the [Fluorescence] tab in the LabSolutions RF launcher.

— The dedicated analysis application for quantum yield starts and the [Quantum Yield
Measurement] window is displayed.

Quantum Yield Measurement [

Select an operation

@) Measure:
“) View data file

-

[Quantum Yield Measurement] Window

2 Select an operation and click [OK].
¢ Selecting [Measure] displays the preparation window in measurement mode.

¢ Selecting [View data file] displays the measurement window in file check mode.
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11.1.1

Preparation Window Layout

11.1 Startup

7] Quantum Yield - Mode o[- )
9__F;|. Fdit _Granh _Tools _Heln
D i, l:i] «O-
|_ceTom J Open || Mumzere || Dicomnect
r N7
Standard Sample Measurement Parameter =) ==
2 Measure " = 366.0 7000
W ): .
© Use existing data fie [Bxciaton Wavelength () 01
: v Arclamp  ON (241 hours)
CiRF _O.faty ==l Data Interval {om): 1.0 _6
Sample Name:  Standard Sample Scan Speed (nmfmin): 600
SampleID: 96685
Opin: — Instrument Parameter
Fluores Yield: 3
PEEE emam T 119500 Exdtaton Bandwidth (nm): | 5.0
Areavae:  134915.313
Emission Wavelength Range (nm):  Start  400.0 Eatbent i vkt o) | 55
End 7000
Sensitivity:  Auto
Absorbance: 00415
Solvent Refractive Index: ~ 1.4200 Ikecrating Sphere
Diuton: 1,000
Integrating Sphere:  Notused @
211026
L. 150000}
k]
&  1000.00}
E
500.00 /-
0.00
400.0 500.0 600.0 7000
Emission Wavelength (nm)
. i »
\

Quantum Yield - "Preparation Window"

No. Name Function
© | Title bar Displays the application name and window mode ("Measurement
Mode" or "File Check Mode").
Displays the application menus. Selecting a menu along the bar
® | Menu bar displays multiple command menus. The displayed command menus
differ depending on the application type and window mode.
Displays tool buttons for executing main functions, such as starting
©® | Main toolbar and stopping measurement, performing file operations, and
printing.
o Standard sample | For the standard sample, set whether to perform a new
view measurement or use previously measured standard sample data.
The upper section displays the current wavelength and
fluorescence intensity and the lower section displays the current
(5) Instrument status of the spectrofluorophotometer.
status
D) Reference For details on the instrument status, see "2.3.3 Instrument
Status" P.23.
@ | Parameter view | Set the various parameters required for measurement.
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11 Quantum Yield

11.1.2 Measurement Window Layout

Quantum Yield Measurement - Measurement Mode
File Edit Graph Tools Help

0 ||

Open

mmﬁ \JRA‘M

-_— =

Standard Sample Table

Standerd Sample | Actve | Overdraning| X EM

[ wo. | name [ ar [ abs]

366.0 700.0

[o6 o0 [14

[ 0| Standard Sample

211026
01

2000.00 v Arclamp  ON (241 hours)

1500.00f---- |

Destination

Intensity

1000.00 - -

Analyst

Comment

500.00

Measurement Conditions
Exditation Wavelength: 366 nm
Data Interval: 1.0nm
Scan Speed: 600 nmjfmin
Excitation Bandwidth: 5.0 nm

0.00

4000 7000

600.0
Emission Wavelength (nm)

500.0

Quantum Yield - "Measurement Window"

No.

Name

Function

Analysis result
view

Displays the analysis results in a standard table and unknown
sample table.

File information
view

Displays file information (such as filename, analyst name, and
measurement conditions) on a data file being measured or an
open data file.

Graph view

Displays the fluorescence spectrum graph of the standard sample
and unknown samples.

¢ [Standard Sample] tab
Displays the fluorescence spectrum of the standard sample.

e [Active] tab
Displays the fluorescence spectrum of the selected unknown
sample. Select an unknown sample by clicking on a row in the
unknown sample table.

¢ [Overdrawing] tab
Displays the fluorescence spectrum of any unknown samples.
Whether to overlay the graph of each unknown sample can be
performed by selecting the corresponding checkbox in the
unknown sample table.
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11.2 Preparation for Analysis

11.2 Preparation for Analysis

Measure the fluorescence spectrum of the sample to prepare for quantum yield
calculation.
This section explains how to configure the standard sample settings and analysis
parameters.

11.2.1 Setting the Standard Sample

A fluorescence spectrum of a standard sample with a known quantum yield value is
required to determine the quantum yield of an unknown sample.

B When measuring the fluorescence spectrum of a standard sample

When measuring the fluorescence spectrum of a standard sample prior to measuring the
fluorescence spectrum of an unknown sample, select [Measure] under [Standard Sample].

Quantum Yield Measurement - Measurement Mode
File Edit Graph Tools Help

New Analysis

Standard Sample View (Preparation Window)
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11 Quantum Yield

B When using a previously measured standard sample fluorescence spectrum

To reference previous measurement data without measuring a new standard sample

fluorescence spectrum, use the following procedure.

1 ’ Select [Use existing data file] and click [...].

i
Quantum Yield Measurement - Measurement Mode
File Edit Graph Tools Help

[———
d

New Analysis

Standard Sample View (Preparation Window)

’ Select the quantum yield data file to use as the standard sample data and click

! [Open].
X open =
Lookin: |, Data - 02 E-
T Name Date modified Type
2/10/2015 6:41 AM  FQTY File

S AoV o1
Recent Places

-

Desktop
=)
Libraries
&’L\.

Computer

@ < | 11 | »
Network
File name: [ Qv_01 z ] [ ]

Flesofype:  |QuanTum Yield Fies ("fqty) v | Concel I|

[Open] Window
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11.2 Preparation for Analysis

Select the quantum yield data file (.fqty) to use as standard sample data from
the relevant folder.

Selecting a quantum yield data file loads the information on the standard sample
contained in the file and displays the information under [Standard Samplel].

Standard Sample
) Measure
@) Use existing data fie
C:\RF-Datz\Dat=\QY_01.faty [Z]

Sample Name:  Standard Sample
Sample ID: 96685
Option: -
Fluorescence Quantum Yield:  0.5500
Area Value:  134915.313

Emission Wavelength Range (nm): Start  $00.0
End 700.0

Absorbance:  0.0415

Solvent Refractive Index:  1.4200

2110.26

1500.00 | - - - -

1000.00 - -

Intensity

500.00 f - -

0.00
400.0 500.0 600.0 700.0
Emission Wavelength (nm)

Standard Sample View (Preparation Window)
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11 Quantum Yield

11.2.2 Setting Analysis Parameters

When [Measure] is selected under [Standard Sample], set the analysis parameters
according to the following procedure.

:' Hint  When [Use existing data file] is selected under [Standard Sample], the analysis parameters
are automatically set to the same settings in the loaded data file and therefore do not
require configuration.

1 Set the parameters under [Measurement Parameter].

Measurement Parameter

Exdtation Wavelength {nm): 386.0
Data Interval {nm): [1.0 "]
Scan Speed (nm/min): [600 v]

Measurement Parameters (Parameter View)

Measurement Parameter Setting

[Excitation Wavelength] 366 (nm)

[Data Interval] 1.0 (nm)

[Scan Speed] 600 (nm/min)
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11.2 Preparation for Analysis

Set the parameters under [Instrument Parameter].

Instrument Parameter
Exditation Bandwidth (nm): ’5.0 v]
Emission Bandwidth {nm]): ’5.0 v]

Sensitivity: |Auto -

Instrument Parameters (Parameter View)

Instrument Parameter Setting
[Excitation Bandwidth] 5.0 (nm)
[Emission Bandwidth] 5.0 (nm)
[Sensitivity] Auto

Set the integrating sphere setting under [Integrating Sphere].

Integrating Sphere
Integrating Sphere: Mot used
Integrating Sphere (Parameter View)
Instrument Parameter Setting
[Integrating Sphere] Not used
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11 Quantum Yield

Entering Sample Information and Performing Sample Measurement

11.3.1 Measuring the Standard Sample

When [Measure] is selected under [Standard Sample], measure the standard sample first.
Standard sample measurement is not performed when [Use existing data file] is selected
under [Standard Sample]. In this case, proceed to "11.3.2 Measuring the Unknown
Sample" P.169.

Set the standard sample into the sample compartment.

=Y

2 ‘ Click [Start - Std].
— The "preparation window" changes to the "measurement window" and the [Quantum
Yield Measurement] window is displayed.

Starting Standard Sample Measurement (Main Toolbar)

i
Go To WL

AN

Auto Zero

Disconnect
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11.3 Entering Sample Information and Performing Sample Measurement

3

Enter the sample information and scan range.

Quantum Yield Measurement

1. Set the standard sample in the sample compartment.

2. Enter the sample information.

Sample Name:
Standard Sample
Sample ID:
96685

Option:

Fluorescence Quantum Yield:
Absorbance:
Solvent Refraction Index:

Dilution:

3. Set the scan range.

0.5500

0.0415

1.4200

10000

Emission Wavelength Range (nm): Start 400.0

: End 700.0

e Lo

[Quantum Yield Measurement] Window (Entering Standard Sample Information)

Standard Sample
Information

Setting

[Sample Name]

Standard Sample

[Sample ID] 96685
[Option] -
[Fluorescence Quantum

Yield] 0.55
[Absorbance] 0.0415

[Solvent Refraction Index] | 1.4200

[Dilution]

1.0000

[Emission Wavelength

Range]

[Start]: 400.0 (nm), [End]: 700.0 (nm)
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11 Quantum Yield

4 ’ Click [Measurement].

— Measurement of the fluorescence spectrum of the standard sample starts. The captured
data is graphed in real time.

Frfrre =ro e,

Ga T WL (= Auts Zere | | Dascervect

Starciand Sampie Tatie Standaed Sarcle | Actve | Gvercraming

[ Wo | name [ o [avs| m [ Memo |
L 0|5tandlﬂ5anuk 506 | oo él-t ! | 3000.00

2000

s000 6000 To0.0
Emaqinn Wavekngtn {nm)

Measurement Window
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11.3 Entering Sample Information and Performing Sample Measurement

11.3.2 Measuring the Unknown Sample

When measurement of the standard sample is complete, measure the unknown sample.

1 Set the unknown sample into the sample compartment.

2 Click [Start - Unk].

3 Enter the sample information and scan range.

-.Quanlum Yield Measurement (3]

1. Set the unknown sample in the sample compartment.
2. Enter the sample information.

Sample Name:
Unknown Sample

Sample ID :

Option :

Absorbance:  0.0579
Solvent Refraction Index:  1,3500
Diution: | 10

3. Set the scan range.

Emission Wavelength Range (nm): Start  $00.0

: End 700.0

[Measwrement] [ cancel |

[Quantum Yield Measurement] Window (Entering Unknown Sample Information)

Unknown Sample

Information SEing
[Sample Name] Unknown Sample01
[Sample ID] -
[Option] -
[Absorbance] 0.0579

[Solvent Refractive Index] | 1.36

[Dilution] 10

[Emission Wavelength

Range] [Start]: 400.0 (nm), [End]: 700.0 (nm)
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11 Quantum Yield

Click [Measurement].

Measurement of the fluorescence spectrum of the unknown sample starts. The captured

data is graphed in real time.

[ Quantum Vield Measurement - Measurement Mode E’ ]
File Edit Graph Tools Help
P &) X
GoToWL Close Auto Zero Disconnect
Standard Sample Table Standard Sample | Active |0 X =
} No. I name [ ar [Abs| m |  Wemo — 3660 5830
0 | Standard Sample 06 |00 |14 .
andard Samp [os Too [14 | 2196
Unknown Sample Table
Ho. name QY | Abs Rl Memo
: 800.00} -
Filename &
600.00
g Destination
s
E
00.00 Tadvet |
Comment
oy [RERES . | ERNNIEG (USRS L ——
Measurement Conditions il
Exdtation Wavelength: 386 nm
DataInterval: 1.0nm
0.00 Scan Speed: 600 nm/min
400.0 500.0 600.0 700.0 ? 4
Emission Wavelength (nm) Exchan Sendwct ~am

1w 5.0nm i

"Measurement Window"
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11.4 Performing Additional Unknown Sample Measurements

11.4 Performing Additional Unknown Sample Measurements

To continue measuring multiple unknown samples, use [Start - Unk] on the toolbar.

1 ‘ Set the unknown sample into the sample compartment.

2 | Click [start - Unk].
— The [Quantum Yield Measurement] window is displayed.

3 ‘ Perform steps 3 and 4 in "11.3.2 Measuring the Unknown Sample" P.169.
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11 Quantum Yield

11.5 Changing the Items Displayed in the Analysis Result Table

Change the items displayed in the analysis result table in the "measurement window" as
well as the number of digits used to display calculation results.

1 ‘ Click [Set Analysis Results] on the [Tools] menu.
The [Set Analysis Results] window is displayed.

Set the number of displayed digits and whether to show or hide display items.

Set Analysis Results =

Mumber of Displayed Digits
Decimal Point| 4~ | Digits

| Area Value (Sem)

["|Emission Wavelength Range (rang
[#]Absorbance (Abs)

[V]Solvent Refractive Index (RI)

| Dilution (DR)

[ Mema

o ][ conce

[Set Analysis Results] Window

Item Setting

[Number of Displayed 4

Digits]
[Sample Name (name)] Selected
[Sample ID (ID)] Unselected
[Option] Unselected
[Fluorescence Quantum Yield (QY)] Selected
[Area Value (Sem)] Unselected

[Select Display Item]
[Emission Wavelength Range (range)] Unselected
[Absorbance (Abs)] Selected
[Solvent Refractive Index (RI)] Selected
[Dilution (DR)] Selected
[Memo] Unselected
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11.6 Printing

11.6 Printing

This section explains how to print reports of measurement results.

There are two types of reports that can be printed: detailed reports and summary reports.

11.6.1 Printing a Detailed Report

In detailed report printing, a detailed report for the standard sample or any unknown
sample is printed.

M Printing a detailed report of the standard sample

1 Click the [Standard Sample] tab in the graph view.
mo— The standard sample graph is displayed.

2 Click [Print] on the main toolbar.
— The [Print] window is displayed.

3 Confirm that the printer for output is correct and click [OK].
A detailed report for the standard sample is printed.

B Printing a detailed report of an unknown sample

1 Click the [Active] tab in the graph view.

2 Click a row in the unknown sample table to select the unknown sample for
— printing.

3 Click [Print] on the main toolbar.
The [Print] window is displayed.

4 Confirm that the printer for output is correct and click [OK].
A detailed report for the unknown sample graphed on the [Active] tab is printed.
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11 Quantum Yield

11.6.2 Printing a Summary Report

In summary report printing, two types of layouts can be selected: table printing and
simple table printing.

B Printing using [Print Table]

1 Click [Print Layout] - [Print Table] (or [Print Simple Table]) on the [Tools] menu.

2 Click the [Overdrawing] tab in the graph view.

3 Click [Print] on the main toolbar.
The [Print] window is displayed.
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11.6 Printing

4 | Confirm that the printer for output is correct and click [OK].
Printing is executed.

Quantum Yield Summarny Reporn Fiie Hame: i 100 S

Fin Nama Cammeer.

Araiyut

Masiramart Camgtana
faotaner Wasiogr M8 o
Dt Ioturnd 18 e
Saam Sorst 800 wvm. man
Evcauton Tt 50 e
[
Seaety Low
Irtugranrg dgrare Hare

Date of Mamasurarmast
Stamdbard Sarple: 1105 £8321 AM
Uk s Barvple: 27102005 851 89 MM

Dt o Carmptonn Frosmtons Crptoss
Stamsbird Sarvple 152015 KIALL AM
Uk rvars Sarvple: 23/7015 B3AAL AN

Example of Printing with [Print Table]

Quantum Yield S Report (Simple) File Name: 202015 65645

B - Tafatetihl Sl

Quantum Yield Summary Report (Simple)  File Name: _ YRS e5ed
Fia Hama Commant

Masiurrmart Cordtapmy
Encitation Wavelongth 344 nm

Diata Ietervad 10 rem
Scan Seeed GO0 rem mn

Exetanen St 50 om
Eminnion St 58 rem
Senasvity Low
Integratng Sehere Mone
Date o Maasusmmars

Standerd Sample 170072015 64921 AM
Uk rime Samgle: 2710/2015 65148 AM

Date of Comecton Furction Crestion
Starcberd Sargle 253015 05047 AM
Urkronn Sample 1752015 #5842 AW

Standard

Pl — To ettt ol

Page 1 /2

Example of Printing with [Print Simple Table]
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—
Quantum Efficiency

This chapter explains how to operate the special analysis application for quantum
efficiency.

PP Reference For cases and functions not covered in this chapter, refer to the help file provided with
LabSolutions RF.

B Explanations Included in this Chapter

This application calculates quantum efficiency from the difference between the peak
areas of a blank spectrum measured without a sample placed in the sample compartment

(integrating sphere) and the sample spectrum measured with the sample in the sample
compartment.

This chapter explains the procedures for measuring sample fluorescence spectra and
calculating quantum efficiency, changing the area calculation range, and printing reports.

B NOTE  An integrating sphere must be installed in the sample compartment when
performing measurement using this application.

B Functions Used in this Chapter

The following functions are used in the quantum efficiency measurement program.
e Configuring measurement and instrument parameters

e Entering sample information and performing sample measurement

e Changing the area calculation range

e Printing reports
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12.1 Startup

12.1 Startup

The quantum efficiency measurement program comprises a "measurement mode" and
"file check mode".

In "measurement mode", a "preparation window" for performing tasks including
configuring parameters for measurement and a "measurement window" for checking
measurement results are used.

In "file check mode", the content of opened data files can be viewed in the
"measurement window".

B NOTE  An integrating sphere is required to perform measurement using this application.
Only start this application after registering instrument information and installing
an integrating sphere for which any required spectrum correction functions have
been measured and saved.

PP Reference For details on registering instrument information, see "13.2 Registering an Integrating
Sphere" P.196. For details on measuring and saving spectrum correction functions, see "13.
3 Measuring Integrating Sphere Correction Functions" P.200.

1 Click [Quantum efficiency] on the [Fluorescence] tab in the LabSolutions RF
— launcher.

The special analysis application for quantum efficiency starts and the [Quantum Efficiency
Measurement] window is displayed.

Quantum Efficiency Measurement ||

Select an operation

o ] [ conce

[Quantum Efficiency Measurement] Window

2 Select an operation and click [OK].
e Selecting [Measure] displays the preparation window in measurement mode.

¢ Selecting [View data file] displays the measurement window in file check mode.
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12 Quantum Efficiency

12.1.1 Preparation Window Layout

?

[&] Quantum Efficiency - Mode
T Fila _Edit Grank  Tanle  Haln

Measurement Parameter

Excitation Wavelength (nm):  366.0
Emission Wavelength Range (nm): Start  316.0

End 700.0

Datalnterval(m): 0.5 ¥

e

EX EM
900.0 900.0
450.6
v Arclamp  ON (242 hours)

+ Integrating Sphere

Sean Speed (nmjmin): (600

0
Exdtation Bandwidth (nm): 3.0 A
Emission Bandwidth (nm): | 15,0 -~/
R —
Integrating Sphere.
Integrating Sphere: |ISR-01 |
Quantum Efficiency - "Preparation Window"
No. Name Function
© | Title bar Displays the application name and window mode ("Measurement
Mode" or "File Check Mode").
Displays the application menus. Selecting a menu along the bar
® | Menu bar displays multiple command menus. The displayed command menus
differ depending on the application type and window mode.
Displays tool buttons for executing main functions, such as starting
© | Main toolbar and stopping measurement, performing file operations, and
printing.
O | Parameter view | Set the various parameters required for measurement.
The upper section displays the current wavelength and
fluorescence intensity and the lower section displays the current
(5) Instrument status of the spectrofluorophotometer.
status
PP Reference For details on the instrument status, see "2.3.3 Instrument
Status" P.23.
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12.1 Startup

12.1.2 Measurement Window Layout

] Quantum Effciency - Mode [E=8ECR =)
File Edit Graph Iools Help
I r
B ] = =N P v = | «O» || 0 \ CH
New Analysis Open Save Print ‘ GoToWL H Open “ Auto Zero. J Disconnect
—— ~
f EX EM
214795.] H | ch Range _366.0 700.0
200000.00 P3 bee- e dezzs = 0.1
H : : Switch Graph Display v Arclamp  ON (242 hours)
V]Blank v Integrating Sphere
| sample

150000.00

lExcitation Liht Area | | Fiename
z 7] Emission Area
2

£

100000.00 | -- -
Destination

50000.00 -~ --~~

3160 400.0 600.0 700.0

500.0
Emission Wavelength (nm)

‘onditions
Excitation Wavelength: 366 nm
Emission WL. Range: 316 - 700 nm

Data Interval; 0.5rm
A< Scan Speed: 600 nmjmin
Excitation Bandwidth: 3.0nm
Emission Bandwidth: 15.0nm
Sensitivitv: Low

Quantum Efficiency - "Measurement Window"

No. Name Function

Displays a spectrum graph of the sample.

Making changes to the graph display, such as overlaying the blank
spectrum or changing the peak area color, can be performed using
@ | Graph view the checkboxes on the right side of the graph.

The wavelength range used in area calculation can also be
changed by clicking [Change Area Range].

PP Reference "12.5 Changing the Graph Display Range" P.186

Displays the measurement results for the sample in a table.
Analysis result The items displayed in the table and the number of digits used
view to display calculation results can be changed via [Set Analysis
Results] on the [Tools] menu.

P3) File information | Displays information on the currently loaded data file.
view The analyst name and comments can be edited.
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12 Quantum Efficiency

12.2 Preparation for Analysis

Measure the fluorescence spectrum of the sample to prepare for quantum efficiency
calculation.

This section explains the how to configure the required analysis parameter settings.

12.2.1 Setting Analysis Parameters

1 Set the parameters under [Measurement Parameter].

Measurement Parameter

Exdtation Wavelength (nm): 366.0

Emission Wavelength Range (nm): Start 316.0

End 700.0
Data Interval (nm): [0.5 v]
Scan Speed {nmjfmin): [GUU v]

Measurement Parameters (Parameter View)

Measurement Parameter Setting

[Excitation Wavelength] 366 (nm)
[Start]: 316.0 (nm), [End]: 700.0 (nm)

[Emission Wavelength :' Hint  The start wavelength is automatically calculated from the

Range] set excitation wavelength (excitation wavelength - 50 nm)
and set.

[Data Interval 0.5 (nm)

[Scan Speed] 600 nm/min
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12.2 Preparation for Analysis

2

Set the parameters under [Instrument Parameter].

Instrument Parameter

Excitation Bandwidth {(nm): [3.0 'l
Emission Bandwidth (nm): ’15.0 ']
Sensitivity: lLow n ]

Instrument Parameters (Parameter View)

Instrument Parameter Setting
[Excitation Bandwidth] 3.0 (nm)
[Emission Bandwidth] 15.0 (nm)
[Sensitivity] Low

Set the integrating sphere setting under [Integrating Sphere].

The integrating spheres registered using the instrument registration tool are displayed.
Select the integrating sphere to use from the list.

Integrating Sphere

Integrating Sphere: [ISR'Ol b

Integrating Sphere (Parameter View)

Instrument Parameter Setting

[Integrating Sphere] ISR-01

:’ Hint  The [Integrating Sphere] list displays the names of registered integrating spheres.
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12 Quantum Efficiency

Entering Sample Information and Performing Sample Measurement

12.3.1 Blank Measurement

1 ‘ Click [Start] on the main toolbar.
— A message is displayed to confirm that the sample compartment is configured for blank
measurement.
2 ‘ Check that no sample is set in the sample compartment and then click
— [Measurement].
OQimmmEl’ﬁdﬂlcyMcﬂsumﬁmt ﬁ

Perform blank measurement.

Chedk that nothing or =olvent cell is set in sample holder in

the intearating sphere

and dick the measure button.

[Maﬂ.l'emmti [ Cancel

Sample Compartment Confirmation

A message is displayed to confirm whether the integrating sphere specified in the analysis
parameters is installed.

B NOTE The correction function used differs depending on the integrating sphere. Be
aware that incorrect data will be created if measurement is performed using an
integrating sphere that differs from the integrating sphere selected in the
analysis parameters.

3 ‘ If the set integrating sphere is correct, click [OK].

GQumtun Efficiency Measurement [

':0} Confirm integrating sphere: ISR-01/490255200001 is installed.

[ ok || cancel

Integrating Sphere Confirmation

The "preparation window" changes to the "measurement window" and blank spectrum
measurement starts.
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12.3 Entering Sample Information and Performing Sample Measurement

123.2 Sample Measurement

When blank spectrum measurement is complete, the window for setting sample
information is displayed.

1 Set the sample into the integrating sphere and enter the sample information.
Quantum Efficiency Measurement -5
1. Set the standard sample in the sample compartment.
2. Enter the sample information.
Sample Name:
Sample01
Sample ID:
0001
Option :
iMeasurement [ Cancel
Window for Setting Sample Information
Sample Information Setting
[Sample Name] Sample01
[Sample ID] 0001
[Option] -

2 Click [Measurement].

Measurement of the fluorescence spectrum of the sample starts. The captured data is
graphed in real time.
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12 Quantum Efficiency

Performing Additional Sample Measurements

When measuring multiple samples, whether to perform blank spectrum measurement can
be selected for the second and subsequent sample measurements.

1241 When Performing Blank Spectrum Measurement Again

1 Click [Start] on the main toolbar.
A window is displayed for selecting whether to perform blank measurement.

2 Select [Blank Measure and Sample Measurement] and click [Measurement].

Quantum Efficiency Measurement @

(@ Blank Measure and Sample Measurement!

(") Measure Sample Only

[Measurement] [ Cancel

Blank Measurement Selection Window (When Performing Blank Measurement)

3 Measure the blank spectrum and sample spectrum according to the procedure
! described in "12.3 Entering Sample Information and Performing Sample
Measurement" P.182.
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12.4 Performing Additional Sample Measurements

1242 When Skipping Blank Spectrum Measurement

1 Click [Start] on the main toolbar.

A window is displayed for selecting whether to perform blank measurement.

2 Select [Measure Sample Only] and click [Measurement].

Quanturm Efficiency Measurement @

() Blank Measure and Sample Measurement

(@) Measure Sample Only

[Measurement] [ Cancel

Blank Measurement Selection Window (When Skipping Blank Measurement)

Measure the sample spectrum according to the procedure described in "12.3
Entering Sample Information and Performing Sample Measurement" P.182.

B NOTE  This only performs sample measurement without performing blank spectrum

measurement. The blank spectrum information for this sample is copied from the
last sample in the result table.

LabSolutions RF Basic Operation Guide

185




12 Quantum Efficiency

12.5 Changing the Graph Display Range

The graph display range in the measurement window can be changed by dragging out
a range using the mouse or directly entering values for the upper and lower limits of
the graph frame.

i 4 —_— (oo
File Graph Tools Help
Y wm | 0 || @ { gt
GoTo WL Open H autozero | | Disconnect
X EM
oty Change Arca Range 3660 72000
200000.00 s : - : 0.1
i Switch Graph Display « Arclamp  ON (242 hours)
[¥]Blank + Integrating Sphere
V] sample

150000.00

[¥] Excitation Light Area lename =

’E (7] Emission Area
£ 10000000 Beatn
$0000.00 - Analyst
Comment =

0.00
3160 4000 500.0 600.0 700.0
Emission Wavelength (nm)

Measurement Conditions

Exdtation Wavelength: 366 nm

Emission WL. Range: 316 - 700 nm
Data Interval: 0.5nm

Scan Speed: 600 nm/min
Exdtation Bandwadth: 3.0 nm
Emission Bandwidth: 15.0 nm
Sensitivity: Low

"Measurement Window"

B Specifying the display range with the mouse

Use the mouse to drag out a rectangular frame of the range to magnify and then release
the left mouse button. The area enclosed by the rectangular frame is drawn magnified.

212950.29
200000.00 hbl SALL § RETEIIEEELI R R R LR L LEeLe: T R

150000.00 206727 72
. i
% 200000.00 | 4
£ 10000000 ----------- ;
190000.00
50000.00 z
13 i
s :
E 130000.00 |
0.00
3160

170000.00

158329.92 -
3497 360.0 370.0 380.0 385.1
Emission Wavelength (nm)

Example of Magnification Using the Mouse
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12.5 Changing the Graph Display Range

W Directly entering upper and lower limit values on the graph axes

The upper and lower limit values of the horizontal and vertical axes on the graph can
be changed by clicking on them so they are highlighted.

Enter a value and click on a location outside of the highlighted area to accept the
entered value. The graph is then redrawn.

=1

ZUUUUU.UU |

150000.00

200.00 -

Intensity

100000.00

600.00 f -~ -----

50000.00

Intensity

400.0 500.0 600.0 700.0

Emission Wavelength (nm)

Example of Directly Entering an Upper Limit Value on the Vertical Axis
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12 Quantum Efficiency

12.6 Changing the Area Calculation Range

Change the wavelength range used to calculate the peak area of the fluorescence
spectrum and then recalculate the quantum efficiency.

1 ‘ Click [Change Area Range] on the right side of the graph view in the
———  measurement window.

The window for changing the area range is displayed.
The area range of both the excitation light and emission light can be changed in this

window.

:' Hint The drawing range of the graph can be changed by directly changing the upper and lower
limit values on the horizontal and vertical axes of the graph.

PP Reference "Directly entering upper and lower limit values on the graph axes" P.187

Quantum Efficiency Measurement

Quantum Efficiency
21295029 T

200000.00

_____________________________________________________________________________________________

150000.00

Intensity

100000.00

50000.00

0.00
316.00 400,00 500.00 600,00 700.00
Emission Wawvelength (nm)

© Excitation Light Area Range: | Start 350.0  End  385.0

(") Emission Area Range : Start | 390.0 End | 630.0

Window for Changing Area Ranges
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12.6 Changing the Area Calculation Range

Select [Excitation Light Area Range], enter wavelengths for [Start] and [End], and
click [Update].

The wavelength range is accepted.

@ Excitation Light Area Range: | Start  350.0 End  385.0

(") Emission Area Range : Start | 330.0 End |630.0

Changing the Excitation Light Area Range

Item Setting
[Excitation Light Area Select
Range]
[Start] (wavelength) 350.0 (nm)
[End] (wavelength) 385.0 (nm)

Select [Emission Area Range], enter wavelengths for [Start] and [End], and click
[Update].

The wavelength range is accepted.

(7 Exdtation Light Area Range: Start | 350.0 End | 385.0

(@ Emission Area Range : | Start  390.0 End 630.0

Changing the Emission Light Area Range

Item Setting
[Emission Area Range] Select
[Start] (wavelength) 390.0 (nm)
[End] (wavelength) 630.0 (nm)

Click [OK].

The quantum efficiency is recalculated using the new area range and the result table is
updated.
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12 Quantum Efficiency

12.7 Printing

This section explains how to print reports of measurement results.

There are two types of reports that can be printed: detailed reports and summary reports.

127.1 Printing a Detailed Report

In detailed report printing, a detailed report for the sample is printed.

1 ‘ Click on the graph view.
— The graph periphery is enclosed in a blue frame.

2 Click [Print] on the main toolbar.
— The [Print] window is displayed.

3 Confirm that the printer for output is correct and click [OK].
— A detailed report for the standard sample is printed.

Quantum Efficiency Detailed Report  Sample  Sample01 pibcaccib A bl
File Name: QE_01fgte C

Destination: CYRF-Data¥Data¥

1000.00 T . * . Measurement Conditions
Excitation Wavalength: 366 nm
Data Interval: 0.5 rm
800.00: ! Sean Speed 600 rm/min
Excitation Bandwidth: 3.0 rm
Emission Bandwidth: 150 nm

800.00+ 1 Sensitivity: Low
Intograting Sphere: ISR-01
Date of Measurement
400.00" T Samgle: 2/10/2015 1052 AM
Date of Comection Function Creation
200.00; L * 1 Sample: 2/10/2015 73014 AM
N S St e aan s s LTI

0.00
3160 400.0

Wensty

500.0
Emission Wavelength (nm)

Paga 1 /1

Example of a Printed Detailed Report
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12.7 Printing

12.7.2 Printing a Summary Report

In summary report printing, two types of layouts can be selected: table printing and
simple table printing.

1 Click [Print Layout] - [Print Table] (or [Print Simple Table]) on the [Tools] menu.

2 Click on the result table in the analysis results view.
The table periphery is enclosed in a blue frame.

No. name AF QEin QEex Sem Memo
Sampled1 3 [ 0.4715 | 0.0157 | 74335.1043

Result Table (Analysis Result View)

3 Click [Print] on the main toolbar.
The [Print] window is displayed.

4 Confirm that the printer for output is correct and click [OK].
Printing is executed.

ntum Efficien ymmary R File Name: QE 01.fgte 2/10/2015 84542
|
Samy
Quantum Efficiency Summary Report File Name: QE 01 fgte 2/10/2015 84542
File Neme: GF 01 fate Commant

Destination: CYRF-Data¥Data¥

Excitation Bandwidth: 30 nm

Emission Bandwidth: 150 nm
Sensitivity: Low

Integrating Sphere: ISR-01

ction Function Creation
Sample: 2/10/2015 7:30.14 AM

Page 1/2

Example of Printing with [Print Simple Table]
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13 Management Tools

This chapter explains how to operate the management tools used for instrument
management, registration, and performance checks.

PP Reference For cases and functions not covered in this chapter, refer to the help file provided with
LabSolutions RF.

B Explanations Included in this Chapter

Three management tools are provided with LabSolutions RF.

El sHIMADZU

LabSolutions RF

Manage

Management Tool

Application

e’

Help Op
G

RF performance validation software ([Validation])
Check the performance of an RF-6000 instrument.

Instrument registration tool ([Register Device])

Register instruments for control and data processing by LabSolutions RF and register
optional integrating spheres for use in applications.

Spectrum correction function measurement tool ([Correction])
Measure spectrum correction functions for optional integrating spheres and check the
results.
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13.1 Registering an Instrument

13.1 Registering an Instrument

Instrument registration must be performed before starting any of the LabSolutions RF
applications.

1 ‘ Click [Register Device] on the [Manage] tab in the LabSolutions RF launcher.
— The [Instrument Registration Tool] window is displayed.

Click [Regist] on the [Instrument] tab.

Instrument Registration Tool X

Instrument Name

Instrument Type

Serial Number

Serial Port

[Instrument Registration Tool] Window (Initial Display)
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13 Management Tools

3 Enter the instrument name.
Enter the instrument name of the connected spectrofluorophotometer. In this case, enter
"RF-01".

:' Hint  Normally enter the name used on the system or a control number used to differentiate
the instrument from other instruments. If the instrument does not have any particular name,
enter the model name.

Instrument Registration 55|

Instrument Name
RF-01|

Instrument Type
| RF-6000 Series -

Model

Serial Port

[ ok || cancel

Entering the Instrument Name

4 Select the instrument type.

Select the instrument type of the connected spectrofluorophotometer. In this case, select
"RF-6000 Series".

Instrument Registration @

Instrument Mame
RF-01

Instrument Type
|RF-6000 Series -

RF-5300 Series
RF-6000 Series
I

Serial Port

OK || Cancsl

Selecting the Model Name
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13.1 Registering an Instrument

Click [OK].

A confirmation message is displayed. Clicking [OK] registers the instrument with the

entered information.

:' Hint e When registering an RF-6000 series instrument, [Model] and [Serial Number] do not need
to be entered because they are read from the instrument upon establishing a connection.

e Set [Serial Port] when registering an RF-5300 series instrument that uses an RS-232C cable

as the communication cable.

Instrument Registration Tool

Instrument | Intgrating Sphere

5]

Instrument Mame
RF-01

Instrument Type

RF-6000 Series

Model

Serial Mumber

Serial Port

Edi.. || Delete |

Close

[Instrument Registration Tool] Window (Instrument Registration Complete)
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13 Management Tools

13.2 Registering an Integrating Sphere

An integrating sphere must be registered in advance in order to perform measurements
in each application that require the use of an integrating sphere.

1 ‘ Click [Register Device] on the [Manage] tab in the LabSolutions RF launcher.
— The [Instrument Registration Tool] window is displayed.

2 ‘ Click [Add] on the [Integrating Sphere] tab.

Instrument Registration Tool ==

Name Model Serial Number

[Instrument Registration Tool] Window (Initial Display)
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13.2 Registering an Integrating Sphere

Enter the integrating sphere name.
Enter the name of the integrating sphere for registration. In this case, enter "ISR-01".

:' Hint  Normally enter the name used on the system or a control number used to differentiate
the instrument from other instruments. If the instrument does not have any particular name,
enter the model name.

(Ttegrating Sphere Registration ==

Integrating Sphere Name
ISR-01

Model

Serial Number

[ ok [ Concel

Entering the Integrating Sphere Name
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13 Management Tools

4 Enter the model name and serial number.

Enter the model name and serial number of the integrating sphere for registration. In
this case, enter "ISR-100" for the model name and "A90255200001" for the serial number.

:' Hint The model name and serial number are indicated on the name plate on the storage case
of the instrument.

Integrating Sphere Registration

Integrating Sphere Name
ISR-01

Model
ISR-100

Serial Number
A30255200001

[ ok ][ concel

Entering the Model and Serial Number
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13.2 Registering an Integrating Sphere

5 Click [OK].
Clicking [OK] on the confirmation message registers the integrating sphere with the
entered information.

= Instrument Registration Tool ==
\ |
| Name Model Serial Number
ISR-D1 ISR-100 AS0255200001

Delete

[Instrument Registration Tool] Window (Integrating Sphere Registration Complete)
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13 Management Tools

13.3 Measuring Integrating Sphere Correction Functions

When performing measurement using an integrating sphere, a spectrum correction
function must be measured and saved after completing registration of an integrating
sphere (see "13.2 Registering an Integrating Sphere" P.196).

:' Hint  Measure and save a spectrum correction function once every year. If the inside of the
integrating sphere is stained, also create a new correction function.

1 ‘ Click [Correction] on the [Manage] tab in the LabSolutions RF launcher.
wo— The [Spectrum Correction Function Measurement Tool] window is displayed.

:' Hint A confirmation message is displayed when a correction function has not been created for
a registered integrating sphere.
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13.3 Measuring Integrating Sphere Correction Functions

Enter the name of the personnel who is creating the correction function as well
as any comments and click [Start].

' Hint

When multiple integrating spheres are registered, select the target integrating sphere with
[Integrating Sphere Name].

5 Spectrum Correction Function Measurement Tool 23]
Creation of Correction Function | Confirmation of Correction Function |
BW 1nm | 8w 3nm | BW Som | BW 10nm | BW 150m | BW 200m |
Instrument Type Correction Function
RF-6000 Series 1.05 ‘
Instrument Name TN 17 | AR o s e i A —
RF-01 H H H
Instrument Serial Number
H2_20141222a
Date of Creation L1 Bt yfasemnanseRas 3m=ssenmncisezon fmssnons
02/13/15 13:12:26
Integrating Sphere Name
ISR-01 H H '
100 - -ommemnmnanns R ESRaatantt SUTEERRERLREEEE boeennes
Integrating Sphere Serial No. : H i
A90255200001
e ~
Created by : ' :
RFAdrm USS ................ E................:' ............... E ........
Comment
|
I e boeeeees
0.5 H H .
200.00 400.00 600.00 800.00 300.00
L ) nm
) E Measured Correction Function El Current Correction Function

Entering Name of the Correction Function Creator and Comments
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13 Management Tools

3 Check the following points and click [OK] according to the onscreen messages.
e The target integrating sphere is installed in the instrument's sample compartment.
e No sample is set in the integrating sphere.

e The provided mesh assembly is attached to the emission side filter holder of the
instrument's sample compartment.

If 30 minutes has not elapsed since lighting the xenon arc lamp, a standby window is
displayed to allow the instrument to stabilize.

:' Hint  Measurement starts automatically after 30 minutes elapse.

Waiting for instrurment to stabilize

30 minutes have not elapsed since the arc lamp turned on.
Inspection will start automatically after 30 minutes.

Waiting (remaining time: 20 min46 sec)

Click the "Execute” button to execute immediately.

Execute | | Abort

[Waiting for instrument to stabilize] Window
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13.3 Measuring Integrating Sphere Correction Functions

When measurement starts, spectrum data is displayed in real time in the graph area.

E Spectrum Correction Function Measurement Tool 2

Creation of Correction Function | Confirmation of Correction Function |

: stp | ISR-01

s : - = -
BW inm BW 3nm | BW Snm | BW 10nm | BW 15nm | BW 20nm |
Instrument Type Correction Function

I RF-6000 Series 1084.88

Instrument Name 1000.00} --------------- e memimmme i boninnee
RF-01 ; ‘

Instrument Serial Number

I H2_20141222a
Date of Creation
02/13/15 13:12:26
Integrating Sphere Name
I ISR-01
Integrating Sphere Serial No. L pomn s fese=:

I AS0255200001

Created by
RF Admin|

Comment

0.00 . . '
200.00 400.00 £00.00 800.00 900.00
nm

=] Measured Correction Function ==~ Current Correction Function
| § J

[Spectrum Correction Function Measurement Tool] Window (During Measurement)
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13 Management Tools

‘ After measurement is complete, check that the measured spectrum is free from

—— abnormalities and then click [Update].

Spectrum Correction Function Measurement Tool (e

Creation of Correction Function | Confirmation of Correction Function |

I | | ISR-01

BW 1nm | 8W 3nm | BW 50m | BW 10nm | BW 15nm  BW 20nm |
Instrument Type Correction Function

RF-6000 Series 1.44

Instrument Name
RF-01

Instrument Serial Number

H2_201412223

Date of Creation 1.00

01/28/15 10:01:54
Integrating Sphere Name
ISR-01
Integrating Sphere Serial No.

A90255200001

Created by 050
RF Admin

Comment

0.00 g L A
200.00 400.00 600.00 800.00 300.00
nm

Update E Measured Correction Function El Current Correction Function

[Spectrum Correction Function Measurement Tool] Window (Measurement Complete)

A message to confirm updating is displayed.

5 ‘ Click [Yes] to update.

— A message indicating that updating has completed is displayed and the spectrum

correction function obtained in measurement is saved.

6 ‘ Click [OK] to close the message.

Spectrum Correction Function Measurement Tool ()

I:o:l Spectrum correction function was updated.

Update Complete Message
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13.4 Checking Integrating Sphere Correction Functions

13.4 Checking Integrating Sphere Correction Functions

Click [Correction] on the [Manage] tab in the LabSolutions RF launcher.
The [Spectrum Correction Function Measurement Tool] window is displayed.

:' Hint A confirmation message is displayed when a correction function has not been created for
a registered integrating sphere.

Click the [Confirmation of Correction Function] tab.

When multiple integrating spheres are registered, select the target integrating
sphere with [Integrating Sphere Name].

The data of the spectrum correction function in use is displayed in the graph area.

B spectrum Correction Function Measurement Tool =

Creation of Correction Function Confirmation of Correction Function

Text File Output | I5R-01

'BW tnm | BW 3nm | BW Som | BW 10nm | BW 150m  BW 20nm
Instrument Type Correction Function

|R.F~sooosmes 1.44

Instrument Name
RF-01

Instrument Serial Number

I H2_20141222a
Date of Creation 1.00
| 01/28/15 10:01:54
Integrating Sphere Name
|ISR-0 1 > I
Integrating Sphere Serial No.
I A1234567890
Created by 080

o

Comment

0.00 F ; :
200,00 400.00 £00.00 800.00 900,00
rim

E Current Correction Function

[Spectrum Correction Function Measurement Tool] Window (Checking the Correction Function)

:’ Hint The data of the spectrum correction function in use can be saved in text format.
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13 Management Tools

4 Click [Text File Output].

Spectrum Correction Function Measurement Tool

Creation of Correction Function Confirmation of Correction Function

Text File Output

slit 1nm | siit 3nm | Siit Som |
Instrument Type
| RF-6000 Series 1.05
Instrument Name
1.04
| RF-01

[Text File Output]

The [Save As] window is displayed.

5

Specify the save destination, enter a filename, and click [Save].

B save As

Savein:| . Bxport j = @ cx B
= Name ’
Recent Places

Date modified Type

Desktop

I

File name:

[ISR-01_ComectionDatal

Save as type:

| ASCII Files (")

[Save As] Window

A message indicating that the data was output in text format is displayed.

6 Click [OKI.

A text file is created in the specified folder.
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13.4 Checking Integrating Sphere Correction Functions

7 Check the content of the text file.

| 1SR-01_CorrectionData_Slitlnm.bet - Notepad |- ]
File Edit Format View Help

"Correction Function”,”slit 1mm" -
"Instrument Type","RF-6000 series” K
"Instrument Name","RF-01" —
"serial Number (Instrument)","H2_20141222a"
"pate”,"11/17/14 07:19:47"

"ISR Mame","ISR-01"

"serial Number (ISR)™,"A90255200001"

"analyst Name","administrator”

"Comment”, "for manual”

"wavelength(nm)", "Correction Number"”

200.00,0. 000000

200.10,0. 000000

200.20,0.000000

200.30,0. 000000

200.40,0.000000

200.50,0. 000000

200.60,0.000000

200.70,0.000000

200. 80,0. 000000

200.90,0. 000000 =

4 F

Checking the Text File
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13.5 Checking RF-6000 Performance

Instrument performance can be checked using the RF performance validation software.

Startup

Click [Validation] on the [Manage] tab in the LabSolutions RF launcher.
The RF performance validation software starts.

B validation System-[Disconnect]
File View Tests Instrument Help

EsHMaDzZU
RF Perf
Baich of Test
1 Select
Gy Select Al | %% Clear Al | 26 Tolerance [ | Procezsng
1 Finished
Batch of Test(s) Result

S/N ratio

Stability

WL Accuracy

WL Repeatability

WL Repeatability(USP)
Resolution

Not executed

Mot executed

Not executed

Mot executed

Not executed

Not executed

EEEEEEE

Results of Initialization Not executed

Inspection Progress

Overal Progress

Remain: 47 min

[E=E ECH £X3

Help
{F1)

File Property

Folder for Saving:
| C:\RF-Data'\ValidationResult

Test Results File:

]
Analyst:

Result is displayed here.

[Validation System] Window (Initial Display)
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13.5 Checking RF-6000 Performance

Click [Connect] on the main toolbar.

B sHMaADZU

RF |

Tool Buttons

The available test items are displayed when a connection is established with the
instrument.

:’ Hint If the optional mercury lamp unit is installed, wavelength accuracy, wavelength
repeatability, and resolution test items are also available.

Validation System-[Connect] EI@

File View Tests [nstrument Help

EsHMaDzU

RF Performa
Batch of Test File Property
O Select
E Select Al w | —p . Folder for Saving:
- - = — nr:fffimg C:\RF-Data\ValidationResult .
Batch of Test|s) Result e E T
S/N ratio Not executed = ]
Stability Not executed
WL Accuracy Not executed Analyst:
WL Repeatability Not executed
WL Repeatability(USP) Not executed
Results of Initialization Mot executed

Resultis displayed here.

Overall Progress

| Remain: 23 min

[Validation System] Window (Connected)
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1352 Setting Judgment Criteria

1 ‘ Click [Tolerance] in the test item area.

Batch of Test

1 Select
(B seectal | [#) Cearal | | = Processing
1 Finished
Batch of Test(s) Result
S/M ratio Not executed
Stability Mot executed
WL Accuracy Mot executed

WL Repeatability

Mot executed

WL Repeatability(USF)

Mot executed

Resolution

Mot executed

EEEEEEE

Results of Initialization

Not executed

Setting Tolerances

The [Tolerance] window is displayed.
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13.5 Checking RF-6000 Performance

Switch between the tabs to check and change the tolerance settings, and then
click [OK].

[Tolelance @
arc Mercury Lamp
S/ ratio
RMS
P 350
Stability

Stability(%s) 1.0

Recommend

[ oK ] Cancel ]

[Tolerance] Window

Accept the tolerance settings and close the [Tolerance] window.

PP Reference For details on each test item and recommended values, see the help file provided with
LabSolutions RF.
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13 Management Tools

13.5.3 Executing Testing

1 Select the checkboxes of the test items to perform in the test item area.

— In this case, perform all test items. The total testing time is displayed in the test progress
area according to the items selected for testing.

Batch of Test

(G seect | (7 Cearm | | g ﬁiﬁ‘;’mg

1 Finished

Batch of Test(s) Result
3/M ratio Mot executed
Stability Mot executed
WL Accuracy Mot executed
ML Repeatability Mot executed
ML Repeatability(USP) Mot executed
Resolution Mot executed
lesults of Initialization Mot executed

Inspection Progress

COverall Progress

| | Remain: 26 min

Test Item Area/Test Progress Area

2 Check the save destination of the result file in the file information area.

File Property

[ Foider for Saving:
C:\RF-Data\validationResult [

Test Results File:

i

Analyst:

Checking the Save Destination

-’ Hint The save destination can be changed by clicking C]
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13.5 Checking RF-6000 Performance

3 Enter the test result filename and analyst name.

File Property

Folder for Saving:
C:\RF-Data\ValidationResult |'

-
Test Results File:
RFtest150128.fpvr |

i

Analyst:
RF Tester

—

Entering the Filename and Analyst Name

-' Hint Comments can also be entered for the result file by clicking | =] |.

4 Click [Start] on the main toolbar.

If 30 minutes has not elapsed since lighting the xenon arc lamp, a standby window is
displayed to allow the instrument to stabilize. Testing starts automatically after 30
minutes elapse.

Waiting for instrument to stabilize

30 minutes have not elapsed since the arc lamp turned on.
Inspection will start automatically after 30 minutes.

Waiting (remaining time: 20 min46 sec)

Click the "Execute” button to execute immediately.
Execute I | Abort I

[Waiting for instrument to stabilize] Window
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5 Set distilled water or a PTFE block onto the cell holder according to the displayed
message, and click [OK].

Measurement starts and a spectrum and time-course graph are displayed in real time in
the test result area.

500.0

4000 +

3000 +

Intensity

2000 +

1000

0.0 | | | | |
3700 3300 3900 400.0 410.0 4200 430.0
nm

Result Measurement Parameters ‘ Raman Peak Moise Level

Test Result Area (Test State Display)

1354 Checking Test Results

The results of completed items can be checked during testing.

1 Click the title of the item for checking in the test item area.
In this case, click the [WL Accuracy] item for which testing has completed (indicated in
blue).

Batch of Test

[ Select
Select All | %™ Clear All | Tolerance [ Processing
1 Finished
Batch of Test(s) Result
S/M ratio Passed
7] | 4 mbilidnr Dmemmrd
WL Accuracy Passed
= vrC TSpooteoiy Toesony
WL Repeatability(USP) Mot executed
Resolution Mot executed
Results of Initialization Mot executed

Test Item Area

The test result of the selected item is displayed in the test result area.
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13.5 Checking RF-6000 Performance

2 Check the test result.
The spectrum can also be checked by switching between tabs.

Ex/Em | WL(nm) | Tolerance(nm)| Peak(nm) | Error(nm) Result
1 Ex 2537 +/-1.0 253.5 -0.2 Passed
2 =8 365.0 +/-1.0 365.1 01 Passed
3 Ex: 4358 +/-1.0 4355 -0.3 Passed
4 Ex 546.1 +/-1.0 5458 -0.3 Passed
5 Em. 253.7 +/-1.0 253.7 0.0 Passed
6 Em. 365.0 +/-1.0 364.9 -0.1 Passed
7 Em. 4358 +/-1.0 4358 0.0 Passed
8 Em. 546.1 +/-1.0 546.1 0.0 Passed

Result[ Measurement Parameters l Ex Spectrum ] Em Spectrum ]

Test Result Area (Test Result Display Mode)

3 Click [View Test] on the main toolbar.

) sSHIMADZU

forr

Main Toolbar

This returns to the window that displays the current state of testing.
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13.5.5 Printing

1 ‘ Click [Print] on the main toolbar.

— The [Print] window is displayed.

] sHIMADZU

ma

Main Toolbar

2 ‘ Confirm that the printer for output is correct and click [OK].
m— Summary information and test results of the test result file are printed.

B NOTE The layout of printed results cannot be changed.

Instrument Validation Report

Date/Time 87152015 102437

WL Accuracy
[Phodturs ran]
[Ex Warvtlangth e |
B Wivlang [-SVES
Sean Spewd odne|
o Inserval anm |
[rsmamant
X Bardwih Wmm |
BN Bandwicsh e |
Tanary Low
ExEm i e |
L) Ei Eo)
F [ £}
] [ 5
] Ex =
5 Erm |
(] Em |
7 Em a3
E] Em. |

[Ex Epectrom(fiL 53 Tam 365 0
=0 ——

Tratrument Vabdation Report

Dot/ Teme 91572005 102437 AW

5 Vhdation Report
SN ratio
DCote Time $/152015 103437 AM Pags | /10
[T I—— Softewrs Verson T Verson 110
EX et crsmem Modal Hams RF-5000 Series
EM Wavelergt 37een - 4300
Scan Spwed 2o atrumant Tige L2
Duna Bnem 5N Al
[rsrumant] Firmaurs Version 10000
EX Bandantt; S50nm
:u i :‘:'M Anstyst's nama Shimadri
Commant
Toderance
b 3 s Teat o Rusu
1 3967 --LSDI =]
SN Passed
Suabaliny Passed
Feaman Paak W Asousey Passed
WL Rapsatabsln: Passed
W Rapaacabilny TSP Passed
Rhars ol Passed
= Resuirs of Insialganion Paszed
H
£
a0 o
Home Ll
190,50

a4 WA

g l——

°e oW M

Example of Printed Test Results
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I

3D Graph Range 58 Graph 64, 84
3D spectrum graph view 50, 57 Graph view 160, 179
3D spectrum measurement toolbar 50
History 8
activate 76, 78
Active 37, 57, 102 _
active data set 14 initialization of settings 21
Activity Values 112 Instrument Status 23, 25
Analysis Parameters 180 integrating sphere 177, 196, 200
Analysis result view 160, 179 Intensity Difference Table 11, 139
Area Calculation 188
auto file 42
auto file function 109 Judgment Equation 93
Auto Zero 43, 53, 76, 78, 98, 110
Automatic Scaling 46, 47, 58
Log view 5 24
B
Basic Analysis 1, 3
Batch Point Pick 127, 138, 139 Main Table 113, 139
Blank 182 Main toolbar 5, 159, 178
management tools 2, 4
Manipulate 132
Calculation Formula 89 Measurement (Standard) 69
Calibration 68 Measurement mode 7
Calibration Curve 66, 76 Measurement parameter files 12
Calibration curve file 63 Measurement parameters 8
calibration curve function 76 Menu bar 5, 159, 178
Converted data 7, 8
Correction data 7 _
correlation coefficient 76 Overlay 37, 102
Customize 58
IPA—
_ Parameter view 36, 50, 64, 84, 101, 159, 178
Data files 9 Peak Area 12
data history 37, 57, 102 Peak area table 8
Data Print 10, 138, 139 Peak Pick 11, 120, 138, 139
Data processing view 37, 102 Peak pick table 8
Data set 7, 13 Photometric measurement toolbar 84
Detailed Report 173, 190 Point Pick 10, 123, 138, 139
Point pick table 8
_ Print Simple Table 174, 191
Edit printform 7 Print Table 174, 191
Event recording 3
Event table 139 _
Extract Spectrum 61 Quantitation measurement toolbar 64
Quantum Yield 157
Quick Print 48, 138
File Formats 9
File information view 179
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Raw data 7, 8
Record Events 105
Register Device 193
Report File 136
RF performance validation software 208
right-click menu 16
Sample table 65, 84
Set Analysis Results 172
Special Analysis 2, 4
Spectral Bandwidth 39, 52, 66, 86, 106
spectrum correction function 200

Spectrum Correction Function Measurement Tool
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spectrum correction functions 177
Spectrum graph view 36, 37
Spectrum measurement toolbar 35
Standard Sample 76, 161, 166
Standard sample view 159
Standard table 8, 65
Summary 8
Template files 12
Time course graph view 101, 102
Time course measurement toolbar 100
Title bar 5, 159, 178
Tolerance 210
Tree view 5, 13, 133
Unknown Sample 169, 171
Unknown sample table 8
Validation 2, 4
View mode 7
Window Mode 7
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